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Welcome to Perfect Photo Suite
Introducing the new and improved Perfect Photo Suite 7.5! Create images that are
even more extraordinary with powerful new tools, new intuitive interface, improved
performance, and direct integration with Adobe Photoshop, Lightroom and Apple
Aperture.

Discover Perfect B&W—the brand new module designed to help photographers of all
skill levels create stunning black and white images. Also, find new versions of Perfect
Portrait, Perfect Effects, Perfect Layers and Perfect Resize. With the new Perfect
Photo Suite 7.5, it's now faster and easier to realize your photographic vision.

What's New

NEW streamlined, intuitive interface and seamless integration with
Lightroom, Photoshop and Aperture. Also works as a standalone application.
All NEW product Perfect B&W for creating stunning black and white images
quickly and easily with presets and powerful tools.
NEW effects library in the new Perfect Effects 4 with search capability,
favorites folder, larger image view, and new effects, textures and borders.
Powerful NEW retouching and auto enhancement tools in the new Perfect
Portrait 2.
NEW image browser, search functionality, blending modes, and Perfect
Brush in the new Perfect Layers 3.
NEW and improved image-resizing algorithms, powered by Genuine Fractals
technology, in the new Perfect Resize 7.5 Pro.
NEW precise edge-detected masking with the new Perfect Brush tool.

What's Included

Perfect B&W

Discover this completely brand new module that helps you develop stunning black
and white images quickly and easily. It includes powerful and intuitive tools that add
dramatic, elegant, and classic black and white looks to images instantly and offer you
complete creative control to reproduce time-honored black and white processing
techniques.

Perfect Portrait 2

Get simply powerful portrait retouching, now improved with more accurate
automated feature detection and enhancement tools to smooth skin, remove
blemishes, brighten eyes and teeth, and correct skin color. Faster processing speeds
also allow you to retouch images more quickly for simply stunning portraits.
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Perfect Layers 3

Combine images and extend your image editing options in a layered file workflow
without Photoshop. Create and edit multi-layered files with Perfect Layers directly
from Lightroom, Aperture or as a standalone application. Included are new blending
modes, textures, borders, PNG file support, and the powerful new edge-detecting
Perfect Brush.

Perfect Effects 4

Extend your creative power and find even more ways create images with impact.
Perfect Effects 4 delivers an extended library of photographic effects, frames and
edges, and presets designed by industry experts, via a flexible new browser with
keyword search functionality and Favorites selection. New blending modes and paint-
in brush effects offer you even more creative options over how effects are combined
and applied.

 

Perfect Resize 7.5

Get the industry standard for image enlargement. Perfect Resize is renown across
the photographic and printing industries for its ability to increase image size well over
1000% without the loss of sharpness or detail that is normally expected. Now,
proven Genuine Fractals technology has been applied to new algorithms that optimize
the clarity and detail of different image types, including mobile snapshots.

 

Perfect Mask 5

Create high quality masks quickly and easily with automated functionality and
powerful tools that make selecting subjects and isolating backgrounds for removal
extraordinarily accurate. Redesigned user interface allows you to focus on your
image editing while keeping your most used tools readily accessible.
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FocalPoint 2

Create realistic selective focus and depth of field effects after the shot. Choose from
a selection of lens presets to produce a specific bokeh or adjust controls to get the
amount and kind of blur you want.

 

Suite Edition Comparison
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Introduction

This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.

Pages in this Section

Using the Help System
Contacting onOne Software
Additional Help
System Requirements
Installation
Licensing and Registration
Opening and Saving Files
Using Modules
Using as Standalone
Using with Adobe Photoshop
Using with Adobe Lightroom
Using with Apple Aperture
Using with Other Applications
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Using the Help System

This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.

You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.

If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual

 You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.
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Contacting onOne Software

 At onOne Software, we value our customers and offer a variety of ways to be contacted.

• Visit our company website at:

   www.onOnesoftware.com

• For technical support please visit: 

   www.onOnesoftware.com/support

onOne Software, Inc.

15333 SW Sequoia Parkway Suite 150 
Portland, OR 97224
Telephone: 503-968-1468
Fax: 503-968-1469

© 20072013 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom, Flash and Adobe Acrobat are either registered trademarks or trademarks of Adobe Systems,
Incorporated in the United States and/or other countries. Mac OSX, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other
countries. Microsoft, Windows, Windows Vista, Windows 8 and .NET are registered trademarks of Microsoft Corporation. All other trademarks are the property of their
respective owners. The activation system used by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file
installed with the software.
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Additional Help

Technical Support
Contact technical support at www.ononesoftware.com/support or by filing out a request form.

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.

Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.
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Minimum  
Recommended

Operating
System

Mac OSX
Mac OSX 10.6, 10.7, 10.8
(current maintenance releases, 64 bit)

Windows
Windows Vista, Windows 7 or Windows 8 
(current maintenance releases, 32 and 64 bit)

 

Mac OSX
Mac OSX 10.7, 10.8 
(current maintenance releases, 64 bit only)

Windows
Windows, Windows 7 
or Windows 8 
(current maintenance releases, 64 bit) 

Processor Intel Core 2 Duo, Xeon or better processor(s)  Quad-core Intel Core i5, Xeon or better processors(s)

RAM 4 GB RAM  8+ GB RAM

Hard Drive 1.5 GB for installation  
1.5 GB for installation
Fast 7200 RPM or SSD drives

Display
OpenGL 2.0 compatible video card with 256 MB dedicated
video RAM
1280x720 resolution

 
OpenGL 4.0 compatible video card with 1GB dedicated video RAM
1920x1080 resolution

Optional
Application 
Integration

Adobe® Photoshop® CS4, CS5, CS6, CC 

Adobe® Photoshop® Elements 9, 10, 11

Adobe® Lightroom® 2, 3, 4, 5
Apple Aperture 2.1, 3

 

Adobe® Photoshop® CS5, CS6, CC

Adobe® Photoshop® Elements 10, 11

Photoshop® Lightroom® 4, 5
Apple Aperture 3

Other
Internet connection for activation, auto update checking,
online help, content downloads and tutorials.

 

High-speed internet connection for activation, auto update
checking, online help, content downloads and tutorials.
Wacom tablet for pressure sensitive input.
Hardware display calibration tool.

 

System Requirements

 

About Windows Video Cards

If you are using Perfect Photo Suite from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the
best performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or
more of dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.
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Installation

To install Perfect Photo Suite, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the onOne
Software website or it may be on a DVD if you elected for a physical shipment.

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OSX

The application is installed in the Perfect Photo Suite folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Photo Suite is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.

Windows

The application is installed in the Perfect Photo Suite directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Photo Suite is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling

To uninstall Perfect Photo Suite, follow these instructions. 

You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.

Mac OSX

1. Go to the Applications/Perfect Photo Suite/Documentation folder.
2. Double click on the Remove Perfect Photo Suite application.

Windows

1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Photo Suite and then click on the Uninstall button.
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Licensing and Registration

Perfect Photo Suite will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Photo Suite, you will want to license it so
you can continue to use it past the trial period. When you install Perfect Photo Suite it will prompt you to license it. Simply click on the license button and enter
your license code. Your license code can be found in your order confirmation email if you purchased the download version directly from onOne Software. If you
purchased a physical copy of Perfect Photo Suite, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect
Photo Suite on two computers. When you enter your license code, Perfect Photo Suite communicates with the onOne activation server and will activate your
software. Your software must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the
internet, you can manually activate your software by following the manual activation instructions in the license dialog.

If you wish to move your copy of Perfect Photo Suite from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Photo Suite and select Deactivate from the Help menu. This will deactivate Perfect Photo Suite on the current machine, allowing
you to install and activate it on another machine. 

If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact onOne customer service at 1-888-968-1468 or visit the support section of the onOne software website. 

It is important to register your copy of Perfect Photo Suite if you did not purchase it directly from onOne Software, so we can provide you with the best possible
service. Registered users of Perfect Photo Suite are eligible for free technical support, information regarding new versions and products, free updates, upgrade
pricing and special offers on new products.

Product Improvement Program

We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted. 

You can choose to participate in the Product Improvement Program the first time you launch an onOne product. You can change your participation later, just
click the Help menu, then Help Improve onOne Products. 

You can learn more about the Product Improvement Program here.
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Opening and Saving Files

Supported File Types

Perfect Photo Suite uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file
format that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing
applications. It supports multilayered images and layer masks making it the perfect format for durable, adjusting imaging. Perfect Photo Suite also supports the
opening and saving of the following file types.

Photoshop (PSD)
Photoshop Large Document (PSB) 
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras

Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Photo Suite and are recommended as your main file format. If your saved
file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer version of
the PSD file format and still maintains all your layers and masks. 

You can use the Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not saved directly.
They must be saved as another file type.

Opening Files

You may open an existing file in several ways.

1. Open the file from the File > Open menu if you are using Perfect Photo Suite as a standalone application.
2. Dragging a file onto the Perfect Photo Suite icon.
3. Double-clicking on an image in the Perfect Photo Suite Browser.
4. Sending a file to Perfect Photo Suite from a host application like Photoshop or Lightroom using the Perfect Photo Suite plug-in.

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Saving Files

1. You may save the open file using the save option. If you have created a new PSD, you will be prompted to select the name and location of the file.
2. You may save a copy of the image using the Save As command. This allows you to select the name and location. 
3. You may save flattened images in the TIF, JPG, PNG format from the Save As command in the file menu.
4. If you have accessed Perfect Photo Suite using a plug-in from another application, follow the instructions from that application for saving.

If you are opening a JPG, TIF, PNG, or RAW file, Perfect Photo Suite will default to saving a new PSD file. To save over the original file, use the
Save As command and select the original file.
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Using Modules

Perfect Photo Suite is a collection of modules, or tools, that work together to accomplish your digital workflow tasks. At the heart of Perfect Photo Suite is the
Perfect Layers module which acts as the host for the other modules. It is responsible for:

The opening and saving of files
Merging multiple files into a single, layered file
Selecting the layer you would like to work on in other modules

Depending on how you access Perfect Photo Suite you may never notice Perfect Layers, but it is there working in the background each time.

The Module Selector

If you access Perfect Photo Suite as a standalone
application you will start in the Perfect Layers module.
This is where you will open your file and prepare it for
editing.

When you are ready, you will select the module you
wish to use from the Module Selector in the upper right
corner of the main window. You can easily switch
between modules by clicking on another in the Module
Selector. This allows you to perform multiple tasks
during the same editing session.

When you have completed your work, you return the
Perfect Layers module to save your work.

 This is the module selector from the Perfect Photo Suite. It contains all of the available modules that
onOne Software makes. If you have purchased a single product, you will only see that product module
and Perfect Layers in your module selector.

If you access Perfect Photo Suite as a Photoshop Plug-in you will not see the Module selector. You will also not see the module selector if you use the following
modules as plug-ins through Lightroom or Aperture:

Perfect Portrait
Perfect Effects
Perfect B&W
FocalPoint
Perfect Resize

When you access these modules as plug-ins you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically. If you access Perfect Layers or Perfect Mask through Lightroom or Aperture you will start in the Perfect Layers module.

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Layers plug-in. This will start
you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules. 
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Using as Standalone

Perfect Photo Suite can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OSX

1. Open your Hard Drive.
2. Navigate to the Applications folder.
3. Navigate to the Perfect Photo Suite folder.
4. Double click on the Perfect Photo Suite application icon.

You can add Perfect Photo Suite to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use
Launchpad it can be found there as well.

Windows Vista and 7

1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Photo Suite.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Photo Suite from there.

Windows 8

1. Open the Start screen by pressing the Window key.
2. Select Perfect Photo Suite.

If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Photo Suite from there.
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[Using with Adobe® Photoshop®]

If you have the Premium Edition of Perfect Photo Suite, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the Photoshop
workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for automating and batch
processing.

If you do not have the Premium Edition of Perfect Photo Suite and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition.

To use Perfect Photo Suite inside of Adobe Photoshop follow these steps:

1. Open the image you want to work on.
2. Select the layer you want to work on. Generally Perfect Photo Suite works

on a copy of your selected layer, not the entire image.
3. From the File menu, select Automate, and then the module you would like

to use. 

 To use Perfect Photo Suite inside of Adobe Photoshop Elements, follow these
steps:

1. Open the image you want to work on.
2. Select the layer you want to work on. Generally Perfect Photo Suite works

on a copy of your selected layer, not the entire image.
3. From the File menu, select Automation Tools, and then the module you

would like to use. 

Perfect Layers is not accessible from Adobe Photoshop or Photoshop Elements.

onOne Panel
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 Users of Adobe Photoshop CS4 and higher can also access Perfect Photo Suite as plug-ins
using the onOne Extension Panel. This provides fast access to the Perfect Photo Suite and
its presets. To access the onOne panel, go the Window > Extensions menu in Photoshop and
select onOne.

The onOne panel behaves just like any other panel in Photoshop. It can be minimized or
nested with other panels. To access a module, simple double-click on it. To use a preset,
single click on the module name. A menu of available presets will be displayed. Simply double-
click on one to apply it to your selected layer.

If you wish to record actions using Perfect Photo Suite be sure to access it from
the File > Automate menu when recording.
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[Using with Adobe® Lightroom®]

If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® version of Perfect Photo Suite you can access Perfect Photo Suite as a
plug-in inside of Lightroom. This provides an integrated, round-trip workflow.

Perfect Photo Suite is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Photo Suite with Lightroom. 

Plug-In Extras

Perfect Photo Suite can be accessed from the File > Plug-in Extras menu. This is
the preferred way to access it. It gives you access to all installed modules and has
the most flexibility in how the files are handled. To edit an image in Perfect Photo
Suite follow these steps.

1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select the module you would like to use.

When you access Perfect Photo Suite as a plug-in from Lightroom the module
selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same
editing session. At the end of the editing session you must save and close the
image from the Perfect Layers module.

When you select a module other than Perfect Layers or Perfect Mask your image
will be sent to it directly and when you press Apply, the image is saved and closed
automatically and you are returned back to Lightroom.

Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on which
modules you select.

Perfect Layers or Perfect Mask: Multiple images will be merged into a new,
multilayered file. Then you may access any modules available in the Module
Selector.
All other plug-ins: The first image will be opened in the selected module.
You make your adjustments and then when you hit apply the image is
automatically saved and closed. Then the subsequent images are
processed with the same settings automatically.

Lightroom Plug-in Preferences 

When you use Perfect Photo Suite through the Plug-In Extras menu there are
important file handling options that are controlled in the Preferences dialog of the
Perfect Layers module. These need to be configured in advance based on your
desired workflow.

File Type: The file type drop-down menu determines what type of file will
be created. The default is PSD, which maintains layers. You can also select
JPG or TIF if you prefer those formats and are not concerned about
maintaining layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which are saved as
PSD.
Color Space: The color space drop-down menu determines what RGB
working color space is used; Adobe RGB 1998, sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the bit depth,
either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the resolution of
the file.
Stack with Original: When enabled, the new image is stacked with the
original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select a single PSD
file, it will be edited directly, rather than having a copy made.

External Editor
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You can also access modules as external editors for all modules except Perfect
Layers or Perfect Mask. You can access them from the Edit In contextual menu.
These behave similarly to the plug-ins in the Plug-In Extras menu but ignore the
preferences set in Perfect Layers. Instead you have the option to control a subset
of these options each time you access a module, in the same way you do when you
access Photoshop or any other external editor.

Batch Processing

There are two ways to batch process multiple images in Lightroom with Perfect Photo Suite. It depends on the number of images that you want to process and
where you want them saved as to which method is best.

Small Batches

If you have a small number of images you can batch process them using the same method you would process a single image using the plug-in from the Plug-in
Extras menu. A good example would be two similar images that you would like to process the same way. Follow these steps.

1. Select both images.
2. Go to the Plug-in Extras menu and select the module you would like to use.
3. The first image will open in the module, do your work.
4. Press Apply.

The first image will be saved and closed automatically. The second image will be opened in the module and the settings used on the first image will be applied
automatically, then it will be saved and closed and you will be returned to Lightroom.

Remember, you can't batch process with Perfect Layers or Perfect Mask, your images will be stacked to create a new multilayered file
instead.
If you need to use brushes to apply effects, you should not batch process as brushing is not repeated on multiple images.

Large Batches

If you need to batch process a large number of images, or control the
file size, naming or save to location you should batch process through
Lightroom's Export dialog, located in the File menu. Batch processing
through Export is driven by presets, so you need to create a preset that
accomplishes the work you desire first.

1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select the module to

use.
4. Complete the module specific options below. These will start with

the preset, followed by options for selecting the export location,
file naming, file size, etc.

5. Press the export button.

You cannot save Lightroom export presets or use the Export with Previous option. 
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[Using with Apple® Aperture®]

If you have the Premium or for Adobe® Lightroom® & Apple® Aperture® Edition of Perfect Photo Suite you can access Perfect Photo Suite as a
plug-in inside of Aperture. This provides an integrated, round-trip workflow.

Perfect Photo Suite integrates tightly with Apple Aperture and provides a seamless
experience for enhancing your images.

Perfect Photo Suite can be accessed from the Photo > Edit with Plug-In menu. To
edit an image in Perfect Photo Suite follow these steps.

1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.

When you access Perfect Photo Suite as a plug-in from Aperture the module
selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same
editing session. At the end of the editing session you must save and close the
image from the Perfect Layers module.

When you select a module other than Perfect Layers or Perfect Mask your image
will be sent to it directly and when you press Apply, the image is saved and closed
automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which
modules you select.

Perfect Layers or Perfect Mask: Multiple images will be merged into a new,
multilayered file. Then you may access any modules available in the Module
Selector.
All other plug-ins: The first image will be opened in the selected module.
You make your adjustments and then when you hit apply the image is
automatically saved and closed. Then the subsequent images are
processed with the same settings automatically.

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Photo Suite will
maintain the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store
re-editable layers and mask.

Introduction  19

Perfect Photo Suite



 

Using with Other Applications

You can use Perfect Photo Suite as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application
user guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include
selecting Perfect Photo Suite setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto. 

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option

(note if you have ever selected another external editor, it may be
listed here instead.)

4. From the Choose dialog that appears, navigate the the Perfect
Layers folder, inside the Applications folder and select Perfect
Layers.

5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .
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Perfect Layers (Home)

Perfect Layers is the home base module for Perfect Layers. It is responsible for:

The opening and saving of files
Merging multiple files into a single, layered file
Selecting the layer you would like to work on in other modules

Depending on how you access Introduction you may never notice Perfect Layers, but it is there
working in the background each time.

On its own, Perfect Layers is incredibly useful, especially if you don't own Adobe Photoshop. It is the
fast and easy way to a layered workflow. Use it to change skies, composite multiple images together
or retouch portraits.

Some of the features:

Combine multiple images into a layered Photoshop-compatible file.
Adjust layer size, position, blending mode and opacity.
Use the built-in layer masks and masking tools to blend multiple layers together.
Use the Retouch Brush to remove blemishes and dust spots.

With Perfect Layers, multiple images can be merged as separate layers of a single new file. Then
photographers can easily reorder and position each layer; As well as change blending modes and
opacity. In addition, photographers can selectively blend, or mask layers together using the Masking
Brush and Masking Bug developed originally for PhotoTools and FocalPoint. Perfect Layers saves its
work as native layered Photoshop files so users can open them directly with Photoshop for additional
editing.
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This getting started section will give you the basics of using Perfect Layers. If you have never used
Perfect Layers before, this is a good place to start. You might also try watching the getting started
video tutorial. For detailed information on steps and controls mentioned in the getting started section,
see the "Using Perfect Layers" section instead. 

Pages in this Section
Perfect Layers Workspace
Perfect Layers Tool Well
Using the File Browser
Navigating the Preview
Navigator, Loupe, Histogram and Info
Preview Window Modes

 

 

Getting Started
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Perfect Layers Workspace

Perfect Layers provides you with an easy-to-use work space for editing your photos. Below is an overview of the main sections. 

The Main Window:

The main window sections of Perfect Layers:

A. Browser Section: This is located on the left side of the window. It is where you browse and select your images.

B. Tool Well: This is where the tools are located.

C. Preview Window: This is the main section where you preview and work on images.

D. Tool Options Bar: This strip above the preview window contains the options for the selected tool.
E. Navigator, Loupe Histogram and Info Pane: This pane will access navigational, loupe,histogram features as well as file information.

F. Layers Pane: This is where you control the image order and apply blending modes.

G. Module Selector: This is where you select other modules to work in.

H. Close & Save Buttons: This is one way to save or close the current image.
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Perfect Layers Tool Well

There are nine different tools in the tool well.

More details about each tool are covered in the following chapters, click on a tool title to learn how to use it.

 Transform Tool  This moves and changes the size and rotation of your layer.

 Crop Tool  This crops your image.

 Trim Tool  This trims a single layer.

 Masking Brush  This masks areas using brush strokes to expose underlying layers.

 Masking Bug  This masks areas using gradients to expose underlying layers.

 Retouch Brush  This retouches small imperfections.

Red Eye Tool  This tool reduces red eye.

 Pan Tool  This tool repositions your image within the preview window. 

 Zoom Tool  This tool changes the magnification in the preview window.
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Using the File Browser

Built into Perfect Layers is a file browser, located in the left panel. You can use it to browse your images as well as content you download from the onOne
website. The browser starts by displaying a series of sample images used in many of the onOne Software video tutorials. Below is a description of the controls in
the file browser.

A. Browser Tabs: This switches between the Browser tab and the Extras tab. The Extras tab displays
the included backgrounds, borders and textures.
B. Folder Tree: This drop-down menu displays the folder paths above the folder you are browsing. You
can use this to quickly navigate up the folder tree. The currently selected root folder is displayed here as
well.
C. Search Field: Use the search field to locate files in the current sub-folder. Simply start to type and
your results will appear in a new sub-folder called search results while you type.
D. Image File: A file is displayed as a thumbnail of the image and will have the filename and extension
listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of the
browser or close it.
F. File Info: This window will show captured and modified dates, color space, exposure settings and size
on disk if applicable.
G. Browser Modes: These icons control the browser views. One column, two column, three column or
list view.
H. Quick View Browser Button: Press this button to open the current folder in the Quick View
Browser.

Browsing a Folder

You can select which folder to browse by selecting Browser... in the File menu.
The last folder you browsed will be remembered and displayed automatically.

Navigating the Browser

To open a sub-folder, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
Double-clicking on a folder sets it to the root folder and its name will appear in the folder tree drop-down.
The selected item, either a folder or file, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close folders using the command (control on Windows) up and down arrows.
You can select multiple files by holding down the shift key.

You cannot move or delete files from the File Browser.

Opening Files from the Browser

You can open an image in the browser by double-clicking it. If you already have an image open you will be prompted to either merge the selected file as
anew layer or to open it as a new file.
If you have multiple images selected, you can open them as layers using the Open Selected from Browser command in the File menu.
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Searching for Files

To search for files in the currently selected folder, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on an image, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four viewing modes. Three
that display thumbnails in columns and one list
view. The browser modes are selected using the
browser mode icons at the bottom of the
browser.

   single column view    two column view    list view

Extras Tab

The Extras tab displays add-on content including backgrounds, borders and textures.
When you download content packs from the onOne website they are automatically installed in the Extras tab.

Quick View Browser
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The Quick View Browser adds an
elegant full-screen view of your
images, effects and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.

Browse folders and
images quickly to find
the right one to work on.
View all your effect or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate.
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.
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Navigating the Preview
Perfect Layers provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

 

Perfect Layers (Home)  29

 

Perfect Photo Suite



The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 The Info panel is not visible when you access Perfect Layers as a Photoshop plug-in.
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The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

Top-Bottom Screen. Top-Bottom Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

Preview Window Modes
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This section covers the complete use of Perfect Layers. It includes how to use each tool and control
as well as information on preferences and menu options.

Pages in this Section
Creating a New File and Adding Layers
Adjusting Canvas Size
Cropping the Image
Working with Layers
Masking Layers
Preferences
Menus
Keyboard Shortcuts

 

 

Using Perfect Layers
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1. Create a new, empty file from the File > New menu. The New Image dialog is presented,
see the image to the right. From the New Image dialog, you have the following options.

Name: Presets the name of the image.
Preset: Lists a range of preset image dimensions for common print sizes.
Width: Sets the width. There is a drop-down menu that includes inches, cm and
pixels.
Height: The same as the width, just for setting the height.
Swap Dimensions button: Pressing this button will swap the current width
and height.
Resolution: Sets the resolution of the image.
Color Space: Sets the color space (icc profile) of the image. The default is set
based on the user preferences. Only RGB color space profiles are available.
Bit Depth: Sets the bit depth of the image, either 8 or 16 bit.

1. Merge one or more images together using the Add Layer from File command.
2. Merge one or more images together using the Lightroom or Aperture plug-ins or external

editor option.
3. Dragging one or more images onto the Perfect Layers icon.

You may add images (flat or layered) as layers into an open file by:

1. Using the Add Layer from File command from the File menu.
2. Using the Lightroom or Aperture plug-ins when an image is already open.

Attempting to open or merge files from the application icon or from the Lightroom or Aperture
plug-ins will prompt the user to either merge the files into the existing image or create a new one.

Creating a New File and Adding Layers
You can create a new file in several ways. 

Adding Layers from Files
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The canvas size, or image size is the aperture through which you view the layers. An
image may have layers that are larger than the canvas size and are partially hidden by
the canvas size aperture.

1. When creating a new empty file from the File > New dialog, an arbitrary size is
set by you. When creating a new image, you have the option to set the
resolution.

2. When creating a new PSD file by merging other files together using the Add
Layer from File command, the source image that has the largest pixel
dimensions will become the bottom most layer and will set the canvas size. The
canvas size is adjustable by the user.

3. When opening an existing PSD file, the canvas size is already set. The canvas
size is adjustable by the user by accessing the Canvas Size dialog from the Edit
menu.

Layer image data outside the canvas area is maintained.

Adjusting the Canvas Size

1. In the top section, Current Size, it displays the current canvas size and is non-editable.
2. Below the Current Size is the New Size section. It displays the current width and height and is editable. 

There is a drop-down menu with options for pixels, inches, and cm.
There are width and height fields where you can adjust the canvas size.
The canvas size dialog does not interpolate (resize all the layers at the same time). This is the same as the image size dialog box in Photoshop
when the resize image option is disabled.
There is a lock proportions toggle that locks the width and height proportions together. Adjusting the width will change the height
proportionally. This option is on by default.
At the top of the new size section is a pop-up called Set To. 

The values in the pop-up are; Current Layer, All Layers and Custom.

When a user selects the current layer option, the width, and height are set to the size of the currently selected layer(s).
If the user selects all layers, the width and height are set to the union of all the layers, making all the pixels on all layers visible
in the canvas.
If the user selects one of the layer size options and then manually overrides them, the pop-up changes to custom.

Adjusting Canvas Size
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The crop tool removes any pixels outside a crop box
and changes the canvas size at the same time. To
crop the image, select the Crop Tool from the tool
well. Then drag a box over the area you wish to
keep. The area outside the crop box appears
darkened for guidance. You can resize and move
the crop box. When you are satisfied with your
settings, press the Apply button in the Tool Options
Bar or press enter.

Moving the Crop Box

To move the Crop Box, simply click and drag inside
the box. You can also nudge the box using the
arrow keys on your keyboard.

Resizing a Crop Box

To resize the Crop Box, click and drag on any of the resize handles. Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a
side handle allows you to adjust that side. If you hold the shift key down while adjusting the size, the proportions of the box are maintained. You cannot rotate
a Crop Box. You can enter the size in pixels of the crop box by typing in the width and height fields of the Tool Options Bar. There are also buttons to
automatically set the crop to the current layer or canvas size.

Cropping the Image

Crop Tool: This is used to crop the entire image.
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Working with Layers

The concept of a layers and a layered workflow is the key benefit of Perfect Layers. Having the ability to create composites of multiple layers is the most
powerful tool in a photographer's arsenal and is the hear of many photographers workflows. This feature is lacking in Lightroom and Aperture and requires
photographers to purchase Photoshop which is expensive and cumbersome to learn.

Articles in this Section

The Layers Pane
Transforming Layers
Trimming Layers
Using Color Fill Layers
Retouching Layers
Red Eye Tool
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Layer Visibility

You may change the visibility of a layer (hide it) by pressing the eye icon to the left of the layer
thumbnail. This will hide a layer without deleting it. You can hide all layers except the current layer by
holding the option (Mac OS X) or alt (Windows) key when clicking on the eye icon. This is especially
useful for viewing the bottom most layer, which in some cases is the original image. This acts like a
before and after preview.

Changing Layer Order

You may change the order of layers by dragging and dropping layers into the order you prefer. You
may select multiple layers at the same time by holding down the command (Mac OS X) or control
(Windows) key while clicking.

Renaming Layers

You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your
preferred name and press enter. When merging files together the layer name is the name of the
source image. This is a useful verification of the source image.

Deleting a Layer

You may delete a layer by selecting the layer, then pressing the Delete button. You may also use the Delete key on your keyboard.

Duplicating a Layer

You may duplicate or copy the current layer by pressing the Copy button. You may also use the command (Mac OS X) or control (Windows) + J keyboard
shortcut.

Merging Layers

You may merge layers by selecting them and then pressing the Merge button. You may also use the command (Mac OS X) or control (Windows) + E keyboard
shortcut.

Creating Color Fill Layers

Color Fill Layers are new layers filled with a solid color. They are useful for altering the color and tone of the image. To create a Color Fill Layer, press the Fill
button. You can learn more about using Color Fill Layers here.

Changing Blending Modes

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending mode is normal. This maintains the full opacity of the
upper layer. Perfect Layers also supports many other blending modes which can be used to alter the brightness, contrast and color of the image by combining
either a copy of the underlying layer or a Color Fill Layer. 

Changing Opacity

The opacity slider controls how opaque, or how strong the selected layer is. The default is 100%. At lower settings, the layer will blend with the layer(s) under
it. Altering the blending mode and opacity of a layer can create a wide range of color and tone effects.

Layer Masks

If you use any of the masking tools, a layer mask will be created automatically. A layer mask appears as grayscale thumbnail next to the layer icon. There is no
need to select the layer mask to work on it, invert it, or reset it. Think of it as always selected with the layer.

 

The Layers Pane

Layers are listed in the Layers Pane, located in the right column. It lists the layers and contains the controls to adjust them.
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A layer may be repositioned, sized or rotated using the Transform Tool. When the Transform
Tool is selected, transform handles will appear on the edges of the selected layer. You use
these transform handles to manipulate the image. You can only transform one layer at a
time.

Repositioning a Layer

To reposition a layer, simply click and drag inside the transform box. You can also use the
keyboard arrow keys to nudge a layer one pixel in any direction.

Resizing a Layer

To resize a layer, click and drag on any of the transform handles. Clicking on a corner handle
allows you to adjust two sides simultaneously. Clicking on a side handle allows you to adjust
that side. If you hold the shift key down while adjusting the size, the proportions of the layer
are maintained. If you hold down the option (Mac OS X) or alt (Windows) key while resizing
your image will resize from the center instead of from the edge. You can hold down both the
shift and option or alt simultaneously to resize, proportionally from the center. 

You can also type in the size you desire in the Tool Options Bar (see below) in the width and
height fields. You can also size a layer to fill the canvas automatically by pressing the Fill but
in the Inspector.

The Tool Options Bar

Rotating a Layer

To rotate a layer, move the Transform Tool near but just outside a corner transform handle. Notice that the tool cursor changes to a rotate cursor. Now click
and drag to rotate the layer. You can also use the opt (alt) left and right arrow keys to rotate a layer when the transform tool is selected. To rotate the layer
quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool Options Bar.

Flipping a Layer 

You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar.

When you have completed your transforms you need to commit the changes. You can do this by pressing the Apply button that appears in the Tool Options
Bar or by pressing the enter key. You can cancel a transform by pressing the Cancel button in the Tool Options Bar or by pressing the escape key.

Transforming Layers

Transform Tool: The Transform Tool is located at the top of the tool well. It is used to manipulate the image and layers.
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Using the Trim Tool

To trim a layer, select the Trim Tool from the tool well. It looks like a pair of scissors. Then
drag a box over the area you wish to keep on the selected layer. The area outside the trim
box appears darkened for guidance. You can resize and move the trim box. When you are
satisfied with your settings, press the Apply button in the Tool Options Bar.

Moving the Trim Box

To move the Trim Box simply click and drag inside the box. You can also nudge the box
using the arrow keys on your keyboard.

Resizing a Trim Box

To resize the Trim Box, click and drag on any of the resize handles. Clicking on a corner
handle allows you to adjust two sides simultaneously. Clicking on a side handle allows you
to adjust that side. If you hold the shift key down while adjusting the size, the proportions
of the box are maintained. You cannot rotate a Trim Box. You can manually enter the size
of the trim box in pixels using the width and height fields in the Tool Options Bar (see
below).

When you have completed your adjustments, you need to commit the changes. You can do
this by pressing the Apply button that appears in the Tool Options Bar or by pressing the
enter key. You can cancel a transform by pressing the Cancel button in the Tool Options
Bar or by pressing the escape key.

The Trim Tool Options Bar

Trimming Layers

Trim Tool: The trim tool is used to trim or crop a layer. It removes any pixels outside of a crop-style box for the current layer. 

Perfect Layers (Home)  39

Perfect Photo Suite



Color Fill Layers provide fast, re-editable ways to alter the brightness,
contrast and color of your image. Color Fill Layers leverage the power of
layers, blending modes, and opacity. Color Fill Layers are simply layers filled
with a solid color. However by changing the color, blending mode, and
opacity along with Perfect Layer's masking tools you can do the following:

Create a burn or dodge layer to selectively lighten or darken the
image.
Convert the image to black and white.
Tint the image any color.
Add a vignette.
Simulate photographic filters like warming and cooling.
Create darkroom looks like sepia toner.

Creating Color Fill Layer

To create a Color Fill Layer, press the Fill button in the Layers Pane or use
the New Color Fill Layer command from the Layers menu. The Color Fill Layer
dialog will appear. With this dialog you can select a preset or manually adjust
the color, blending mode, and opacity of the Color Fill Layer.

1. Preset: This pop-up list contains presets for many common filter
effects. Select a preset from the menu to preview it on your image.

2. Fill Color: This is a color well that displays the current color. You
may press the color well to open a color picker dialog. Selecting new
colors in the color well will be previewed in realtime on the image.

3. Blending Mode: This option sets the blending mode for the layer. 
You can always change this later from the Layers pane.

4. Opacity: This slider sets the opacity for the layer. You can think of
this as a strength slider for the effect. You can always change this
later from the Layers pane.

Editing a Color Fill Layer

You can edit an existing Color Fill Layer by using the Edit Color Fill Layer
option from the Layers menu. It will reopen the Color Fill Layer dialog where
you can adjust the settings.

Color Fill Layers work similar to a regular layer. You can move, resize, rotate,
trim, delete and duplicate them.

Masking a Color Fill Layer

You can mask, or selectively apply a Color Fill Layer using any of the masking
tools in Perfect Layers, similar to any other layer. To learn how to mask a
layer, see the Masking Layers section.

Before After

 

 

Using Color Fill Layers
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Retouching Layers

Retouch Brush: Use the Retouch Brush to remove small imperfections like dust.

You can retouch small imperfections on a layer using the Retouch Brush. Just dab the
retouch brush on spots like acne, dust spots, power lines, etc. It looks at the neighboring
areas and fills in the brush with similar color and texture. It is best to use the smallest
brush size possible and to work by dabbing rather than making large brush strokes. If
you dab with the Retouch Brush and don't like the results, use the undo command and
try using a smaller brush or vary your brush stroke and try again. 

You can control the Retouch Brush using the Tool Options Bar (see below).

Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It works best to use a
feather larger than 50 to blend and look natural.
Brush Opacity: This adjusts how strong the retouching is. Use 100% to
completely remove an imperfection. Use a lower opacity to soften them.
W: If you have a Wacom pressure sensitive tablet, you can adjust the size of
the brush according to the pressure. Click on the "W" in the box to activate the
Wacom sensitivity controls.
Use Clone Brush: You can choose the "Use Clone Brush"  option by clicking the
the box to activate it. This will allow you to select an area to clone. Hold down
the option (Mac) or alt key (Win) and click the area you want to clone from. Then
click and drag on the area you want to clone over and it will clone from the point
you selected. You can adjust the size of brush, feather and opacity just as you
would with the regular brush. This just gives you more control over the area you
want to retouch.
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Home > Perfect Layers (Home) > Using Perfect Layers > Working with Layers > Red Eye Tool

Red Eye Tool

 Red Eye Tool: To instantly reducered eye.  

The Red Eye Tool is the perfect tool for eliminating or reducing
red eye in your images. It's a simple one-click stamp that will
immediately take care of red eye. 

You start by selecting the red eye brush in your Tool-Well. Next
adjust your brush size to be as close to the same size as the red
eye you are wanting to remove. Then dab the tool over the
eyes.

The Protect Skin toggle reduces the tools affect on skin colored
areas. It is on by default. If the red-eye reduction is not strong
enough, try toggling this off.
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You can think of masking as painting with black paint on white paper. A white mask
reveals all the layer that the mask is attached to. An all white mask is considered
blank or empty and shows all the selected layer. As you use the masking tools, you
are adding black paint (Paint-Out mode). Where you paint with black you are hiding
the current layer, allowing the layer(s) under it to show through. Think of it like
cutting a hole in the mask. If you make a mistake, you can switch your paint color
to white (Paint-In mode) and paint the layer back in like an eraser. When you paint
you have more than just white or black, but any shade of gray in between
depending on the opacity of the brush. Shades of gray partially hide the layer,
blending the layers together. 

Each layer in Perfect Layers has a mask automatically added to it. This allows you
to blend each layer differently. Masking in Perfect Layers is done in a
nondestructive, re-editable way that is compatible with Photoshop. The masking
done in Perfect Layers is stored as layer masks which can be viewed and edited
later in Perfect Layers and Photoshop.

There are several global masking options that can be accessed from either the Tool
Options Bar or the Masking Menu. They affect the entire mask on the selected
layer.

Reset Mask

Reseting a mask returns it to all white. The entire layer is visible.

Invert Mask

Invert swaps the white for black and black for white. What was hidden is now
revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a
small area.

Copy and Paste Mask

Perfect Layers allows you to copy the mask from one layer to another. This is
handy if you have painted a complex mask on one layer for an adjustment and you
wish to use the same mask on another layer for a different adjustment. To copy or
paste a mask, use the Copy Mask and Paste Mask commands from the Masking
menu. It is important that the source and target layers are the same size, or you
may get odd results.

 

 

Masking Layers

Masking allows you to selectively blend layers together. It is the heart of using Perfect Layers. 

Creative examples of what you can do with masks:

Change heads from one image to another.
Replace the sky by merging exposures or image together.
Add a vignette.
Burn or Dodge to lighten or darken selective areas.
Combine a motor drive sequence.
Create a montage.

Perfect Layers (Home)  43

 

Perfect Photo Suite



The pulldown Mask Mode is located at the bottom of the
Preview Window

 
 A close-up of the Mask Mode and options

 

All Layers (default option, this shows the mask for the current layer).
Mask-Red (this shows the mask for the current layer).
Mask-White (this shows the mask for the current layer).
Mask-Dark (this shows the mask for the current layer).
Mask-Grayscale (this shows the mask for the current layer).
Current Layer (Displays only the currently selected layer, this is the same as
option-clicking on a layer).

                         

   

   

Mask-Red
The masked area appears as 50%
red. This is similar to the Quick Mask
view in Photoshop.

 

Mask-White

The masked area
appears as solid
white.

Mask-Dark

The masked area appears as 90%
black.

 

Mask-Grayscale

The masked area
appears as black.
The unmasked
areas appear as
white. This is the
same as viewing a
layer mask in
Photoshop.

 

Mask Modes

Mask Mode allows you to view your image mask in several ways.

Mask Mode allows you to view the mask for each layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several modes,
which are accessible from the Show Mask pop-up in the Masking Pane, from the Masking menu, the masking tool inspectors or from the preview window mode
pop-up in the bottom left of each preview pane. Below are examples of the different mask view modes. You can toggle the mask view on and off with the
command (Mac OSX) or control (Windows) plus m keyboard shortcut.
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The Masking Brush is one of two tools in Perfect Layers for masking layers. When you
select the Masking Brush, your tool icon changes to a circle that represents the size of
the brush. It may also appear as two concentric circles (see below), indicating the
inner hard edge and outer soft edge of the brush if the feather control is set above
zero. There is also either a plus or minus in the center of the brush. Minus means the
brush mode is set to paint-out, plus means it is set to paint-in.

How to use the Masking Brush

To use the Masking Brush, select it in the tool well. Make sure you are on the layer you wish to hide. Then check your brush mode and confirm it is set to Paint-
Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying layer(s) appear. If you make
a mistake while brushing you have several options to correct them:

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.

The Masking Brush Tool Options Bar

Paint Mode

The paint mode controls is you are Painting-Out (hiding the layer) or Painting-In (restoring the layer). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily. 

Invert Mask

Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask with the command (Mac OS X) or control
(Windows) I keyboard shortcut, or by pressing the Invert button in the Tool Options Bar.

Reset Mask

Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.

Brush Size

You can control the size of the brush using the Size pop-up in the Tool Options Bar.
You use a small brush at high magnification for precise work, and a large brush at fit to
screen for general work. To the right, you can see examples of brush strokes at
varying sizes. You can control the size of the brush several ways:

Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Using the Masking Brush

The Masking Brush: The Masking Brush functions like a brush tool for masking layers. 
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Feather

You control the amount of feathering or hardness of the brush by using the Feather
pop-up in the Tool Options Bar. The feather has a range from 1 to 100 percent. You
use a small feather at high magnification for precise, hard-edged work and a large,
soft-edged brush at fit to screen for general work. You can visually see your feather
by watching the outer concentric circle of the brush tool. To the right you can see
examples of different feather options. You can control the size of the brush several
ways:

Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [  ] ).

 

Opacity

You can control the opacity, or strength of the brush with the Opacity pop-up in the
Tool Options Bar. Think of the opacity as the shade of gray you are painting with. The
opacity has a range from 1 to 100 percent. You use a high opacity to paint quickly and
hide large areas. You use a lower opacity for blending areas together or for subtle
work. To the right you can see examples of different opacity options. You can control
the size of the brush several ways:

Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

 

Wacom® Controls

Perfect Layers supports pressure sensitive Wacom tablets. When you use the Masking
Brush you can enable pressure sensitive controls for the brush size, brush opacity, or
both simultaneously. Click on the W button next to each control in the Tool Options
Bar to activate the pressure sensitive controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right you
can see examples of how pressure sensitivity can be used to control the Masking
Brush.
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Perfect Brush

The Perfect Brush option enableds a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from being
applied across edges. A great of example of using the Perfect Brush option would be
to mask a sky along a horizon of mountains.

Tip: You can turn the Perfect Brush on and off using the command or control
-r keyboard shortcut. You can also temporarily lock the color to remove by
holding down the control key(win) or the command key(mac). This is useful
when brushing through areas with a lot of openings like tree branches.
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Below is the Tool Options Bar that contains the controls for the Masking Bug.

Using the Masking Bug

Masking Bug: This is used for masking layers by creating gradient masks in either a round or rectangular shape.

The Masking Bug is perfect for tasks like swapping skies, creating vignettes and graduated filters using Color Fill Layers. Learning to use the Masking Bug is fast
and easy. All the adjustments made with the Masking Bug are live and readjustable while using the Masking Bug... so don't be afraid to experiment with it.

To use the Masking Bug, select it in the tool well. Select the layer you wish to mask. Now click the center of the area you wish to mask out. A new rectangular
Masking Bug appears where you click. You can change the shape from rectangle to round by using the Shape pop-up menu in the Tool Options Bar. 

Adjusting the Masking Bug

Learning to use the Masking Bug is easy and fun. Start by adding a Masking Bug to a layer and then set the Mask View mode to Mask - Grayscale. This will let
you see the Masking Bug in simple black and white.

Start by moving the Masking Bug. Click and drag inside the center square or circle.
Now change the size and angle by clicking and dragging on the the legs. The legs are the shorter limbs with closed terminals. As you pull the legs the
bug gets larger. As you twist the legs the Masking Bug rotates.
Now adjust the feather by changing the angle of the right antenna. The antennas are the longer limbs with the open terminals.
The right antenna length changes the opacity of the current layer. You won't see any change when the grayscale mask preview in on.
The left antenna length controls the opacity of the Masking Bug.
Finally tilt the Masking Bug by holding down the option (Mac OSX) or alt (Windows) key and click and drag in the body. This will tilt the plan of the bug in
3D. You can use this to change the feather or shape of the Masking Bug. To reset the angle, hold the option or alt key and double-click in the body.
You can adjust the Masking Bug while the Masking Bug tool is selected. When you change layers or switch to another tool the mask created by the
Masking Bug is rendered. If you want to use the Masking Bug again on the same layer the old Masking Bug will be replaced and you simply start again.
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Feather

You can control the amount of feathering or hardness of the edge of the Masking
Bug using the Feather Slider. The feather has a range from 1 to 100 percent. You
use a small feather to create a hard edge, a soft feather for a larger, softer
transition. To the right you can see examples of different feather options. 

You control the feather by:

Using the Feather Slider in the tool options bar.
Changing the angle of the right antenna.

 

 

 

 Hard Feather 0%  Soft Feather 50%

Opacity

You can control the opacity, or strength of the Masking Bug with the Opacity Slider.
The opacity has a range from 1 to 100 percent. You use a high opacity to completely
hide the area under the Masking Bug. You use a lower opacity for blending areas
together or for subtle work. To the right you can see examples of different opacity
options. 

You can control the opacity several ways:

Using the Opacity Slider in the tool options bar.
Changing the length of the left antenna.

   

 100% Opacity  50% Opacity

Shape

This controls the shape of the masking area. You can choose none, round or
rectangle.

Use the round Masking Bug to create vignettes or soft, round masks.
Use the rectangular Masking Bug to swap skies, add gradient filters, etc.
Use the none option to remove an existing Masking Bug from a layer.

   

 Round Masking Bug  Rectangular Masking Bug

Grid

This turns on or off the ability to view a grid that represents the area effected by
the mask. You can also set this to Auto and the grid will appear only when making
adjustments then turn off after the adjustment is made. 

Invert Mask

Invert swaps the white for black and black for white. What was hidden is now
revealed and vice-versa. Inverting a mask can be very useful. It allows you to
remove what is outside the Masking Bug rather than what is contained within. You
can invert the mask with the command (Mac OS X) or control (Windows) i keyboard
shortcut.

Reset Mask

Reseting a mask returns it to all white. The entire layer is visible.
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Retouching the Masking Bug

You can retouch the Masking Bug with the Masking Brush. The mask created by the Masking Brush sits on top of and overrides the Masking Bug. 

You can add to a Masking Bug with the Masking Brush when the paint mode is set to Paint-Out.
You can subtract from a Masking Bug with the Masking Brush when the paint mode is set to Paint-In.

Masking Bug View Options

There are several options for viewing the Masking Bug, located in the Mask Menu:

Masking Bug Tool Opacity: Not to be confused with the opacity of the mask. This option controls how visible the Masking Bug tool outline appears
on screen. If the Masking Bug is interfering with the view of the image, you can turn it down to make it more subtle. This control has no effect on how
the image itself appears.
Masking Bug Grid: This allows you to turn the grid that appears under the Masking Bug on or off. Normally, it is set to Auto, where the grid will
appear while you are adjusting the Masking Bug only.
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1. Working Color Space: When a new file is created or file is opened and has no
color profile associated with it, this is the assumed color profile for the image.
Images that come from other hosts or have tagged or embedded profiles will use
the associated profile instead.

2. Scrolling Controls: Lets you select how the mouse scroll wheel or scrolling
gesture works. The options are:

1. None: Default
2. Preview Zoom: Adjusts the zoom of the preview window. Scrolling up

increases the zoom, scrolling down decreases the zoom. It is important
that the zooming is comfortable, not too fast or slow or jerky.

3. Preview Pan: Pans the image, like using the pan tool or navigator. It is
important that the panning is comfortable, not too fast or slow or jerky.

4. Brush Size: Adjusts the size of the current tool if relevant, such as a
brush tool.

3. Preview Background Color: You may select the color of the background
behind the preview image. The default color is black. There should be options for
black, white, light gray, dark gray and custom... The custom option a color picker
where you can select your own background color.

 

 

1. File Type: Specifies four options. PSD (Supports Layers, Defaults Setting. Same
as Source (PSD for Raw). TIFF (No Layers). JPEG (No Layers).

2. Color Space: Specifies the color space to use when processing copies from
Lightroom. This is similar to the working color space pop-up in the general
preferences tab, however there are only the three options supported by
Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.

3. Bit Depth: Sets the bit depth for the copies created by Lightroom, the options
are 8 and 16 bit.

4. Resolution: Sets the resolution of copies created by Lightroom.
5. Stack with Original: Enabled by default, copies created by Lightroom are

stacked with their original or source image.
6. Use Original for Single PSDs: Enabled by default. If your selection is a single

PSD file, the original PSD is opened rather than creating a copy.

 

 

1. Memory Usage: Specifies the amount of system memory (RAM) that is used by
the application. The default 50% will work well on systems with 4-8 GB of RAM. If
you have more than 8 GB of RAM and you work with large images you can try a
larger setting.

2. VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the
application. The default 50% will work well on systems with more than 256MB of
VRAM. If you only have 256MB, try a higher setting of 70%.

3. Segmented Brush Undo: When enabled, the last brush stroke made is
segmented into many smaller strokes allowing you to undo a portion of a segment
rather than an entire segment. This is off by default to reduce the amount of
memory used for storing undo operations.

 

 

 

Preferences

The preferences dialog for Perfect Layers contains general application settings that are used by Perfect Layers. The Perfect Layers preferences are accessed
from the Perfect Layers menu on Mac or the Edit menu on Windows.  

The preferences contain the following controls:

General Settings

Lightroom Plug-In Settings

 

Performance Settings
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Perfect Layers (Mac OS X Only)

About Perfect Layers: Opens the about box, displays your version number and
activation code. (Help menu on Windows)
Preferences: Opens the preferences dialog. (Edit menu on Windows)
Quit Perfect Layers: Quits Perfect Layers.

File Menu

New: Opens the create new file dialog for creating a new file.
Open: Opens the open dialog for locating and opening an existing file.
Add Layer(s) from File: Opens the open dialog for location files to merge into the
current open file.
Open Selected from Browser: Opens the images selected in the browser.
Browse...: Opens the browse dialog where you can select which folder you would
like to browse in a new browser tab.
Browse Extras: Switches the browser to the Extras tab where you can view and
open website content.
Open Recent: Displays a list of recently opened files.
Close: Closes the current file. You will have the opportunity to save or not.
Save: Saves the current file.
Save As: Opens the Save As dialog where you can select the filename and location
to save to.
Revert to Saved: Reopens the file without your changes.
Batch: Opens the Batch mode window (Perfect Resize Only)

Edit Menu

Undo: Undoes the last action.
Redo: Redoes the last undone action
Undo Stroke: If segmented undo is enabled and the last action was a brush
stroke, this will undo the entire brush stroke rather than the last brush segment.
Redo Stroke: If segmented undo is enabled and your last action was to undo a
brush stroke, this will redo the entire brush segment.
Cut: Disabled.
Copy: Disabled.
Paste: Disabled.
Adjust Canvas Size: Opens the canvas size dialog where you can adjust the
canvas size.

Menus
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Layer Menu

Duplicate: Duplicates or copies the current layer.
Delete: Deletes the current layer.
Merge Layers: Merges the selected layers into a single layer.
Merge All: Merges all layers into a single layer.
New Stamped Layer: Creates a new layer above the current layer that contains
a merged version of all the layers under it.
Hide Other Layers: Toggles the visibility off of all layers except the current one.
Makes it easy to see just the current layer.
New Color Fill Layer: Adds a new color fill layer.
Edit Color Fill Layer: Opens the color fill layer dialog where you can set the
properties of the selected color fill layer.

Masking Menu

Invert Mask: Inverts the mask. Visible areas become hidden and hidden areas
become visible.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask from the current layer.
Paste Mask: Pastes the mask in the clipboard to the mask on the current layer.
Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool cursor.
Masking Bug Grid: Toggles the view mode of the Masking Bug grid.

View Menu

Zoom In: Adjusts the preview zoom in one increment, makes the preview image
larger.
Zoom Out: Adjusts the preview zoom out one increment, makes the preview image
smaller.
Fit to Screen: Sets the zoom to fit the entire image on screen.
Fill with Layer: Sets the zoom to fit the current layer.
Actual Pixels: Sets the zoom to 100% or actual pixels.
Show Browser Pop-up: Enables the browser pop-up window.
Browser Mode: Allows the user to select how the Browser Library displays the
categories.
Show Clipping: Shows the clipping overlay view, which over-rides the
current mask view.
Preview Mode: Allows the user to switch preview modes.
Preview Background Color: Toggles the background color options.
Show Mask: Allows the viewer to see the mask.
Mask View Mode: Allows the user to select the various mask modes.

Window Menu

Navigator/Loupe/Histogram: Opens and closes the Navigator pane.
Layers: Opens and closes the Layers pane.
Show Browser Panel: Hides or shows the Control Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Full Screen: Toggles to and from full screen mode.
Document Name: Shows the name, zoom level and bit depth of the open image.
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Help Menu

Search: Searches the menus (Mac OSX only).
Perfect Layers Online Help: Opens this html Help in your default web browser.
Video Tutorials: Opens the online Video Tutorial in your default web browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for  Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and be
walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the registration
page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.
Help Improve onOne Products: Opens the Improve onOne Products dialog.

  

 

54  Perfect Layers (Home)

Perfect Photo Suite



 

Keyboard Shortcuts

Action  Mac  Win

 New File  cmd n  ctl n

 Open  cmd o  ctl o

 Open as Layer  cmd shift o  ctl shift o

 Save  cmd s  ctl s

 Save As  cmd shift s  ctl shift s

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Undo Stroke  cmd opt z  ctl alt z

 Redo  cmd shift z  ctl shift z

 Redo Stroke  cmd shift opt z  ctl shift alt z

 Open/Close Navigator Pane  cmd 1  ctl 1

 Open/Close Layers Pane  cmd 2  ctl 2

 Open/Close Browser Panel  cmd left arrow  ctl left arrow

 Open/Close Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

 Delete Layer  del  del

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Trim Tool  t  t

 Select Move Tool  v  v

 Select Masking Brush  b  b

 Select Masking Bug  m  m

 Zoom-In  cmd + or cmd =  ctl + or ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fit to Layer  cmd shift 0  ctl shift 0

 Brush Size
 larger ]
smaller [

larger ]
smaller [

 Brush Feather
softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc 

 Layer Opacity

1 (10%)
2 (20%)
0 (100%)
etc

1 (10%)
2 (20%)
0 (100%)
etc

 Enable or Disable Perfect Brush  cmd r  ctl r

 Show Mask  ctl m  ctl m

 Toggle Mask View  cmd opt m  ctl alt m

 Invert Mask  cmd i  ctl i

 Duplicate Layer  cmd j  ctl j

 Merge Layer  cmd e  ctl e

 Merge Visible  cmd shift e  ctl shift e

 Constrain Prop  shift drag on corner  shift drag on corner

 Grow from center  opt drag on corner  alt drag on corner

 Toggle Paint-In/Paint-Out/Erase
 x
opt

 x
alt

 Toggle Single View Preview  cmd Y  ctl Y

 Toggle Left/Right Preview  cmd L  ctl L

 Toggle Left/Right Split Preview  cmd opt L  ctl alt L
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 Toggle Top/Bottom Preview  cmd T  ctl T

 Toggle Top/Bottom Split Preview  cmd opt T  ctl alt T

 Show Clipping  opt J  alt J

 Show Quick View Browser  cmd up  ctl up
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Perfect Mask

Perfect Mask is the next generation of Mask Pro, the leading software for background replacement.
Perfect Mask takes the core strengths of Mask Pro to another level, by automating many common
masking tasks with incredible accuracy.

Perfect Mask's new masking technology makes selecting subjects and isolating backgrounds
surprisingly easy. With Automatic Background Removal, an initial mask is made on your image that can
be fine-tuned using the Erase and Refine Tools. With these new features, you can create high quality
masks in just a few clicks. You'll be amazed at how well this works even when masking tough subjects
like hair and glass on complex backgrounds.

Perfect Mask works where you do with seamless integration into your workflow whether you use
Lightroom, Aperture or Photoshop. It even works as a standalone application.
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This getting started section will give you the basics of using Perfect Mask. If you have never used
Perfect Mask before this is a good place to start. You may also watch the getting started video
tutorial. For detailed information on steps and controls mentioned in the getting started section,
see the Using Perfect Mask section.

 

 

 

Getting Started
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You can think of masking as painting with black paint on white
paper. A white mask reveals all the layer that the mask is
attached to. An all white mask is considered blank or empty and
shows all the selected layer. As you use the masking tools, you
are adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current layer, allowing the layer(s)
under it to show through. Think of it like cutting a hole in the
mask. If you make a mistake, you can switch your paint color to
white (Paint-In mode) and paint the layer back in like an eraser.
When you paint you have more than just white or black, but
any shade of gray in between depending on the opacity of the
brush. Shades of gray partially hide the layer, blending the
layers together. 

 

 

Understanding Masking

Masking allows you to selectively blend layers together. 

Creative examples of what you can do with masks:

Change heads from one image to another.
Replace the sky by merging exposures or image together.
Add a vignette.
Burn or Dodge to lighten or darken selective areas.
Combine a motor drive sequence.
Create a montage.
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Perfect Mask Workspace
Perfect Mask provides you with an easy-to-use work area for editing your photos. Below is an overview of the main sections. 

Perfect Mask work area overview:

The main sections of Perfect Mask:

A. The Tool Well: This is where the tools are located.
B. The Tools Option Bar: This is where information and options about each tool is set.
C. The Preview Window: This is the main section where you preview and work on images.
D. The Modules Selector: This is where you choose which software module to use.
E. The Navigator, Loupe and Histogram Pane: This pane will access the Navigational, Loupe and Histogram features.
F. The Adjust Mask Pane: This is where you control various masking and blending modes.
G. The Colors Pane: This is where the colors you select to Keep and Drop appear in a list.
H. The Cancel/Apply Button: This is where you cancel or apply an action.
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Perfect Mask Tool Well

There are 14 different tools in the tool well. They are divided into four sections. More details about each tool will be covered in the next chapters.

 Keep Brush Tool  This tool offers a selective undo for the drop brush.

 Drop Brush Tool  This tool offers a fast way to remove large sections in a single stroke.

 Refine Brush Tool  This tool cleans up intricate areas and the borders between the Keep and Drop Brush.

 Masking Brush Tool  This masks out areas using brush strokes to expose underlying layers.

 Magic Brush Tool  This precise tool protects the Keep Colors and removes Drop Colors.

 Color Spill Brush Tool  This tool is used to help remove color spill from solid backgrounds like blue and green screens.

 Keep Color Eyedropper  Use this tool to add colors to the Keep List.

 Drop Color Eyedropper  Use this tool to add colors to the Drop List.

 Pen Tool  Use this tool for detecting and tracing edges around an image for masking.

 Chisel Tool  This tool is used for removing fringes or halos along hard edges.

 Blur Tool  This tool is similar to the chisel, but rather than removing edge pixels, it softens or blurs them.

 Bucket Tool  This tool is used to remove large areas quickly.

 Pan Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  
This tool changes the magnification in the preview window.
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Navigating the Preview
Perfect Mask provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 The Info panel is not visible when you access Perfect Mask as a Photoshop plug-in. 
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The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

Top-Bottom Screen. Top-Bottom Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

Preview Window Modes
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Simple hard edged subjects on a
solid background are very easy.

1. Start by opening an image into the
Layers module of Perfect Mask.

2. Load a new background if desired
and place it under the subject.

3. Switch to the Mask module from
the module selector.

4. Press the Remove Background
button in the Adjust Mask pane. It
will detect solid color backgrounds
and remove them automatically.

5. Press Apply to return to the
Layers module to save your
changes.

 

  

One of the more difficult subjects to mask is hair or
other semi-transparent and intricate subjects against
a varied background. Try these steps for the best
results.

1. Start by opening an image into the Layers
module of Perfect Mask.

2. Add a new background and align it in the
Layers module.

3. Next select the Mask module.

 

 

 

4. Select the Drop Tool from the toolwell and
loosely brush the areas you don't want. The
brush strokes will automatically expand to
similar colors.

 

 

5. Next select the Refine Tool and paint over
the edge of the foreground and background
to remove fringe colors or small islands of
color. You can brush over areas more than
once to improve the results.

 

 

Using Perfect Mask

Perfect Mask's new masking technology makes selecting subjects and isolating backgrounds surprisingly easy. With Automatic Background Removal, an initial
mask is made on your image and can then be fine-tuned using the Drop and Refine Tools. With these new features, you can create high quality masks in just a
few clicks. You'll be amazed at how well this works even when masking tough subjects like hair and glass on complex backgrounds.

Perfect Mask provides several ways to work depending on your user level and the type of image. It works for beginners through advanced users. Below are
example workflows for different user levels.

Simple hard edged subject on a solid background

 Complex or Semi-Transparent Subject
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1. Start by opening your subject image and
background image.

 

 

 

 

2. Determine which image is the correct size and
aspect ratio, either the subject or background. In
this example, the subject image is the correct
size.

3. Select whichever image is not the correct size,
use the select all command and the copy
command to copy the image to the clipboard.

 

 

 

4. Now return to the other image and paste the
results as a new layer.

5. Here, the new layer is a sky and should be
positioned under the subject. Drag it under the
subject layer in the Layers palette. Note that if
the subject layer is a Background Layer, it needs
to be converted into a normal layer to position a
layer under it. Simply double-click on it to convert
it to a normal layer. 

 

 

 

Preparing Your Image

To get the most out of Perfect Mask, it is best to prepare your composite layers in advance. This means placing your new background as a layer under your
subject (target) layer. This can be accomplished in Photoshop, Photoshop Elements of the Layers module of Perfect Mask. Below are instructions to get you
started.

Photoshop and Photoshop Elements
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6. Next, reduce the opacity of the upper layer to
50-70%. This makes it easier to see the subject
and background simultaneously.

7. Select the background layer.
8. Use the transform tool to size and position the

background correctly with the subject layer. Keep
in mind you can always adjust this later or change
to a different background.

9. Select the subject layer and return its opacity to
100%. Now, you are ready to start Perfect
Mask.

1. Determine which image to use as the correct
size and aspect ratio, either the subject
image or the background image.

2. Start by opening this image. In this case,
the foreground image is the correct size.

3. Next find your background image and open
it. You will be prompted to either add the
image as a new layer or create a new
image. Select the "add as new layer" option.

Tip 1: If you are working from Lightroom
or Aperture, you can open the first
image into the Layers Module, then
return to Lightroom, or Aperture, select
your background image and send it to
the Layers Module to merge it in as an
another layer.

Tip 2: If you don't have a background
that you like, try one of the included
backgrounds that come with Perfect
Mask From the Extras tab in the Layers
Module.

Layers Module of Perfect Mask
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4. The background will be added on top of the
foreground, simply drag it below in the
Layers pane.

 

 

5. Next, reduce the opacity of the upper layer
to 50-70%. This makes it easier to see the
subject and background simultaneously.

6. Select the background layer.
7. Use the transform tool to size and position

the background correctly with the subject
layer. Keep in mind you can always adjust
this later or change to a different
background.

8. Select the subject layer and return its
opacity to 100%. Now, you are ready to
start Perfect Mask.
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You can view the mask in several modes, which are accessible from the Mask View Mode at the bottom of each Preview Window pane.  

 

  

Below are examples of the different mask view modes. You can toggle Mask View on and off with the control + M keyboard shortcut.  

 

Original
Shows the original target layer, with no mask. Think of this as a before image.

Composite
Shows the current layer with the masked areas transparent so you can see the layers
under it. This is what the results will look like when you apply. Think of this as the after
image.

Red Overlay
The masked area appears as 50% red. This is similar to the Quick Mask view in Photoshop.

 

Viewing the Mask

Perfect Mask allows you to view the mask for each Preview Window pane.
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White
The masked area appears as solid white.

Dark
The masked area appears as 90% black.

Grayscale
The masked area appears as black, the unmasked areas appear as white. This is the same
as viewing a layer mask in Photoshop.

Segments
Displays the results of the initial segmentation.
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When you launch Perfect Mask it starts by breaking the image down into small similar colored segments.
The Keep and Drop Brushes are used to assign segments to be kept or removed. By default, all segments
are marked as Keep when you open Perfect Mask. 

The first step in masking most images is to use the Drop Brush and make large brush strokes through
areas you want to remove. The brush strokes you make will automatically be expanded to similar color
and textured segments. The Drop Brush offers a fast way to remove large sections in a single stroke. 

Below are descriptions of the controls in the Keep and Drop Brush Tool Options Bar.

Size: Adjusts the size of the brush. Use a large size for large areas and a smaller brush to get into the tight spots.

Refine: Sets how thick of an edge is automatically refined. This smooths out segment artifacts and reduces color fringing.

Segment: Sets the size, or mass of the segments that are created. The default setting of 8 works best for most images. You can see the segments
using segment view. If your image has few colors and is creating too many segments will little difference, try a higher setting. If your image has many
colors and gradations use a lower setting.

Tolerance: The expand tolerance controls how similar segments need to be before they are grouped together.

Auto Expand: When enabled, segments of similar color to those under the drop brush will be dropped as well.

Remove Background: Attempts to find a solid color background and remove it automatically. If you press the button and nothing happens, your
background is too varied to be removed automatically. You can increase the segment size and try again or use the Drop Brush.

Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain parameters with pressure. Controls with a W icon next to them
support this when they are turned on.

Refine Brush: This tool cleans up intricate areas and the borders between the Keep and Drop Brush.

The Refine Brush is used to clean up the borders between keep and drop segments as well as intricate
areas like hair, lace, mesh and tree branches. Once you have removed the majority of the background
with the Drop Brush, paint the intersection of the subject and background to refine the border. This will
remove islands of background color and make the edge more defined.

Below are descriptions of the controls in the Refine Brush Options Bar.

Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the intersection of the subject and background. Avoid using
oversized brushes it will take longer to process and may yield lower quality results.

Color Decontamination: When enabled, colors from the drop regions are filtered out of the keep regions. This changes the colors of the pixels in the
image. This is useful when the background you are trying to remove have a strong color such as green or blue screens.
Reset: This will reset the tool back to the default settings.

Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain parameters with pressure. Controls with a W icon next to them
support this when they are turned on.

Keep, Drop and Refine Brushes

Keep and Drop Brushes: Used to assign segments to be kept or removed.
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Magic Brush: The Magic Brush is used to make powerful and precise masks in difficult places.

The Magic Brush is the most powerful and precise tool in Perfect Mask. When you are dealing with the most difficult subjects, the Magic Brush is the go-to
tool. It works by comparing Keep and Drop colors. It protects the Keep colors and removes the Drop colors. This allows it to mask through glass, smoke,
fog or other semitransparent, non-sharp edged subjects.

Below are descriptions of the controls in the Magic Brush Options Bar.

Painting Mode: Toggles the painting mode, either Paint-Out, Paint-In or Automatic. Automatic is generally the best choice for this tool. It will paint-in
and out at the same time based on the colors.

Size: The brush size slider controls the size of the brush. Use the smallest brush needed.

Feather: The brush feather slider controls the feather, or hardness of the brush. Make sure you have a feather of at least 25 to blend in retouched
areas evenly.

Transition: The transition slider determines how hard the cut-off is between Keep and Drop colors. Think of this like feathering. A low transition setting
creates a harder edge between the Keep and Drop colors. A higher setting will create a softer transition. 

Threshold: The threshold slider determines how far away from the exact keep colors are allowed to be removed. A low threshold setting will keep only
the exact colors in the keep pane. As you increase the threshold, more colors close to the keep colors will be protected. 

The Transition and Threshold are linked together. Changing one, has the inverse affect on the other. If you can't adjust one control, try
increasing or decreasing the other. 

Reset: This will reset Tool Options Bar back to default settings.

Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain parameters with pressure. Controls with a W icon next to them
support this when they are turned on.

Color Decontamination: When enabled, Perfect Mask will attempt to remove the Drop color component from semi-transparent areas. This can be
helpful for reducing color fringing and spill colors when working on blue or green screens.

Magic Brush and Colors
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Auto Brushing

There are two ways to use the Magic Brush. The first method is called auto brushing. Start by
selecting the Magic Brush and simply click in the background, then brush into the subject. The
color to remove is automatically assigned as the color at the center of the brush when you click
down. As long as there is a strong difference between the subject and background this can be a
quick way to paint away the background.

Tip: When using the auto brush technique, you should have no colors in your Colors
pane. Be sure to confirm that the Painting Mode is set to Paint-out only.

Eye Dropper Tools

The second and more precise way to use the Magic Brush is to select colors to keep and drop
using the Eye Dropper tools. The Eye Droppers live in the tool well. There are two droppers; one
for selecting colors to keep and one for selecting drop colors. It is best to zoom into at least
100% or use the Loupe tool when selecting colors. When working with selecting colors for the
Magic Brush, it is best to work in small, similar colored sections. 

Avoid selecting every keep and drop in your image. The Keep and Drop colors and Magic Brush
are global tools, meaning that they don't care what area of the image you are painting. If you
have the color blue for example that you want to remove from the background, but your
subjects eyes are blue... if you paint over both areas the background and eyes would be
removed.

To deal with similar colors in different regions, you can create different color sets. In the
Colors pane you can create as many Keep and Drop color sets as needed. 
To create a new color set, press the Add button at the bottom of the Colors pane. You
have the option to create either a new Keep, Drop, or both color sets.
You can also disable a set by clicking on the toggle in its upper left corner.
You can delete a color or a set, depending on your selection by pressing the delete
button.
You can manually adjust a color by double-clicking on it. This will open a color picker
where you can see the color values as well as adjust the color if needed.

Once you have selected the Keep and Drop colors for your region, brush over it with the Magic
Brush. If the results are not as desired, refine your Keep and Drop colors and brush over the
region again.

Tip: Keep the number of colors per set to less than six to maintain optimum
performance. You can create as many sets as you need as you work your way
around the image.
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Color Spill Brush: The color spill brush removes reflected or transmitted background color from the keep or edge areas.

It works by removing adjacent colors marked by the drop brush without altering the transparency. This brush is useful for removing reflected or spill color
from reflective, opaque subjects such as chrome, leather, metals, etc. It is not desirable to alter the opacity of these opaque areas, as they are not near
the edge of the subject. Instead the reflected color needs to be painted away.

Below are descriptions of the controls in the Color Spill Brush Tool Options Bar.

Size: The brush size slider controls the size of the brush. Use the smallest brush needed.

W: When selected, this activates the Wacom brush controls.

Feather: The brush feather slider controls the feather, or hardness of the brush. Make sure you have a feather of at least 25 to blend in retouched
areas evenly.

Strength: The brush slider controls the strength of the brush.

Smart Strength: When the Smart Strength option is enabled, the strength is automatically adjusted based on how strong the local drop colors are.

Override Color: When enabled, the Color Spill brush paints with the color you specify rather than one determined automatically. You can select the
color to paint with either with the associated dropper tool or by clicking on the color well.
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The Masking Brush in Perfect Mask is the same as in other onOne modules, or using
the paint brush in Photoshop. When you select the Masking Brush, your tool icon
changes to a circle that represents the size of the brush. It may also appear as
two concentric circles (see below), indicating the inner hard edge and outer soft
edge of the brush if the feather control is set above zero. There is also either a
plus or minus in the center of the brush. Minus means the brush mode is set to
paint-out, plus means it is set to paint-in.

How to use the Masking Brush

To use the Masking Brush, select it in the tool well. Make sure you are on the layer you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying layer(s) appear. If
you make a mistake while brushing you have several options to correct them:

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.

The Masking Brush Tool Options Bar

Paint Mode

The paint mode controls is you are Painting-Out (hiding the layer) or Painting-In (restoring the layer). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily. 

Invert Mask

Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask with the command (Mac OS X) or control
(Windows) I keyboard shortcut, or by pressing the Invert button in the Tool Options Bar.

Reset Mask

Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.

Brush Size

You can control the size of the brush using the Size pop-up in the Tool Options
Bar. You use a small brush at high magnification for precise work, and a large
brush at fit to screen for general work. To the right, you can see examples of
brush strokes at varying sizes. You can control the size of the brush several
ways:

Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Masking Brush

The Masking Brush: The Masking Brush functions like a brush tool for masking layers. 
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Feather

You control the amount of feathering or hardness of the brush by using the
Feather pop-up in the Tool Options Bar. The feather has a range from 1 to 100
percent. You use a small feather at high magnification for precise, hard-edged
work and a large, soft-edged brush at fit to screen for general work. You can
visually see your feather by watching the outer concentric circle of the brush tool.
To the right you can see examples of different feather options. You can control
the size of the brush several ways:

Use the Feather pop-up in the Tool Options Bar.

Use the shift + left and right bracket keys ( [  ] ).

 

Opacity

You can control the opacity, or strength of the brush with the Opacity pop-up in
the Tool Options Bar. Think of the opacity as the shade of gray you are painting
with. The opacity has a range from 1 to 100 percent. You use a high opacity to
paint quickly and hide large areas. You use a lower opacity for blending areas
together or for subtle work. To the right you can see examples of different
opacity options. You can control the size of the brush several ways:

Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

 

Wacom® Controls

Perfect Mask supports pressure sensitive Wacom tablets. When you use the
Masking Brush you can enable pressure sensitive controls for the brush size,
brush opacity, or both simultaneously. Click on the W button next to each control
in the Tool Options Bar to activate the pressure sensitive controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right
you can see examples of how pressure sensitivity can be used to control the
Masking Brush.
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Mode: Select remove or restore.

Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing
fast. The size of the chisel does not affect how much is chiseled off.

Amount: Controls the amount, or depth of the chisel. Use the lowest amount needed to
maintain as much detail as possible.

Chisel Hardness: Adjusts how sharp the edge created by the chisel is. The higher the
amount, the softer the edge.

Tip: You can double-click on the chisel tool icon in the toolwell to apply the
chisel to the entire image.

Mode: Select remove or restore.

Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing
fast. The size of the brush does not affect the blur amount.

Amount: Controls the amount of blur. Use the lowest amount needed to maintain as
much detail as possible.

Hardness: Adjusts how sharp the edge between the blurred and sharp area is. The
higher the amount, the softer the edge.

Tip: You can double-click on the blur tool icon in the toolwell to apply it to the
entire image.

Clean Up Tools
Perfect Mask features several handy clean-up tools. The clean-up tools are located towards the bottom of the toolwell on the left side of the screen. The clean-
up tools are the chisel, blur and bucket.

 The Chisel Tool: The Chisel tool is used for removing fringes or halos along hard edges.

Fringes are common when the background to be removed is brighter than the foreground. The chisel works like a chisel or plane in a wood shop. It removes just
a sliver along the edges. The chisel tool only works on the edges so you don't have to be careful with it.

The Blur Tool: Softens edges where you paint.

Softening the edges on blurred or semi-transparent subjects like hair can make them blend with a new background in a more realistic manner.  The blur tool only
works on the edges so you don't have to be careful with it.

The Bucket Tool: The Bucket Tool is used to remove large areas quickly. 

Simply click in any isolated area to remove it completely. It is important that the area to be removed has a completely transparent margin around it, or the
entire image will be removed instead. 
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Mode: Controls whether the bucket tool is to remove (Paint Out) or replace (Paint-In) the area that is clicked on.
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The Pen has two working modes, magic and classic.

In Magic Mode: the default, the pen attempts to detect and trace edges. It works well
when there is a significant difference between the subject and background and the edge
is variegated such as a mountain.

In Classic Mode: the pen draws straight lines from point to point that you click. You can
force classic mode by toggling the Classic Pen check-box, or by holding down the shift
key.

Area: Adjusts the size of the area that the pen tool looks at to detect an edge. Use as
small a magnetic area as possible while being practical.

Attraction: Adjusts how precise or tight the path is to the edge. If you have a highly
variegated subject use a high setting of 100 or more. If you subject is mostly straight or
curved edges, like a building try a lower setting to create cleaner, straighter lines. 

Hardness: Adjusts the hardness of the edge that is created when you select the region
to remove. The lower the setting, the harder the edge.

Classic Pen: When enabled, the pen only draws straight lines between points when you
click. This is useful when working on straight lined subjects like architecture or when the
boundary of the subject and background are ambiguous and need an artists
interpretation.

To use the Pen Tool, start by selecting it in the toolwell. Then click and hold at the edge
you want to trace. Then move the pen along the edge. You will see that the path is
attracted to the edge and attempts to trace it.

If you make a mistake, just trace backwards and the path will change.
If you let go, click on the last point and continue to work with the path.
You can manually push the path where you like by clicking in the middle and
tugging it like a string.
If you encounter an area where the pen will not detect the edge automatically,
try holding down the shift key and drawing straight line segments until the edge
becomes hard again.

You must complete a path by returning to the starting point to be able to remove the
selected area. To complete the path, hold down the shift key and move your cursor back
over the starting point. A red circle will appear and the text "Click now to close the path"
will appear. Click to close the path. 

Tip: you can automatically close the path by command (Mac) or control (Win)
clicking any time you are not over a control point. 

Pen Tool

The Pen Tool: The Pen tool works by detecting and tracing edges.

It is useful for when you have large hard-edged areas or if the difference in color between the subject and background are too close together for the color
based tools to work. The Pen creates a path, or selection. When you complete a path you have the option to remove either what is inside or side of the path.
The controls for the Pen Tool are located in the Tool Options Bar.
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When the path is complete the pen tool will turn into a gavel with either a minus or plus
symbol. Click in the region, either inside or outside the path to remove an area. If the
gavel has a plus icon, rather than minus it is set to Paint-in, instead of paint-out. Just
change the mode in the inspector. If the edge is too hard or too soft, use the undo
command, adjust the Edge Mask slider in the inspector and click again in the region you
want to remove. 

 

 Option
Mac
Modifier
Key

Windows
Modifier
Key 

Move Point Mode: Used to reposition a point. Hold the modifier key, then mouse over a point. When the icon turns to a normal
arrow you are in move point mode.

 Command  Control

Auto Close Path: Used to close a path without moving to the origin point. Hold the modifier, wait for the icon to turn to the
complete icon and click anywhere except a control point.

 Command  Control

Convert Point Mode: Used to convert a standard point into a Bezier point. Hold the modifier and move over a point. When the
icon turns to a carrot (^) click and drag on a point to reveal the handles.

 Option  Alt

Break Bezier Handles: Used to adjust Bezier handles independently of each other. Useful for complex curves. Hold the
modifier and move over a control handle. When the icon turns to a carrot (^) click and drag on the control handle to change the
angle.

 Option  Alt

Using the Classic Pen Tool

The pen tool when used in classic mode is similar to the pen tool in most illustration applications. Simply click to set a standard control point. If you click and drag
you create a Bezier control point with handles for adjusting the curve of the line segment. There are several keyboard shortcuts that are essential when using
the classic pen tool.
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Adjustments: The Adjustments button opens the Adjust Mask dialog, pictured below.
This dialog contains several global mask adjustments.

Remove Background: Attempts to find a solid color background and remove it
automatically. If you press the button and nothing happens, your background is too
varied to be removed automatically. You can increase the segment size and try again or
use the Drop Brush.

Apply As: Sets how Perfect Mask is applied. 

You can apply the results to the current layer, permanently removing pixels. This
is generally not recommended.
New Layer, this is safer as the original image is preserved, but you can not
readjust the mask. This is generally not recommended
Layer Mask, this is the default setting. The mask is stored as a re-editable, non-
destructive layer mask. Layer masks are supported by Perfect Layers, Perfect
Photo Suite and Photoshop.
Copy with Layer Mask. This is the safest option. It applies the mask as a  re-
editable, non-destructive layer mask on a copy of the original layer. keep in mind
that if you use color decontamination you are also changing the color of the
layer, not just the transparency so this option is the most flexible.

 

Adjust Mask Dialog

Accessed from the Adjust Mask pane, the Adjust Mask dialog contains several global
mask adjustments.

White Contrast: Sets the white clip point of the mask. This is useful for reducing haze
that shows too much of the original layer.

Black Contrast: Sets the black clip point of the mask. This is useful for reducing haze

 

 

Adjust Mask Pane

The Adjust Mask Pane contains several important controls that affect the entire mask or how Perfect Mask is applied.

that shows too much of the new background layer.

Feather: Softens the edge of the mask globally. Generally this is better accomplished in
a selective way using the blur tool.

Grow/Shrink: Increases or decreases the size of the mask. Shrinking the mask globally
can remove minor fringes but may sacrifice small details such as hair. Generally this is
better accomplished in a selective way using the chisel tool.

Reduce Noise: Looks for and reduces noise in the mask caused by a noisy, grainy
image or dust on the camera sensor.
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Module Settings

There is a settings dialog located in the Edit menu which contains settings
specific to Perfect Mask.

Remember tool mode for each tool: When enabled, the tool mode
(Paint-In, Paint-out, Auto) is remembered for each tool rather
than a global basis.
Segment Scaling: When Perfect Mask opens, it segments the
image into many small similar colored irregular segments. The
number of, and thus the precision of segments is determined on
the number of processing cores and the segment scaling
preference. The default setting, Smaller will be the fastest and
will take about ten seconds to process. Selecting the Medium or
Large option will take longer to load but will create smaller, more
precise segments. 
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Tip: On Windows, the preferences can be found in the Edit menu, the About Box can
be found in the Help menu.

Perfect Mask Menu

About Perfect Mask: Opens the about box. This dialog contains your serial number, version
number, and information on contacting onOne Software for support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

File Menu

Apply: Applies the current settings and options to your image and returns to the host application.

Cancel: Cancels Perfect Mask and returns back to the host application with no changes.

Edit Menu

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Undo Stroke: If the last action was a brush stroke, this reverses the entire brush stroke.

Redo Stroke: If you last action was an undo of a Brush Stroke, this reapplies the entire stroke.

Reset All: Resets all the floating palette controls back to their default settings.

Module Settings: Opens the Perfect Mask specific settings.

Preferences (Windows Only): Opens the Perfect Mask preferences dialog.

Menus

Mask Menu

Invert Mask: Inverts the mask. 

Reset Mask: Resets the mask to all white.

Remove Background: Attempts to remove the background automatically if the background color is
consistent.
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View Menu

Zoom In: Adjusts the preview zoom in one increment, makes the preview image larger.

Zoom Out: Adjusts the preview zoom out one increment, makes the preview image
smaller.

Fit to Screen: Sets the zoom to fit the entire image on screen.

Fill with Layer: Sets the zoom to fit the current layer.

Actual Pixels: Sets the zoom to 100% or actual pixels.

Show Clipping: Shows the clipping overlay view, which over-rides the
current mask view.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.
Show Mask: Allows the viewer to see the mask.

Mask View Mode: Allows the user to select the various mask modes.

Window Menu

Navigator/Loupe/Histogram: Hides or shows the navigator pane.

Adjust Mask: Hides or shows the Adjust Mask pane.

Colors: Hides or shows the Colors pane.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the open image.

Help Menu

Search: Searches the menus (Mac OSX only).

Perfect Mask Online Help: Opens this html Help in your default web
browser.

Video Tutorials: Opens the online Video Tutorial in your default web browser.

Getting Started: Opens the online Getting Started overlay
.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for  Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.

Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts

Perfect Mask has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action  Mac  Win

 Apply  enter  enter

 Cancel  esc  esc

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Reset All  cmd opt z  ctl alt z

 Switch to Pane  cmd 1,2,etc.  ctl 1,2,etc

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Keep Brush  k  k

 Select Drop Brush d d 

 Select Refine Brush  r  r

 Select Masking Brush  b  b

 Select Magic Brush  m  m

 Select Keep Dropper   

 Select Drop Dropper   

Select Pen Tool  p  p

 Select Chisel Tool  c  c

 Select Blur Tool  l  l

 Select Bucket Tool  s  s

 Zoom-In  cmd + or cmd =  ctl + pr ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fit to Layer  cmd shift 0  ctl shift 0

 Show Clipping  opt J  alt J

 Tool Size
 larger ]
smaller [

larger ]
smaller [

 Tool Feather
softer shift ]
harder shift [

softer shift ]
harder shift [

 Tool Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc 

 Toggle Paint Mode (paint-in, paint-out)
 x
opt

 x
alt

 Show/Hide Mask  ctl m  ctl m

 Toggle Mask View  cmd opt m  ctl alt m

 Preview Modes
  - Single Image
  - Left/Right
  - Left/Right Split
  - Top/Bottom
  - Top/Bottom Split

 
cmd Y
cmd L
cmd opt L
cmd T
cmd opt T

 
ctl Y
ctl L
ctl opt L
ctl T
ctl opt T 

 Open/Close Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

86  Perfect Mask

Perfect Photo Suite



Focus on the art of portrait creation because the most time consuming retouching tasks have now
been automated. With Perfect Portrait, you can improve skin texture and color, remove blemishes,
and enhance eyes, lips and teeth. You'll find that it's never been so easy to create stunning portraits
your family and clients will love.

Give each face in your image the specific attention it needs. Perfect Portrait automatically recognizes
each person in your photo and allows you to retouch each separately.

More than just finding each face, Perfect Portrait also quickly finds the eyes and mouth in a portrait
automatically. You no longer have to waste time painting in the features or use complicated manual
"wizards" because the features are identified right away. So, you can quickly get to the task of
enhancing those critical features.

 

Perfect Portrait
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This getting started section will give you the basics of using Perfect Portrait. If you have never used
Perfect Portrait before, this is a good place to start. You might also try watching the getting started
video tutorial. For detailed information on steps and controls mentioned in the getting started
section, see the "Using Perfect Portrait" section instead.

 

Getting Started
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User Interface

Perfect Portrait Main Window:

A. Preset Browser: This is where you browse and apply presets

B. Tools Option Bar: This is where information and options about each tool is selected.
C. Tool Well: This is where the tools are located.
D. Preview Window: This is the main section where you preview and work on images.

E. Module Selector: This is where you choose which software module to open.

F. The Navigator, Loupe and Histogram Pane: This pane will access Navigational, Loupe and Histogram features.
G. Skin Retouching Pane: This is where you adjust the skin smoothing and retouching controls.

H. Color Correction Pane: This is where you adjust the color correction controls.

I.  Mouth & Eyes Pane: This is where you adjust the mouth and eye enhancement controls.

J.  Cancel & Apply Buttons: This is where you cancel or apply an action.

K.  Mouth & Eye Control Points: Click and drag these control points to refine the mouth & eye areas.

The Perfect Portrait Tool Well

There are 5 different tools in the Perfect Portrait tool well. More details about each tool will be covered in the next chapters.

 Face Select Tool  This tool lets you select the face to edit.

 Face Edit Tool  This tool lets you edit the areas of the face like the skin, eyes and mouth.

 Retouch Brush  This tool lets you retouch areas like blemishes, wrinkles and discoloration.

 Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  This tool changes the magnification in the preview up to 1600%.
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Navigating the Preview
Perfect Portrait provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 The Info panel is not visible when you access Perfect Portrait as a Photoshop plug-in.
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Browsing Presets
Built into Perfect Portrait is a preset browser, located in the left panel. You can use it to browse the factory supplied presets, presets you have created or
downloaded from the onOne website or for marking and finding your favorites. Below is a description of the controls in the file browser.

A. Browser Tabs: This switches between the Effects tab, Favorites tab and My Presets tab.
B. Search Field: Use the search field to locate effects and presets. Simply start to type and your
results will appear in a new sub-folder called search results while you type.
C. Categories: Categories work just like folders. Select one to open it and view its contents
D. Effect: An effect is displayed as a thumbnail of the image with the effect applied and will have the
effect name listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size
of the browser or close it.
F. Favorite Flag: Click on the flag to mark an effect or preset as a favorite. It will appear in the
Favorites tab automatically.
G. Browser Modes: These icons control the browser mode. Either thumbnail columns or list view.
H. Quick View Browser: Pressing this button opens the Quick View Browser where you can see
larger versions of each preset.

Browser Tabs

The Browser is divided into three tabs; Library, Favorites and My Presets.

Library: The Library tab contains the factory presets provided by onOne Software. They are a good place to start.
Favorites: When you click on the favorite flag on a preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to find the
presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne website, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

You cannot move or delete presets from the browser.

Selecting a Preset to Use

To activate a preset on your image, simply click on the preset.
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Searching for Presets

To search for presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on a preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four viewing modes. Three
that display thumbnails in columns and one list
view. The browser modes are selected using the
browser mode icons at the bottom of the
browser.

   single column view    two column view    list view

Quick View Browser
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The Quick View Browser adds an
elegant full-screen view of your
images, effects and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.

Browse folders and
images quickly to find
the right one to work on.
View all your effect or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate.
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.
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The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

Top-Bottom Screen. Top-Bottom Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

Preview Window Modes

96  Perfect Portrait

Perfect Photo Suite



Below are the steps to start selecting and editing faces.

Step 1

When you launch Perfect Portrait, it scans for faces in the image. The selected faces
are marked with a white rectangle box. Select a face to edit and a green highlight box
will surround it.

Each face box will have an "X" icon in the upper left corner. This icon can be pressed
to delete that face selection. 

If Perfect Portrait does not find a face automatically you can manually select one by
using the Face Select Tool and clicking on the face to add. 

See "Adding Faces" in the Face Select Tool section for details.

Step 2

When you select a face by clicking on it, the preview will zoom in to the face and the
eye & mouth control points will be visible. 

You can adjust the selection by moving the control points. If you need to adjust the
overall location of an eye, click on the cyan dot in the center of the eye. Use the
control points to fine tune the selection around the eyes and mouth. You may press
the Hide Controls button located in the Tool Options Bar which will hide the control
points.

Step 3

Now, you can refine the skin selection as well as adjust the color, eyes and mouth
using the controls in the panes located to the right. These include:

Skin Retouching
Color Correction
Eye & Mouth Enhancing

Step 4

A user may also select the Retouch Brush to manually reduce stubborn spots
anywhere in the image.

Using Perfect Portrait
The heart of Perfect Portrait is the automatic finding of faces and creation of accurate and feathered skin selections.

Perfect Portrait is designed to simplify retouching and empower portrait photographers of all levels to create stunning portraits. It contains what we feel are the
most important tools for color correcting, retouching, smoothing, and enhancing portrait images.
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The Face Select Tool is used to select which face to edit. When the Face Tool is
selected, boxes appear on each face in the image. The current face box is marked
in green, other face brackets are marked in white.  You click on the face you wish to
work on, the tool automatically switches to the Face Edit Tool. The eye & mouth
control points become visible.

Adding Faces

Occasionally Perfect Portrait may not find the face you wish to retouch in a scene. 

This can occur if:

The face is small compared to the rest of the image.
The subjects eyes are closed or has glasses on.
The subject is in a profile pose.
The subject is upside-down.
The lighting contrast is heavy.

If Perfect Portrait does not find a face automatically you can manually select it by
clicking the Face Select Tool on the face you would like to add. 

A Square box appears on screen. Move it over the face you wish to add. Adjust the
size of the box with the side handles. The box should go from the hairline to the
chin and be centered on the face. When you have the box adjusted, press the
Apply button and Perfect Portrait will add the new face. 

Deleting Faces

If Perfect Portrait detects a face you do not wish to retouch, simply click on the X in
the upper left corner of the face box.

Using The Face Select Tool

Face Select Tool: Click with the Face Select Tool to select or add a new face selection.
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The Face Edit Tool is a dual-mode tool. It is used to refine the mask for the skin selection as
well as adjust the eye & mouth control points. When the Face Edit Tool is not over a control
point it is similar to the Masking Brush in other onOne Software tools. It is used to refine
the skin selection. It has two states, "Add to Skin" and "Not Skin" which equate to paint-in
and paint-out in mask mode. The tool is represented as concentric circles that are white.

When this tool is over an eye & mouth control point it switches to a normal cursor. A user
clicks and drags a control point to adjust its location. There are five control points for each
eye and six for the mouth. They are used to define these areas for enhancement:

The iris of each eye
The sclera, or white area of each eye
The lips
The area inside lips, generally the teeth

The number of control points is kept minimal to make Perfect Portrait easier to use. The
lines don't need to match the contours of the eyes & mouth perfectly. The selections are
feathered on the edges and are limited to the expected color and tonal ranges of the area
to be adjusted.

The Face Edit Tool Options Bar

Using The Face Edit Tool

Face Edit Tool: Refines the Skin Selection and Moves the Control Points.
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Mode: This mode selects either Not Skin, or Add to Skin. Use the Add to Skin mode to
brush more mask areas on the skin or Not Skin to subtract mask areas around the skin.

Size: This controls the brush size, also contains a toggle "W" to turn off or
on the Wacom pressure sensitivity.

Feather: This controls the brush feather, or hardness.

Opacity: This controls the opacity, also contains a toggle "W" to turn off or
on the Wacom pressure sensitivity.

Perfect Brush: This enables the Perfect Brush function, a self masking mode
based on color that protects edges.

Tip: You can turn the Perfect Brush on and off using the command or
control -r keyboard shortcut. You can also temporarily lock the color
the remove by holding down the control key. This is useful when
brushing through areas with lots of openings like hair. 

Previous/Next Face: These right-left arrow buttons select which face is
selected next.

Hide Controls: This button toggles the showing of the control points.
Normally, the control points are visible. This is good when you are fine-
tuning control point position. However, it obscures the image and makes it
difficult to know how to adjust the Skin Retouching, Color Correction and
Eye & Mouth options. When you press this button, it hides the control points.
This allows the you to see the results of the current settings and to better
adjust the controls. 

Reset Face: This button resets the mask, control points and right group
settings to their defaults for the face.
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When you select the Retouch Brush, the tool will appear as a circular brush in the after preview window. The brush will appear as
two concentric circles. 

The outer circle represents the outer edge, or soft edge of the brush.
The inner circle represents the hard edge of the brush.

The relationship between the hard edge and soft edge is controlled with the brush size and brush feather controls.

Adjust the brush size to the same size as the blemish you wish to remove, then dab the brush on the spot. It is best to use the
smallest brush size needed to remove a blemish. If you don't like the results of a brush stroke, use the undo command and try again
brushing in a different direction or with a smaller brush in steps. 

The Retouch Brush removes blemishes such as acne, spots and stray hairs. It functions like the spot healing brush in Photoshop. It uses the color and detail
information from the areas directly outside the brush to fill in the brush area. It is important that the area to be filled maintains the texture and tonal
gradation of the nearby skin so that the patched area blends in.

Retouch Brush Tool Options Bar

Size: The brush size slider controls the size of the brush. Use the smallest brush needed.

"W" Wacom Controls: If you have a Wacom pressure sensitive tablet you can adjust the size of the brush with the pressure of the tablet. To activate
the Wacom control, click on the box with the "W" on it.

Feather: The brush feather slider controls the feather, or hardness of the brush. Make sure you have a feather of at least 25 to blend in retouched
areas evenly.

Opacity: Sets the opacity, or strength of the Retouch Brush. The default is 100%, which will completely remove a blemish. If you would like to reduce
rather than remove a blemish, try a lower opacity like 50%. It is great for under eye bags and crows feet.

Tip: Keep the brush size about the same size as the blemish you want to remove. Make small dabs rather than brushing large areas for the
best results.

Using The Retouch Brush

Retouch Brush: Use the Retouch Brush for small imperfections on the image.
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The Skin Retouching Pane contains the controls for adjusting the automatic blemish reduction, skin smoothing, shine and shadow reduction as well as
texture addition.

   

Face Size: The Face Size drop-down menu is used to adjust the overall size of the face skin
mask. To adjust it, click and hold on the drop-down. The current automatic face skin mask is
shown. If important skin areas at the edges of the face are not included select a larger size. It
may take a second or two to render the updated mask. Keep the drop-down held down so you
can see the results of your selection. Keep in mind you can always refine the skin mask using
the Face Edit Tool as well

Blemishes: Adjust the Blemishes slider first. It attacks the medium sized blemishes such as
large pores, acne, freckles, fine lines, etc. It reduces the appearance of blemishes while
maintaining the fine pore structure of the skin for a natural appearance. Typical settings for
females and children are 60-80, 30-50 for males.

Smoothing: Smoothing is the second slider to adjust. It acts on the smallest details to add a
smooth finish to the skin, similar to powder in the cosmetics world. Use the smallest amount
you can to preserve a natural look. Typical settings for females are 20-40, males and children
10-20.

Shine: The shine slider is used to reduce the brightness of highlights on the skin. It is great for
reducing shine from oils in the skin.

Shadows: The shadow slider is used to brighten shadows in the skin. This is useful for dark
eye bags and deep wrinkles.

Texture: The texture slider introduces a synthetic skin texture to the skin areas. Generally it
is not needed. It is useful on overexposed images where no texture remains. 

Evenness: Evenness adjusts how consistent the skin color is across the entire face. It is
great for correction highlights that may be too yellow, shadows that may be too green or
reducing redness in noses and ears. It is also useful for making family portraits more consistent
from person to person.

Face Only: The face only toggle limits the skin retouching to just the skin of the face. This is
on by default and is recommended for most uses. This will prevent other flesh colored areas in
your scene from being retouched. This includes things like hair or other people. 

There are two occasions when you would want to disable the face only toggle:

If you are working on a single subject with little or no clothing and you wish to apply
the skin retouching to all the subjects skin.
Your're working on a large group portrait where it is impractical to adjust each face
separately. You can instead disable the face only option and apply the same
retouching to everyone in the scene.

 

 

Skin Retouching

Reduce Blemishes, Smooth the Skin and Even the Skin Hue.
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When a face is selected, Perfect Portrait automatically color corrects the entire image based on the
skin color of your subject. When Perfect Portrait finds the first face in the scene, it analysis the
average skin color of that face and compares it to libraries of hundreds of thousands of color
correct skin color samples. 

If the first face is deleted, the next face takes over and the color correction base value is reset. 

Color correction only needs to be performed on one person in a scene. If you have multiple people,
they all have the same color cast issues. Using the Color Correction controls on one person will
correct the others as well.

The Color Correction pane contains the following controls:

Amount: Adjusts the overall strength of the correction. 

Warmth: Warmth is set automatically based on the image but can be adjusted up or down based
on personal preference. Underexposed images may have too much warmth, where open sky, or
overexposed images may not be warm enough.

Color Shift: Color correction does its best too automatically correct color but may need help
based on personal preferences. Use the Color Shift slider to adjust the color or hue to control how
red the skin is.

Ethnicity: The ethnicity pop-up determines which color library to use for the color correction.
Every ethnicity has a different hue characteristic no matter how bright or saturated the skin is.
For the best results, use the ethnicity library for the face that is selected. If you are not sure, use
the Average option which is an average of all ethnicities.

 

 

Color Correction

The Color Correction pane is used to color correct the image based on skin color.
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The eyes and mouth are the key features of the face. Beyond skin retouching, they
are the most important and common areas to retouch or enhance. Brightening the
eyes and teeth are very common but can be difficult to do in Photoshop in a realistic
way.

Perfect Portrait automatically detects the mouth and eye regions to provide
enhancement. You can adjust the automatic selections using the Face Edit Tool.

The eye and mouth selections are broken down into four regions:

Whites of the eyes (sclera)
Iris of the eyes
Lips
Teeth (area inside the lips)

The number of control points is kept minimal to make Perfect Portrait easier to use.
The lines don't need to match the contours of the eyes & mouth perfectly. The
selections are feathered on the edges and are limited to the expected color and tonal
ranges of the area to be adjusted.

Below is a list of the controls and when to use them.

Eyes-

Whitening: The Eye Whitening slider is used to lighten and whiten the sclera or the
whites of the eyes. 

Detail: The Eye Clarity slider increases the clarity or sharpness of the eye area.

Reduce Red Eye: When this is checked it will automatically reduce red eye.

Mouth-

Whitening: The Mouth Whitening slider whitens and lightens the teeth. If the
subject's teeth are not showing, don't use this control.

Vibrance: The Mouth Vibrance slider increase the vibrancy or color saturation of the
red hues in the mouth region. It is useful for enhancing lip color, typically for women
with lipstick.

Eyes & Mouth
The Mouth and Eyes pane contains the controls for enhancing the eyes and mouth.
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When Perfect Portrait finds a face it automatically generates a
selection, or mask, for the skin of the face. Generally the automatic
mask is very good but occasionally you may need to adjust it to add
areas of skin that where not included or to remove areas such as hair
that are included by mistake. This skin selection can viewed and
adjusted with the Face Edit Tool. 

 
 

  

Adjusting the Face Size

for can be viewed and adjusted in the Skin Retouching Pane under
the Face Size selection. You can adjust the mask by using the Face
Edit Tool. This tool work the same as the Masking Brush in other
onOne products.

 

 

Editing the Skin Mask

You can also edit the skin mask directly using the Face Edit Tool. Visit
the Refining the Masking Selections page for details.

  

 

Adjusting the Skin Selection
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You can view the mask in the Masking menu on the bottom left corner of
each preview pane.

 You can also view the mask and adjust the size in the Skin Retouching Pane
under the Face Size selection.

Below are examples of the different mask view modes. 

You can toggle mask view on and off with the command (Mac OSX) or control (Windows) plus m keyboard shortcut.

   

Red
The masked area appears as 50% red. This is similar to the Quick Mask
view in Photoshop.

 

White
The masked area appears as solid white.

 

 

Viewing the Selection Masks

Perfect Portrait allows you to view and edit the skin mask.
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Dark
The masked area appears as 90% black.

 Grayscale
The masked area black, while the unmasked area is white.
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First, select the Face Edit tool. This dual-mode tool functions as a masking brush
with concentric circles when not over a control point. You control the
brush Size and Feather settings in the Tool Options Bar.

Enable either the Mask-Red or Mask-Dark setting in the Mask View drop-down located bottom-left of
the Preview Window. This will allow you to view the mask that Perfect Portrait uses to define the skin
areas to edit.

These view modes make it easy to see the mask and the image simultaneously.

The preview sample at the right was selected to Mask-Dark.

Now use the Face Edit tool to paint-in areas of the skin that might have not been included in the
automatic selection. 

You can also set the mode to "Not Skin" to undo areas of the mask you painted in.

Refining the Masking Selections

In many cases adjusting the Skin selection mask is not needed. The automatic selections created by Perfect Portrait work well on many images. To see if you
need to refine the selection masks, follow the steps below.
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Focus on the hair around the face. Don't worry too much about the areas around the eyes and
mouth, these areas are adjusted in the Eye and Mouth window pane. 

Make sure that the eyebrows are not selected unless you want to soften them.

Perfect Brush

The Perfect Brush option enableds a unique, color-based, self masking technology. When
enabled, as you paint with the Masking Brush it collects the colors under the center of the brush
and only masks those colors. This protects the mask from being applied across edges.

Tip: You can turn the Perfect Brush on and off using the command or control -r
keyboard shortcut. You can also temporarily lock the color to remove by holding down
the control key(win) or the command key(mac). This is useful when brushing through
an area with a lot of openings.
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Presets
Presets store all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent results. You can save
your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser .

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

 Deleting a Preset

You can remove a preset from Perfect Portrait if you no longer want to
have access to it. To remove a preset, follow these steps:

1. Open Perfect Portrait
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect Portrait the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Portrait.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Portrait, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONPortrait extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Setting the Defaults

The Module Settings are located in the Edit menu allow you to control the default
settings that Perfect Portrait uses. Below are the options:

Skin Only: Adds a modest amount of skin retouching only.

Natural: Adds a modest amount of skin retouching and facial feature enhancement.
No color correction is added. This is the default setting.

Strong: Adds a heavy retouch with color correction and feature enhancement. This
is the default from Perfect Portrait version 1.

My Settings: A set of drop-down menus where the user may select a category and
preset saved in the My Presets tab. This way you can set your own defaults exactly
they way you want. 
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Perfect Portrait

About: Opens the about box. This dialog contains your serial number, version
number and information on contacting onOne Software for support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

File

Apply: Applies the current settings and returns to the host application.

Cancel: Cancels and returns back to the host application with no changes.

Edit

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Undo Stroke: If the last action was a brush stroke, this reverses the entire
brush stroke.

Redo Stroke: If your last action was an undo of a Brush Stroke, this reapplies
the entire stroke.

Cut: Unused

Copy: Unused.

Paste: Unused

Reset All: Resets all the floating palette controls back to their default settings.

Face

Add Face: Opens the Add Face routine.

Delete Face: Deletes the selected face.

Reset Face: Resets the selected face controls and masks to default.

Next Face: Cycles to the next face. This is disabled if only one face.

Previous Face: Cycles to the previous face. This is disabled if only one face.

Show All Faces: Displays all selected faces. Sets the preview zoom to fit and
changes tools to the Face Select Tool.

Copy Settings: Copies the settings from the current face to the clipboard.

Paste Settings: Pastes the settings from the clipboard onto the current
image.

Menus
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Preset

Save Preset: Saves the current Effect Stack as a new preset.

Delete Preset: Deletes the current preset.

Edit Preset: Opens the preset dialog so you can edit the name, author or
description information.

Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.

Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.

View

Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.

Zoom Out: Zooms the preview window out one increment. This will make the
preview image smaller.

Fit to Screen: Fits the zoom to the screen so the entire image is viewable.

Fill with Face: Sets the zoom so the current face fills the entire screen. 
Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.

Show Browser Pop-up: Enables the browser pop-up window.

Browser Mode: Allows the user to select how the Browser Library displays the
categories.

Show Clipping: Shows the clipping overlay view, which over-rides the current
mask view.

Show Preview: Toggle to enable or disable the preview.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.

Show Mask: Shows or hides the mask view.

Mask View Mode: Select which mask view mode to view.

Show Tool Guidance: Shows the tool guidance inspectors.

Window

Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.

Skin Retouching: Opens/closes the Skin Retouching pane.

Color Correction: Opens/closes the Color Correction pane.

Eyes & Mouth: Opens/closes the Color Correction pane.

Show Browser Panel: Hides or shows the Browser Panel.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the open
image.
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Help

Search: Mac OSX only. Searches the menus options.

Perfect Portrait Online Help: Opens this html Help in your default web
browser.

Video Tutorials: Opens the online Video Tutorial in your default web browser.

Getting Started: Opens the online Getting Started overlay.

Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for  Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.

Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts

Perfect Portrait has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action  Mac  Win

 Apply  cmd s  ctl s

 Cancel  esc, cmd w, cmd .  esc, ctl w

 Save Preset  cmd shift s  ctl shift s

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Undo Stroke  cmd-opt-z  ctl-alt-z

 Redo  cmd shift z  ctl shift z

 Redo Stroke  cmd-shift-opt-z  ctl-shift-alt-z

 Reset All  cmd opt z  ctl alt z

 Open/Close Navigator  cmd 1  ctl 1

 Open/Close Skin Retouching  cmd 2  ctl 2

 Open/Close Color Correction  cmd 3  ctl 3

 Open/Close Mouth & Eyes  cmd 4  ctl 4

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Retouch Brush  b  b

 Select Face Select Tool  s  s

 Select Face Edit Tool  e  e

 Zoom-In  cmd + or cmd =  ctl + pr ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fill with Face  cmd shift 0  ctl shift 0

 Brush Size
 larger ]
smaller [

larger ]
smaller [

 Brush Feather
softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc
opt ] more opaque
opt [ less opaque

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc 
alt ] more opaque
alt [ less opaque

 Enable or Disable Perfect Brush  cmd r  ctl r

 Toggle Brush Mode
 x
opt

 x
alt

 Show Mask  ctl m  ctl m

 Preview On/Off  cmd p  ctl p

 Preview Modes
  - Single Image
  - Left/Right
  - Left/Right Split
  - Top/Bottom
  - Top/Bottom Split

 
cmd Y
cmd L
cmd opt L
cmd T
cmd opt T

 
ctl Y
ctl L
ctl opt L
ctl T
ctl opt T 

 Hide Browser Panel  cmd left arrow  ctl left arrow

 Hide Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

 Show Quick View Browser  cmd up  ctl up
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Perfect Effects gives photographers a fast and powerful way to create images with
impact.

It includes an updated library of professional quality photographic effects that can be previewed live
on your image before being applied. Live previews are shown in full screen so you can see your image
at its best. You'll enjoy the ability to stack multiple effects together to create your own unique look.

Perfect Effects takes the idea of stacking effects further with updated blending options that provide
better control over how effects are combined. These advanced tools include blending modes options
and the ability to limit effects to specific color or tonal ranges of an image.

 

 

Perfect Effects
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Getting Started

This getting started section will give you the basics of using Perfect Effects. If you have never used Perfect Effects before this is a good place to start. You can
also watch the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the Using Perfect
Effects section instead.

When to use Perfect Effects

The broad range of effects in Perfect Effects makes it useful at many steps in the digital workflow. For example, the effects in the Brightness, Contrast and
Color Correction categories may be used early in the workflow for correcting the color and tone of an image. While effects in many categories are designed for
more artistic effect, may be used in the middle of the process. Finally, Perfect Effects has several effects designed for sharpening in the Sharpening category
that should be applied as the last step before printing.
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User Interface

Perfect Effects Main Window:

A. Effects Browser: This library of effects is located on the left side of the window for easy browsing.

B. Tool Well: This is where the tools are located.

C. Preview Window: This is the main section where you preview and work on images.

D. Tools Option Bar: This is where information and options about each tool is set.

E. Module Selector: This is where you choose which software module to open.
F. Navigator, Loupe and Histogram Pane: This pane will access the Navigational, Loupe and Histogram features.

G. Effects Stack: This is where you view and stack effects.

H. Effects Options: This is where you access the Effects Options pane.

I. Cancel/Apply Buttons: This is where you cancel or apply an action.

The Perfect Effects Tool Well

There are four different tools in the Perfect Effects tool well. More details about each tool will be covered in the next chapters.

 Masking Brush  This masks out areas using brush strokes to expose underlying layers.

 Masking Bug  This tool lets you mask out the layer to expose the original underlying image.

 Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  This tool changes the magnification in the preview window.
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Navigating the Preview
Perfect Effects

This provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 The Info panel is not visible when you access Perfect Effects as a Photoshop plug-in.
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The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

  

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

 

Top-Bottom Screen. Top-Bottom Split Screen.  

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

 

Preview Window Modes
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Using Perfect Effects

Perfect Effects is designed to work in steps by adding and adjusting multiple effects on top of each other. If you are a photographer, think of this like adding
filters over your cameras lens. First, you would add a polarizer to increase the contrast. Next you would add a graduated neutral density filter to darken the sky
and perhaps add a vignette lens hood to darken the edges. This same concept is what drives Perfect Effects, except you have many more filters and more
flexibility and control. 

Perfect Effects provides several ways to work depending on your skill level. It works for beginners through advanced users. Below are example workflows for
different levels.

Beginner

A new user can simply click on an effect and apply it. This is the easiest way to get started.

1. Start by opening an image into Perfect Effects.
2. On the left side you will see the Browser with a list of categories. Click on a category to open up a series of effects. You will now see your image with

different effects applied. 
3. Simply click on the effect you like and press the Apply button.

Intermediate

An intermediate user may try stacking effects and adjusting their strength.

1. Start by opening an image into Perfect Effects.
2. Add an effect from the Browser, adjust its strength with the strength slider at the bottom of the Effect Stack pane on the right.
3. Add another effect layer by pressing the Add button in the Effect Stack pane, then select a new effect from the library.
4. Continue to add effect layers and adjusting each effects strength.
5. When you have created an effect stack you like, press the Apply button.

Advanced

An advanced user may stack multiple effects, adjust the strength, blending options, effect options and use the masking tools to selectively apply effects.

1. Start by opening an image into Perfect Effects.
2. Add an effect from the Browser.
3. Adjust the effect options in the Effect Options pane. This pane contains controls relevant to the selected effect.
4. Use the blending options dialog to control the strength and blending mode. You can also control which color or tonal ranges are affected.
5. Continue adding effect layers, adjusting the effect options and blending options to achieve the desired look.
6. Use the masking tools to selectively apply each effect layer by painting them in or out or applying an effect as a gradient or vignette.
7. When you have created an effect stack you like, press the Apply button. You can also save a stack as a preset so it can be used again later.
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Browsing Effects
Built into Perfect Effects is a browser, located in the left panel. You can use it to browse the factory supplied effects, presets you have created or downloaded
from the onOne website or for marking and finding your favorites. Below is a description of the controls in the browser.

A. Browser Tabs: This switches between the Browser tab and the Extras tab. The Extras tab displays
the included backgrounds, borders and textures.
B. Folder Tree: This drop-down menu displays the folder paths above the folder you are browsing. You
can use this to quickly navigate up the folder tree. The currently selected root folder is displayed here as
well.
C. Search Field: Use the search field to locate files in the current sub-folder. Simply start to type and
your results will appear in a new sub-folder called search results while you type.
D. Image File: A file is displayed as a thumbnail of the image and will have the filename and extension
listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of the
browser or close it.
F. File Info: This window will show captured and modified dates, color space, exposure settings and size
on disk if applicable.
G. Browser Modes: These icons control the browser views. One column, two column, three column or
list view.
H. Quick View Browser Button: Press this button to open the current folder in the Quick View
Browser.

Browser Tabs

The Browser is divided into three tabs; Effects, Favorites and My Presets.

Effects: The Effects tab contains the factory effects provided by onOne Software. 
Favorites: When you click on the favorite flag on an Effect or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to
find the effects and presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne website, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, effect or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

You cannot move or delete presets from the browser.

Selecting an Effect or Preset to Use

To activate an effect or preset on your image, simply click on it.
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Searching

To search for effects or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on an effect or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four
viewing modes. Three that
display thumbnails in
columns and one list view.
The browser modes are
selected using the browser
mode icons at the bottom
of the browser.

   single column view    two column view    list view

Quick View Browser
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The Quick View Browser adds an
elegant full-screen view of your
images, effects and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.

Browse folders and
images quickly to find
the right one to work on.
View all your effect or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.

 

126  Perfect Effects

Perfect Photo Suite



When you add an effect to your image, it will appear on the current Effect
Layer in the Effects Stack pane. The Stack works similar to the Layers or
History palettes in Photoshop, or the Stack in PhotoTools. At the bottom of
the Effects Stack is your original image. Each effect you select in the
Library will replace the effect on the currently selected Effect Layer. 

You can create as many Effect Layers as needed.

 

   

You move forward and backward in time by selecting different Effect Layers in the Stack. 

For example, if you had an Effects Stack with the original and three Effects Layers applied, you could go back to the first Effect by selecting it in the
Effects Stack. The second and third Effects Layers will appear disabled and your preview will show only the results of the original with the first Effect Layer
applied. You can then click on the third Effect Layer, the most recently applied, and the second and third effects will appear active again and the preview
will show the results of all three effects. The results of each Effect Layer in Perfect Effects are cumulative, so the results of the first effect are passed to
the second effect and so forth. 

It is best to work with Perfect Effects in a step-by-step process, knowing that the results from each step are the starting point for the next effect. This
means that when selecting the effects to apply, think about the workflow order you use.

It is best to make color and tonal adjustments first, followed by special effects and finish with final touches such as vignettes and sharpening. Thinking of
the proper steps to add effects in Perfect Effects will give you better and faster results.

 

 

Using the Effects Stack

The Effects Stack is a list of all effects and presets added to an image.
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Changing the Current Effect

When you start in Perfect Effects, there will be an empty Effect Layer on
top of your original. Your original is at the bottom of the Effect Stack. To
add an effect to the empty Effect Layer, select it first, then click on an
effect thumbnail in the Effects Browser. You can change the effect in an
Effect Layer by clicking a different effect thumbnail in the Effect Library.

Adding Effects

To add another Effect Layer so you can stack multiple effects, click the
Add button at the bottom of the Effects Stack. This creates a new empty
Effect Layer. Then select another effect from the Effect Browser. 

You can also double-click on an effect in the Effect Browser to place it in
the current Effect Layer and add a new empty Effect Layer above it. 

Hiding Effects

An effect may be temporarily hidden or revealed by pressing the Eye icon
next to the effect in the Stack. When you hide an effect, you are not
removing it from the Stack. You can reveal it again anytime. Keep in mind
that hiding an effect in the middle of the Stack may take a moment to re-
render and update your preview.

Changing Effect Order

Effects may be reordered in the Stack by clicking and dragging them into
the desired position. Reordering effects can have a huge difference on the
results of the image. Reordering effects will cause the Stack to re-render
which may take a few moments.

Deleting an Effect

You remove an effect by selecting it and pressing the Delete button at the
bottom of the Effects Stack or by pressing the delete key on your
keyboard.

Tip: You can clear all the effects from the Frame Stack at once
by option (alt on Windows) clicking on the delete button.

Adjusting the Amount

The Amount slider controls how the selected effect blends with the previous effect or the original image. You adjust the amount for any effect by selecting
it and then adjusting the Amount slider. Adjusting the Amount slider effectively adjusts the strength, or opacity of an effect. For example, if you add a
black and white conversion effect, sliding the amount down will reveal some of the color from the previous state. Usually, the Amount slider will be set to
100% when you add an effect, however with some effects like vignettes and soft focus effects, it may be set at 50%.

Adjusting the Amount slider to greater than 50% will make the effect stronger, while adjusting it to less than 50% will make the effect weaker. 

Expanding a Preset

If your current Effect Layer contains a user-created preset you can expand it, revealing all the steps (Effect Layers) in the preset. This allows you to
adjust the strength, blending options or Effect Options for each Effect Layer. A preset will be labeled in italics and the expand button will be enabled.
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Blending Options

Selecting the Options button will bring up the Blending Options
window. This window offers advanced blending options between effects. 

The blending options controls are:
Blending Mode: A pop-up list of blending modes. The list includes normal, lighten, darken, screen, multiply, softlight, hardlight, overlay and color.

Amount: The Amount control is reproduced here for convenience. Amount is measured in percentage with a range from zero to 100.

Apply Effect To: A pop-up list of color or tonal ranges will appear, only one may be selected. The options are; all, highlights, midtones, shadows,
reds, greens, blues, magentas, cyans, yellows, flesh colors, vivid colors and neutrals. This applied effect creates a selection based on the lightness, hue,
or saturation range specified. There is a Fuzziness slider associated with this control that adjusts the hardness or precision of the selection. The range is
zero to 100.

Protect: The protect sliders are used to remove an effect from a specific color or tonal range. The sliders are; highlights, shadows and flesh colors. The
selection created should be feathered and appear natural. The default for these sliders is zero; the range is zero to 64. The range for Flesh Colors is zero
to 100.

Flesh Ethnicity: These select the range of colors used for the flesh color options above. The ethnicity ranges include; Caucasian, African, Latin,
Asian, Middle Eastern and All.

Reset: This resets all settings to the original default settings.
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Perfect Effects has its own image-processing engine. This allows you to control the settings for
many effects down to the smallest detail. 

There are eleven base filters that do all the work in Perfect Effects. Stacking and blending these
filters will create different effects. These filters are accessed in the Effect Options pane. 

The filters are:

Black and White
Blur
Borders
Color Enhancer
Duotone
Glow
Photo Filter
Sharpening
Texturizer
Tone Enhancer
Vignette

  

Many effects in the Effect Browser are basic effects for a single filter. When you select the effect in the Browser, the Effect Options pane will switch to
the correct filter and will show the settings used. You can then adjust the settings as needed. 

Some of the effects in the Library are complex factory effects that use multiple filters simultaneously. When you select one of these, the Effect Options
will display Custom. Factory created presets can be masked. They can also have their amount, and blending options adjusted.

User created presets will also appear as a preset in the Effect Options pane. You can expand a user preset into the Effect Layers that created it by
pressing the Expand button at the bottom of the stack. You can then adjust the effect options for each Effect Layer.

Filter Controls

   

Black and White

The black and white effect is used to turn a color image into a monochromatic image. 

Contrast: Increases or decreases the global contrast
Color Filter: Simulates placing a colored filter over your lens when photographing with
black and white film. It works like a channel mixer, choosing the percentage of each
channel to use.
Toner: A drop-down list of darkroom toners which add a subtle color tint to the image.
Toner Strength: Adjusts how strong the toner is.
Add Grain: A drop-down list of Film Grains from popular black and white films.
Grain Strength: Adjusts the strength, or amount of film grain.

 

  

Blur

The blur filter contains three options for blurring the image. These options are Gaussian, Radial
and Surface.

Type: Select the type of blur
Halo: Adjust the halo, or blur radius.
Strength: Adjusts the blur strength or opacity.

 

   

 

Using Effect Options
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Borders

Adds authentic looking borders.

Category: Sets the category of border.
Border: Select which border to add.
Mode: Sets the blending mode for the border.
Strength: Sets the strength or opacity.
Scale: Changes the size of the border.
Rotate & Flip: Rotates or flips the border.

 

   

Color Enhancer

The color enhancer can be used to control the saturation or vibrancy of colors in the image. This
can be done on a global basis (All) or per a range of colors.

Temperature: Adjusts the warmth of the image.
Tint: Shifts the hue between green and magenta
Color Range: Select which color range to adjust.
Hue: Adjusts the hue of the selected color range.
Saturation: Adjusts the saturation of the selected color range.
Lightness: Adjusts the lightness of the selected color range.
Auto Cast Removal: When enabled, any color cast in the image is detected and removed.

 

   

Duotone

The duotone filter is a gradient map that tints the dark and light portions of the image in different
hues. This is used to age an image and give it an antique or vintage look.

Preset: A drop-down menu with a selection of duotone presets.
Highlights: Sets the highlight duotone color.
Shadows: Sets the shadow duotone color.
Strength: Sets the strength, or opacity of the effect.
Midpoint Sets the transition between the highlight and shadow color.
Mode: Sets the blending mode of the duotone layer.

 

   

Glow

The glow filter contains three options for adding a glow the image. These options are Gaussian,
Radial and Surface.

Type: Select the type of blur
Halo: Adjust the halo, or blur radius.
Strength: Adjusts the blur strength or opacity.
Mode: Sets the blending mode of the glow layer.
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Photo Filter

This filter recreates solid color filters like warming and cooling. It also creates gradient filters like
neutral density and bicolor filters. Bicolor filters are different colors on each side of a divide. 

Below are examples of these types of filters.

  

  

Here are the filter's options:

Preset: A drop-down menu with filter presets.
Filter Type: Sets the filter type; Solid, graduated or bi-color.
Colors: Color wells for setting the filter color.
Strength: Sets the strength, or opacity of the filter.
Base Saturation: Adjusts the saturation of the underlying image.
Position: There are controls for adjusting the position, rotation and transition (hardness).
Mode: Sets the blending mode.

 

   

Sharpening

The sharpening effect adds a touch of sharpness to compensate for a moving subject, out of
focus camera, or for an illustrative effect.

Type: Sets the type of sharpening; Progressive, High Pass or Unsharp Mask
Halo: Sets the halo or radius.
Strength: Sets the amount of sharpening.
Protect: There are three sliders for adjusting the amount of protection for the Darks,
Lights and Skin colors.
Ethnicity: A drop-down menu to select the ethnicity of the skin to protect.
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Texturizer

This places textures over the image to add a stylized look. When loading a texture file, it will be
rotated automatically to match the orientation of the destination image layer. The user can
override the rotation with the rotate and flip tools.

Category: Sets the category of texture.
Border: Select which texture to add.
Mode: Sets the blending mode for the texture.
Strength: Sets the strength or opacity.
Scale: Changes the size of the texture.
Rotate & Flip: Rotates or flips the texture.

 

   

Tone Enhancer

The tone enhancer controls the brightness and contrast, or tone of the image.

Brightness: Adjusts the global brightness.
Contrast: Adjusts the global contrast.
Auto Contrast: When enabled, this sets the black and white clipping points automatically,
improving the contrast range.
Blacks: Sets the black clipping amount.
Shadows: Lightens the shadows to recover detail.
Highlights: Darkens the highlights to recover overexposed areas.
Local Contrast: Increases the detail in the image.
Clarity: Enhances large edges to add clarity.
Curves: The curves dialog is powerful, advanced tool to adjusting contrast and color.

 

   

Vignette

The vignette control allows the user to darken or lighten the edge of the image.

Brightness: Adjusts the brightness of the vignette, either dark or light.
Midpoint: Adjusts the size of the vignette.
Feather: Sets the feather, or hardness.
Roundness: Changes the shape from round to square.
Mode: Sets the blending mode.
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You can think of masking as painting with black paint on white
paper. 

A white mask reveals all the effect that the mask is attached
to. An all white mask is considered blank or empty and shows all
the selected effect. As you use the masking tools, you are
adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current effect, allowing the effect(s)
under it to show through. Think of it like cutting a hole in the
mask. If you make a mistake, you can switch your paint color to
white (Paint-In mode) and paint the effect back in like an
eraser. When you paint you have more than just white or
black, but any shade of gray in between depending on the
opacity of the brush. Shades of gray partially hide the layer,
blending the layers together. 

Each effect layer in Perfect Layers has a mask automatically
added to it. This allows you blend each effect differently.

There are several global masking options that can be accessed
from either the masking tools Tool Options Bars or the Masking
Menu. They affect the entire mask on the selected effect layer.

Reset Mask

Reseting a mask returns it to all white. The entire layer is
visible.

Invert Mask

Invert swaps the white for black and black for white. What was
hidden is now revealed and vice-versa. Inverting a mask can be
very useful. It allows you to paint a layer in, rather than out,
which is handy if you only want to work with a small area.

Copy and Paste Mask

Perfect Layers allows you to copy the mask from one effect
layer to another. This is handy if you have painted a complex
mask on one layer for an adjustment and you wish to use the
same mask on another layer for a different adjustment. To
copy or paste a mask, use the Copy Mask and Paste Mask
commands from the Masking menu.

 

 

Using the Masking Tools

Perfect Effect users can choose the Masking Brush or Masking Bug to selectively apply each effect to the image. This opens a whole new world of control for
Perfect Effects. Using the Masking tools is just like using a layer mask in Photoshop to hide or reveal the effect in specific, user-defined areas of the image. The
Masking tools even support pressure-sensitive Wacom tablets for the ultimate in control. 

 

Paint-In Effects

Some of the effects in Perfect Effects are designed to be painted-in. When you add them to your
image, you will not see the image change, but the Masking Brush will be selected automatically. Simply
paint where you would like the effect to be applied.

You can identify Paint-In effects by the paint-brush icon in the upper left corner of the thumbnail.
Most of the Paint-In effects are located in the Basic Brushes category.
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The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.

 
 A close-up of the Mask View Modes

 

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

                         

   

   

Mask-
Red
The
masked
area
appears as
50% red.
This is
similar to
the Quick
Mask view
in
Photoshop.

 

Mask-
White
The
masked
area
appears as
solid white.

Mask-
Dark
The
masked
area
appears as
90% black.

 

Mask-
Grayscale
The
masked
area
appears as
black. The
unmasked
areas
appear as
white. This
is the same
as viewing
a layer
mask in
Photoshop.

 

Mask Modes

Mask Mode allows you to view your image mask in several ways.

 

Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several
modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are examples of the
different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard shortcut.
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The Masking Brush is one of two tools in Perfect Effects for masking effects. When
you select the Masking Brush, your tool icon changes to a circle that represents
the size of the brush. It may also appear as two concentric circles (see below),
indicating the inner hard edge and outer soft edge of the brush if the feather
control is set above zero. There is also either a plus or minus in the center of the
brush. Minus means the brush mode is set to paint-out, plus means it is set to
paint-in.

How to use the Masking Brush

To use the Masking Brush, select it in the tool well. Make sure you are on the effect you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying effect(s) appear.
If you make a mistake while brushing you have several options to correct them:

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.

How to control the Masking Brush

The Masking Brush Tool Options Bar

Paint Mode
The paint mode controls is you are Painting-Out (hiding the effect) or Painting-In (restoring the effect). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily. 

Invert Mask
Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask by pressing the Invert button in the
Tool Options Bar.

Reset Mask
Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.

Brush Size
You can control the size of the brush using the Size pop-up in the Tool Options
Bar. You use a small brush at high magnification for precise work, and a large
brush at fit to screen for general work. To the right, you can see examples of
brush strokes at varying sizes. You can control the size of the brush several
ways:

Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Using the Masking Brush

The Masking Brush: The Masking Brush functions like a brush tool for masking layers. 
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Feather
You control the amount of feathering or hardness of the brush by using the
Feather pop-up in the Tool Options Bar. The feather has a range from 1 to 100
percent. You use a small feather at high magnification for precise, hard-edged
work and a large, soft-edged brush at fit to screen for general work. You can
visually see your feather by watching the outer concentric circle of the brush tool.
To the right you can see examples of different feather options. You can control
the size of the brush several ways:

Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [  ] ).

 

Opacity
You can control the opacity, or strength of the brush with the Opacity pop-up in
the Tool Options Bar. Think of the opacity as the shade of gray you are painting
with. The opacity has a range from 1 to 100 percent. You use a high opacity to
paint quickly and hide large areas. You use a lower opacity for blending areas
together or for subtle work. To the right you can see examples of different
opacity options. You can control the size of the brush several ways:

Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

 

Wacom® Controls
Perfect Layers supports pressure sensitive Wacom tablets. When you use the
Masking Brush you can enable pressure sensitive controls for the brush size,
brush opacity, or both simultaneously. Click on the W button next to each control
in the Tool Options Bar to activate the pressure sensitive controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right
you can see examples of how pressure sensitivity can be used to control the
Masking Brush.
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Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from
being applied across edges. A great of example of using the Perfect Brush option
would be to mask a sky along a horizon of mountains.

Tip: You can turn the Perfect Brush on and off using the command or
control -r keyboard shortcut. You can also temporarily lock the color to
remove by holding down the control key(win) or the command key(mac).
This is useful when brushing through areas with a lot of openings like
tree branches. 
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Below is the Tool Options Bar that contains the controls for the Masking Bug.

Using the Masking Bug

Masking Bug: This is used for masking effects by creating gradient masks in either a round or rectangular shape.

The Masking Bug is perfect for tasks like darkening skies, creating vignettes and graduated filters. Learning to use the Masking Bug is fast and easy. All the
adjustments made with the Masking Bug are live and readjustable while using the Masking Bug... so don't be afraid to experiment with it. To use the Masking
Bug, select it in the tool well. Select the effect you wish to mask. Now click the center of the area you wish to mask out. A new rectangular Masking Bug appears
where you click. You can change the shape from rectangle to round by using the Shape pop-up menu in the Tool Options Bar. 

Adjusting the Masking Bug

Learning to use the Masking Bug is easy and fun. Start by adding a Masking Bug to a layer and then set the Mask View mode to Mask - Grayscale. This will
let you see the Masking Bug in simple black and white.

Start by moving the Masking Bug. Click and drag inside the center square or circle.
Now change the size and angle by clicking and dragging on the the legs. The legs are the shorter limbs with closed terminals. As you pull the legs
the bug gets larger. As you twist the legs the Masking Bug rotates.
Now adjust the feather by changing the angle of the right antenna. The antennas are the longer limbs with the open terminals.
The right antenna length changes the opacity of the current layer. You won't see any change when the grayscale mask preview in on.
The left antenna length controls the opacity of the Masking Bug.
Finally tilt the Masking Bug by holding down the option (Mac OSX) or alt (Windows) key and click and drag in the body. This will tilt the plan of the
bug in 3D. You can use this to change the feather or shape of the Masking Bug. To reset the angle, hold the option or alt key and double-click in
the body.
You can adjust the Masking Bug while the Masking Bug tool is selected. When you change layers or switch to another tool the mask created by the
Masking Bug is rendered. If you want to use the Masking Bug again on the same layer the old Masking Bug will be replaced and you simply start
again.

Masking Bug Tool Options
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Feather
You can control the amount of feathering or hardness of the edge of the
Masking Bug using the Feather Slider. The feather has a range from 1 to 100
percent. You use a small feather to create a hard edge, a soft feather for a
larger, softer transition. To the right you can see examples of different feather
options. 

You control the feather by:

Using the Feather Slider in the tool options bar.
Changing the angle of the right antenna.

 

 

 Hard Feather 0%  Soft Feather 50%

Opacity
You can control the opacity, or strength of the Masking Bug with the Opacity
Slider. The opacity has a range from 1 to 100 percent. You use a high opacity to
completely hide the area under the Masking Bug. You use a lower opacity for
blending areas together or for subtle work. To the right you can see examples
of different opacity options. 

You can control the opacity several ways:

Using the Opacity Slider in the tool options bar.
Changing the length of the left antenna.

 

 100% Opacity  50% Opacity

Shape
This controls the shape of the masking area. You can choose none, round or
rectangle.

Use the round Masking Bug to create vignettes or soft, round masks.
Use the rectangular Masking Bug to swap skies, add gradient filters,
etc.
Use the none option to remove an existing Masking Bug from a layer.

 

 Round Masking Bug  Rectangular Masking Bug

Grid
This turns on or off the ability to view a grid that represents the area effected
by the mask. You can also set this to Auto and the grid will appear only when
making adjustments then turn off after the adjustment is made. 

Invert Mask
Invert swaps the white for black and black for white. What was hidden is now
revealed and vice-versa. Inverting a mask can be very useful. It allows you to
remove what is outside the Masking Bug rather than what is contained within.
You can invert the mask with the command (Mac OS X) or control (Windows) i
keyboard shortcut.

Reset Mask
Reseting a mask returns it to all white. The entire layer is visible.
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Retouching the Masking Bug

You can retouch the Masking Bug with the Masking Brush. The mask created by the Masking Brush sits on top of and overrides the Masking Bug. 

You can add to a Masking Bug with the Masking Brush when the paint mode is set to Paint-Out.
You can subtract from a Masking Bug with the Masking Brush when the paint mode is set to Paint-In.

Masking Bug View Options
There are several options for viewing the Masking Bug, located in the Mask Menu:

Masking Bug Tool Opacity: Not to be confused with the opacity of the mask. This option controls how visible the Masking Bug tool outline
appears on screen. If the Masking Bug is interfering with the view of the image, you can turn it down to make it more subtle. This control has no
effect on how the image itself appears.
Masking Bug Grid: This allows you to turn the grid that appears under the Masking Bug on or off. Normally, it is set to Auto, where the grid will
appear while you are adjusting the Masking Bug only.

142  Perfect Effects

Perfect Photo Suite



Presets
Presets store the Effect Stack and all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent
results. You can save your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser.

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

Deleting a Preset

You can remove a preset from Perfect Effects if you no longer want to
have access to it. To remove a preset, follow these steps:

1. Open Perfect Effects.
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect Effects the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Effects.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Portrait, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONEffects extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Perfect Effects

About Perfect Effects: Opens the about box. This dialog contains your serial
number, version number and information on contacting onOne Software for
support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

File

Apply: Applies the current effect Stack and options to your image and returns
to the host application.

Cancel: Cancels Perfect Effects and returns back to the host application with
no changes.

Edit

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Undo Stroke: If the last action was a brush stroke, this reverses the entire
brush stroke.

Redo Stroke: If your last action was an undo of a Brush Stroke, this reapplies
the entire stroke.

Cut: Cuts the current text into the clipboard.

Copy: Copies the current text into the clipboard.

Paste: Pastes the content of the clipboard.

Reset All: Resets all the floating palette controls back to their default settings.

Preferences (Windows Only): Opens the Perfect Effects preferences
dialog.

Mask

Invert Mask: Inverts the mask, what was hidden is revealed and vice versa.

Reset Mask: Resets the mask to plain white.

Copy Mask: Copies the mask.

Paste Mask: Pastes the mask.

Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool
overlay. This has no effect on the image, just how obvious the Masking Bug tool
is on screen.

Masking Bug Grid: Sets the grid mode for the Masking Bug.

Menus
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Preset

Save Preset: Saves the current Effect Stack as a new preset.

Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.

Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit the name, author or
description information.

View

Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.

Zoom Out: Zooms the preview window out one increment. This will make the
preview image smaller.

Fit to Screen: This sets the preview image so that the entire image is on
screen at once. Think of this as an overview of the entire image. This is the
setting you will use most of the time.

Fill: If the target layer is smaller than the canvas size, it sets the zoom to fill the
preview with the target layer.

Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.

Show Browser Pop-up: Enables the browser pop-up window.

Browser Mode: Allows the user to select how the Browser Library displays the
categories.

Show Clipping: Shows the clipping overlay view, which over-rides
the current mask view.

Show Preview: Toggle to enable or disable the preview.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.

Show Mask: Allows the viewer to see the mask.

Mask View Mode: Allows the user to select the various mask modes.

Window

Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.

Effects Stack: Hides or shows the Effects Stack pane.

Effect Options: Hides or shows the Effect Options pane. Effect Options is only
available in Advanced mode.

Show Browser Panel: Hides or shows the Browser Panel.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the open
image.
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Help

Search: Mac OSX only. Searches the menus options.

Perfect Effects Online Help: Opens this html Help in your default web
browser.

Video Tutorials: Opens the online Video Tutorial in your default web browser.

Getting Started: Opens the getting started overlay.

Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for  Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving it to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.

About Perfect Effects (Windows Only): Opens the about box with the
version number and license code displayed.

Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts

Perfect Effects has many keyboard short-cuts to make it faster to access common buttons and menu items. It also uses many of the keyboard shortcuts that
Photoshop uses, making it intuitive to learn. Here is a list of the most commonly used keyboard shortcuts:

Action  Mac  Win

 Apply  cmd s  ctl s

 Cancel  esc, cmd w, cmd .  esc, ctl w

 Save Preset  cmd shift s  ctl shift s

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Cut  cmd x  ctl x

 Undo Stroke  cmd opt z  ctl alt z

 Redo Stroke  cmd shift opt z  ctl shift alt z

 Copy  cmd c  ctl c

 Paste  cmd v  ctl v

 Reset All  cmd opt z  ctl alt z

 Open/Close Navigator  cmd 1  ctl 1

 Open/Close Effect Stack cmd 2 ctl 2 

 Open/Close Effect Options cmd 3 ctl 3 

 Hide Browser Panel  cmd left arrow  ctl left arrow

 Hide Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Fullscreen Mode  cmd ctl f  F11

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select MaskingBrush  b  b

 Select MaskingBug  n  n

 Zoom-In  cmd + or cmd =  ctl + pr ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fill with layer  cmd shift 0  ctl shift 0

 Brush Size
 larger ]
smaller [

larger ]
smaller [

 Brush Feather
softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
opt ]
opt [

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc or
alt ]
alt [

 Enable or Disable Perfect Brush  cmd r  ctl r

 Toggle Brush Mode
 x
opt

 x
alt

 Show Mask  ctl m  ctl m

 Preview on/off  cmd p  ctl p

 Preview Modes
  - Single Image
  - Left/Right
  - Left/Right Split
  - Top/Bottom
  - Top/Bottom Split

 
cmd Y
cmd L
cmd opt L
cmd T
cmd opt T

 
ctl Y
ctl L
ctl opt L
ctl T
ctl opt T 

 Show Quick View Browser  cmd up  ctl up

 Change Effect Layer Strength

 number keys
1 - 10%
2 - 20%
etc

  number keys
1 - 10%
2 - 20%
etc
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The pinnacle for many photographers is the perfectly mastered black and white print. With Perfect
B&W, you can easily develop your own stunning black and white images. Its powerful and intuitive
tools give you instant results with complete creative control. Use Perfect B&W to add dramatic and
elegant looks to your photos and create the many moods black and white photography can evoke—
resulting in beautiful and provocative imagery.

Some of the features:

Reproduce vintage styles using film grain and darkroom techniques quickly with a library of
well crafted presets.
Save time and stay focused on your image editing when your library of favorite effects are
always nearby.
Precisely dodge and burn, add detail, and apply selective color with a set of powerful brushes
designed for black & white processing.
Paint inside the lines with precision using the new edge-detecting Perfect Brush.
Use Blending Modes to blend your black & white image with your original to achieve a unique
hand-painted or grungy effect.
Imply mood and depth with striking detail using the Toner Presets in Perfect B&W.
Use built-in color filter presets to enhance contrast in your image.
Adjust the relative brightness of the details you care about, whether it's the sky, foliage, or
people.
Optimize the balance of tone and contrast in your image with the Tone Curve. 
Adjust shadows, mid-tones, and highlights to create the exact look you want.
Accentuate your images with vignettes, authentic film & darkroom edge effects, and borders.

What This Means For You
Whether you are a hobbyist photographer or a working professional, you can achieve classic black
and white looks instantly with a library of expertly crafted effects or customize your own unique look
using powerful, darkroom-inspired controls that replicate time-honored processing techniques.
Enhance tone and contrast by boosting shadow and highlight details or bring back a touch of selective
color. Control the exact appearance of your image using a set of essential adjustment brushes and
achieve precise edge detected masking with the all-new Perfect Brush. With Perfect B&W, you'll infuse
the artistry of black and white photography and create your own masterpiece.

 

 

Perfect B&W

The easiest way to develop stunning black & white images
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This getting started section will give you the basics of using Perfect B&W. If you have never used
Perfect B&W before, this is a good place to start. You might also try watching the getting started
video tutorial. For detailed information on steps and controls mentioned in the getting started
section, see the "Using Perfect B&W" section instead. 

 

 

 

Getting Started
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Perfect B&W Work Space

The Perfect B&W Main Screen Overview

Perfect B&W provides you with an easy-to-use work space for editing your photos. Below is an overview of the main sections. 

The main window sections of Perfect B&W:

A. Browser Section: This is located on the left side of the window. It is where you browse different effects.

B. Tool Well: This is where the tools are located.

C. Preview Window: This is the main section where you preview and work on images.

D. Tools Option Bar: This is where information and options about each tool is set.

E. Module Selector: This is where you choose which software module to open.

F. The Navigator, Loupe and Histogram Pane: This pane will access navigational, loupe and histogram features.

G. The Control Panes: These are located on the right side. It's where you access the ten different control panes.

H. The Cancel/Apply Buttons: This is where you cancel or apply an action.
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Perfect B&W Tool Well

There are seven different tools in the Perfect B&W tool well. 

More details about each tool are covered in the following chapters. 

Brightness Brush  This is used to locally lighten or darken areas of the image (burn or dodge).

Contrast Brush  This is used to locally increase or decrease the amount of contrast in the image.

Detail Brush  This is used to locally increase or decrease the amount of detail in the image.

Targeted Brightness  This varies the brightness of a color range by adjusting the Color Response panel settings.

Selective Color Brush This is used to locally paint back the color from the original image.

Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

Zoom Tool  This tool changes the magnification in the preview window.
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Navigating the Preview

Perfect B&W provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

 Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane there is a slider for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

 The Info panel is not visible when you access Perfect B&W as a Photoshop plug-in.
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The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.

Single Mode Screen. Left-Right Screen. Left-Right Split Screen.

Top-Bottom Screen. Top-Bottom Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.

Command (Control) L:
Command-Option (Control-Alt) L:

Command (Control) T:
Command-Option (Control-Alt) T:

Command (Control) Y:

 Change the preview mode to Left/Right.
 Change the preview mode to Left/Right Split screen.
 Change the preview mode to Top/Bottom.
 Change the preview mode to Top/Bottom Split screen.
 Change the view mode to single image. 

Preview Window Modes
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Using Perfect B&W

Pages in this Section
Browsing Effects
Control Panes
Adjustment Brushes
Targeted Brightness Tool
Mask Modes
Zones View 
Presets
Menus
Keyboard Shortcuts
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Browsing Effects

Built into Perfect B&W is a browser, located in the left panel. You can use it to browse the factory supplied effects, presets you have created or downloaded
from the onOne Marketplace or for marking and finding your favorites. Below is a description of the controls in the browser.

A. Browser Tabs: This switches between the Effects tab, Favorites tab and My Presets tab.
B. Search Field: Use the search field to locate effects and presets. Simply start to type and your
results will appear in a new sub-folder called search results while you type.
C. Categories: Categories work just like folders. Select one to open it and view its contents
D. Effect: An effect is displayed as a thumbnail of the image with the effect applied and will have the
effect name listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size
of the browser or close it.
F. Favorite Flag: Click on the flag to mark an effect or preset as a favorite. It will appear in the
Favorites tab automatically.
G. Browser Modes: These icons control the browser mode. Either thumbnail columns or list view.
H. Quick View Browser: Pressing this button opens the Quick View Browser where you can see
larger versions of each preset.

Browser Tabs

The Browser is divided into three tabs; Effects, Favorites and My Presets.

Effects: The Effects tab contains the factory effects provided by onOne Software. 
Favorites: When you click on the favorite flag on an Effect or preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to
find the effects and presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne Marketplace, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
The selected item, either a category, effect or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close categories using the command (control on Windows) up and down arrows.

You cannot move or delete presets from the browser.

Selecting an Effect or Preset to Use
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To activate an effect or preset on your image, simply click on it.

Searching

To search for effects or presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on an effect or preset, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the command (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four
viewing modes. Three that
display thumbnails in
columns and one list view.
The browser modes are
selected using the browser
mode icons at the bottom
of the browser.

   single column view    two column view    list view

Quick View Browser
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The Quick View Browser adds an
elegant full-screen view of your
images, effects and presets.
Whether you are looking for the
right image or the right look, the
Quick View Browser will make fast
work of the problem. Just press
the Quick View Browser button
(or the command up or control up
keyboard shortcut) and you will
see the full array of options to
choose from. You can visually
navigate categories, then dive
into them to find just the right
look.

Browse folders and
images quickly to find
the right one to work on.
View all your effect or
preset categories at one
time, then dive into them
to find the perfect look
with an effortless, tablet
feel.
Variable thumbnail sizes
gives you a few large
previews or many small
ones depending on your
screen size and content.
Back button and
breadcrumbs make it
easy to navigate a
complex folder
structure.
Use your keyboard
arrow keys to navigate.
Press the return key to
select an item or open a
folder.
Use the command or
control left arrow to go
up a folder level.

 

160  Perfect B&W

Perfect Photo Suite



Perfect B&W has a series of ten control panes to convert and enhance your B&W images.

The Control Panes are:

Tone
Color Response
Tone Curve
Glow
Film Grain
Toner
Vignette
Border
Sharpening
Blending

Tone

The Tone pane controls the global tonality, or brightness and contrast of the image. You can adjust each of
the following:

Brightness: Adjusting the slider to the right will lighten your image. Adjusting to the left will darken
your image.
Contrast: This will increase or decrease the contrast in your image.
Blacks: This slider will clip the blacks adding more contrast to the blacks.
Whites: This slider will clip the whites adding more contrast to the whites.
Auto Levels: This will set the black and white points automatically.  
Shadows:  This slider lightens the shadows, revealing details.
Highlights: This slider darkens the highlights, recovering detail.
Detail: Increases the detail or structure in your image. 

 

  

Color Response

The Color Response pane controls the black and white conversion. Get the effect of photographic filters
after the shot. Use built-in color filter presets to enhance contrast in your image and adjust the relative
brightness of the details, whether it's the sky, foliage, or people.

The top section contains presets based on different color filter options. These simulate using different
colored filters over the lens when photographing with film. 

Color Sliders: The color sliders increase or decrease the brightness of each color range.
Auto Mix: When enabled, the color sliders are set automatically.

 

   

Tone Curve

The Tone Curve pane controls the global tonality of the image. You can adjust your shadows, mid-tones
and highlights to create the exact look you want. 

 

 

Control Panes
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Glow

The Glow pane controls diffusion over the camera or enlarging lens.

Style: Sets the blending mode of the glow layer.
Amount: Adjusts the blur strength or opacity.
Halo: Adjust the halo, or blur radius.

 

   

Film Grain

The Film Grain pane loads an overlay of scanned film grain to add the appearance of film grain. Choose
from a selection of carefully crafted film types that integrate realistic grain onto your images.

Film Type: A drop-down list of Film Grains from popular black and white films.
Amount: Adjusts the strength, or amount of film grain.
Size: Adjusts the size of the grain, simulating different sizes of film.

 

   

Toner

The Toner pane simulates different chemical toners or paper types used in the darkroom. It is divided into
two sections. One for toning the paper (the highlights) and one for toning the silver (the shadows). Select
from a collection of toners such as copper, cyanotype, selenium, sepia or build your own.

Preset: A drop-down menu with a selection of toner presets.
Paper (Highlights): Sets the highlight color.
Amount: Sets the strength, or opacity of the effect
Silver (Shadows): Sets the shadow color.
Balance Sets the transition between the highlight and shadow color.

 

   

Vignette

The Vignette pane creates flexible vignettes and authentic film & darkroom edge effects.

Brightness: Adjusts the brightness of the vignette, either dark or light. 
Size: Adjusts the size of the vignette. 
Feather: Sets the feather or hardness. 
Roundness: Changes the shape from round to square. 
Style: Sets the blending mode.

  

   

Border

The Border pane creates flexible print edges. There are several categories and options to adjust your
border.

Category: Sets the category of border.
Border: Select which border to add.
Blending: Sets the blending mode for the border.
Opacity: Sets the strength or opacity.
Size: Changes the size of the border.
Rotate & Flip: Rotates or flips the border.
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Sharpening

The sharpening pane controls the overall sharpness of an image.There are three types of sharpening;
Progressive, High Pass and Unsharp Mask. Each of the types have sliders to adjust the following:

Type: Sets the type of sharpening; Progressive, High Pass or Unsharp Mask
Halo: Sets the halo or radius.
Amount: Sets the amount of sharpening.
Protect: There are three sliders for adjusting the amount of protection for the Darks, Lights and
Skin colors.
Ethnicity: A drop-down menu to select the ethnicity of the skin to protect.

 

   

Blending

The Blending Pane allows you to blend the black and white version back to the original color image. With
this you can create subtle antique, hand-colored or grunge looks.

Blending: Sets the blending mode.
Opacity: Sets the amount of the added effect to your image.

   

Perfect B&W  163

 

Perfect Photo Suite



When you select the adjustment brushes, your tool changes to a circle representing
the size of the brush. It will appear as two concentric circles indicating the inner hard
edge and outer soft edge of the brush if the feather control is set above zero. There is
also either a plus or minus in the center of the brush. Minus means the brush mode is
set to paint-out, plus means it is set to paint-in.

To use the one of the adjustment brushes, select it in the tool well. Then check the brush mode and confirm it is set to the desired mode. Then adjust the size
and feather. Next, brush over the image in the areas you wish to adjust. 

If you make a mistake it is easy to fix using one of these methods.

First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.
You can always reset all the brush strokes for the tool by pressing the Reset button in the Tool Options Bar.

Brightness Brush Tool Options Bar
The brush mode, size and feather and amount are controlled in the Tool Options Bar, which changes for each tool.

Mode
The mode toggles the control to Lighten or Darken an image when you brush over the image. You can tell your current mode by looking at the plus or minus icon
in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in.  You can change the mode in the Tool Options Bar,
or by pressing the X key, or by holding down the option (alt) key temporarily. 

Size
You can control the size of the brush using the Brush Size Slider. The brush has a
range from 1 to 500 pixels. You use a small brush at high magnification for precise
work, and a large brush at "fit to screen" for general work. To the right, you can see
examples of brush strokes at varying sizes. You can control the size of the brush
several ways:

Use the Brush Size Slider.
Use the left and right bracket keys ( [  ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Adjustment Brushes
Perfect B&W features several adjustment brushes for local control. These brush tools (Brightness, Contrast, Detail  and  Selective Color) mimic many darkroom
techniques like burning, dodging, bleaching, and reducing. There are also options that were almost impossible in the darkroom such as local contrast and
sharpening.

Brightness Brush

 The Brightness Brush is the most commonly used tool. It allows you to lighten or darken areas of the image where you paint. Think of this as burning or
dodging in the darkroom. When you use the Brightness Brush with the Perfect Brush option enabled you have a smart, auto-masking burn and dodge tool that
makes it fast and easy to adjust the brightness locally in a realistic way

Contrast Brush

The Contrast Brush works the same as the Brightness Brush but allows you to increase or decrease contrast locally. You can use this tool to enhance your
center of interest or to reduce distractions. 

Detail Brush

The Detail Brush gives you the power to control the detail or structure of the image locally. You can use it add crispy details to your center of interest or to
reduce noise in the sky. 

Selective Color Brush

The Selective Color Brush allows you to hand-paint color back into your image, just like painting with oils on a print. The best part is you don't have to pick the
color to paint with. Reveal subtle bits of color or paint black and white just where you want it. 

Adjusting the Brushes
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Feather
You control the amount of feathering or hardness of the brush by using the Feather
Slider. The feather has a range from 1 to 100 percent. You use a small feather at high
magnification for precise, hard-edged work and a large, soft-edged brush at "fit to
screen" for general work. You can visually see your feather by watching the outer
concentric circle of the brush tool. To the right you can see examples of different
feather options. You can control the size of the brush several ways:

Use the Feather Slider.
Use the shift + left and right bracket keys ( [  ] ).

 

Amount
You can control the opacity, or strength of the brush with the Amount Slider. Think of
the amount as the shade of gray you are painting with. The opacity has a range from
1 to 100 percent. You use a high opacity to paint quickly and hide large areas. You
use a lower opacity for blending areas together or for subtle work. To the right you
can see examples of different opacity options. You can control the size of the brush
several ways:

Use the Opacity Slider.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

 

Wacom® Controls
Perfect Layers supports pressure sensitive Wacom tablets. When you use the Masking
Brush you, can enable special pressure sensitive controls for the brush size, brush
opacity, or both simultaneously. Click on the "W" to activate the pressure sensitive
controls.

The harder you press; the greater the size or opacity will get. You can set the
maximum value you want to use the Brush Size and Opacity sliders. To the right you
can see examples of how pressure sensitivity can be used to control the Masking
Brush.
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Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking technology.
When enabled, as you paint with the Masking Brush it collects the colors under the
center of the brush and only masks those colors. This protects the mask from being
applied across edges. A great of example of using the Perfect Brush option would be
to mask a sky along a horizon of mountains.

Tip: You can turn the Perfect Brush on and off using the command or control
-r keyboard shortcut. You can also temporarily lock the color to remove by
holding down the control key(win) or command key(mac). This is useful when
brushing through areas with lots of openings like tree branches. 
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Targeted Brightness Tool
The Targeted Brightness tool allows you to quickly control the brightness of local areas in the image based on their color. An example of this tool in use
would be to darken the sky. By clicking on the sky, the blue or aqua color range would be selected. Then you can decrease the brightness to darken the
sky.

Using the Targeted Brightness Tool is simply, follow these steps:

Targeted Brightness Tool

1. Select the Targeted Brightness Tool from the tool-well.
2. Click and hold on the area you would like to make lighter or darker.
3. Drag your mouse to the left to make the area darker, or to the right to make it lighter.

Keep in mind the Targeted Brightness Tool works by adjusting the brightness of an entire color range in the Color Response pane. Darkening the sky will also
darken anything else in the scene that is a similar color such as water.
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The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.

 
 A close-up of the Mask View Modes

 

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

                         

   

   

Mask-
Red
The
masked
area
appears as
50% red.
This is
similar to
the Quick
Mask view
in
Photoshop.

 

Mask-
White
The
masked
area
appears as
solid white.

Mask-
Dark
The
masked
area
appears as
90% black.

 

Mask-
Grayscale
The
masked
area
appears as
black. The
unmasked
areas
appear as
white. This
is the same
as viewing
a layer
mask in
Photoshop.

 

Mask Modes

Mask Mode allows you to view your image mask in several ways.

 

Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in several
modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are examples of the
different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard shortcut.
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This view simulates the 11 zones of the Zone System. It updates in realtime as the user makes changes.

The Zones view is accessed from the the Mask View mode drop-down menu.  A close-up of the Mask View Mode drop-down
menu and options.

 
After: this shows the image results for the current
layer (default option).
Before: this shows the image in its original state.
Zones: this shows the image broken down into a
simulated zone system.

          

 

Zones View
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Presets

Presets store all of the settings you can adjust in the the control panels on the right. Presets are a fast and easy way to get consistent results. You can save
your own presets for batch processing or for simply reproducing your look when retouching.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser .

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

Deleting a Preset

You can remove a preset from Perfect B&W if you no longer want to have
access to it. To remove a preset, follow these steps:

1. Open Perfect B&W
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect B&W the new presets will be located in
the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded as they have been copied into Perfect
B&W.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect B&W, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONB&W extension. You can copy these presets to another
computer, attach them to an email or post them on a website.
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Perfect B&W

About: Opens the about box. This dialog contains your serial number, version
number and information on contacting onOne Software for support.

Preferences: Opens the preferences dialog.

Quit: Quits the application.

File

Apply: Applies the current settings to your image and returns to the host
application.

Cancel: Cancels Perfect B&W and returns back to the host application with no
changes.

Edit

Undo: Reverses the last user action.

Redo: Reapplies the last user action if it has been undone. 

Undo Stroke: If you have segmented undo enabled, if the last action was a
brush stroke this reverses the entire brush stroke.

Redo Stroke: If you have segmented undo enabled, if your last action was an
undo of a Brush Stroke this reapplies the entire stroke.

Cut: Unused.

Copy: Unused.

Paste: Unused.

Reset All: Resets all controls back to their default settings.

Preferences (Windows Only): Opens the Perfect B&W preferences dialog.

Preset

Save Preset: Saves the current settings as a new preset.

Import Preset: Opens the import preset dialog to help you import presets you
have downloaded.

Show Presets Folder: Opens a Finder or Explorer window showing the
presets folder.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit the name, author or
description information.

Menus
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View

Zoom In: Zooms the preview window in one increment. This will make the
preview image larger.

Zoom Out: Zooms the preview window out one increment. This will make the
preview images smaller.

Fit to Screen: This sets the preview image so that the entire image is on
screen at once. Think of this as an overview of the entire image. This is the
setting you will use most of the time.

Fill: If the target layer is smaller than the canvas size, it sets the zoom to fill the
preview with the target layer.

Actual Pixels: This sets the preview image so that it zooms to actual pixels or
1:1 also called 100%. This setting allows you to see every pixel in the image.
This is useful when making precision adjustments.

Show Browser Pop-up: Enables the browser pop-up window.

Browser Mode: Allows the user to select how the Browser Library displays the
categories.

Show Clipping: Shows the clipping overlay view, which over-rides the current
mask view.

Show Preview: Toggle to enable or disable the preview.

Preview Mode: Allows the user to switch preview modes.

Preview Background Color: Toggles the background color options.

Show Mask: Allows the viewer to see the mask.

Mask View Mode: Allows the user to select the various mask modes.

Window

Navigator/Loupe/Histogram: Hides or shows the Navigator, Loupe/
Histogram pane.

Tone: Hides or shows the Tone pane.

Color Response: Hides or shows the Color Response pane. 

Tone Curve: Hides or shows the Tone Curve pane. 

Glow: Hides or shows the Glow pane.

Grain: Hides or shows the Grain pane.

Toner: Hides or shows the Toner pane.

Vignette: Hides or shows the Vignette pane.

Border: Hides or shows the Border pane. 

Sharpening: Hides or shows the Sharpening pane.

Blending: Hides or shows the Blending pane.

Solo Mode: Enables solo mode. When Solo Mode is enabled, only one control
pane may be open at a time.

Show Browser Panel: Hides or shows the Browser Panel.

Show Control Panel: Hides or shows the Control Panel.

Hide Panels: Hides or shows all Panels.

Full Screen: Toggles to and from full screen mode.

Document Name: Shows the name, zoom level and bit depth of the open
image.
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Help

Search: Searches the menu options (Mac OSX only).

Perfect B&W Online Help: Opens this html Help in your default web browser.

Video Tutorials: Opens the online Video Tutorial in your default web browser.

Getting Started: Opens the online Getting Started overlay.

Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.

Perfect Inspiration: Takes you to the Perfect Inspiration web site.

Check for Updates: Checks with the onOne update server to see if you are
running the current version. If there is a newer version you will be notified and
be walked through the update process.

Deactivate: Opens the activation dialog. These are used to deactivate your
software for moving to another computer or for a return.

Registration: Opens the default web browser and navigates to the
registration page of the onOne website.

Provide Feedback: Opens the default web browser and navigates to the
feedback page of the onOne website.

About Perfect B&W (Windows Only): Opens the about box with the
version number and license code displayed.

Help Improve onOne Products: Opens the Improve onOne Products dialog.
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Keyboard Shortcuts

Action  Mac  Win

 New File  cmd n  ctl n

 Open  cmd o  ctl o

 Open as Layer  cmd shift o  ctl shift o

 Save  cmd s  ctl s

 Save As  cmd shift s  ctl shift s

 Export  cmd shift e  ctl shift e

 Preferences  cmd ,  ?

 Undo  cmd z  ctl z

 Undo Stroke  cmd opt z  ctl alt z

 Redo  cmd shift z  ctl shift z

 Redo Stroke  cmd shift opt z  ctl shift alt z

 Cut  cmd x  ctl x

 Copy  cmd c  ctl c

 Paste  cmd v  ctl v

 Open/Close Navigator Panel  cmd 1  ctl 1

 Open/Close Layers Panel  cmd 2  ctl 2

 Open/Close Masking Panel  cmd 3  ctl 3

 Minimize/Restore Browser  cmd down arrow  ctl down arrow

 Delete Layer  del  del

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Trim Tool  t  t

 Select Move Tool  v  v

 Select Masking Brush  b  b

 Select Masking Bug  m  m

 Zoom-In  cmd + or cmd =  ctl + or ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fit to Layer  cmd shift 0  ctl shift 0

 Brush Size
 larger ]
smaller [

larger ]
smaller [

 Brush Feather
softer shift ]
harder shift [

softer shift ]
harder shift [

 Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc 

 Enable or disable Perfect Brush  cmd r  ctl r

 Layer Opacity

1 (10%)
2 (20%)
0 (100%)
etc

1 (10%)
2 (20%)
0 (100%)
etc

 Show Mask  cmd m  ctl m

 Toggle Mask View  cmd opt m  ctl alt m

 Invert Mask  cmd i  ctl i

 Duplicate Layer  cmd j  ctl j

 Merge Layer  cmd e  ctl e

 Merge Visible  cmd shift e  ctl shift e

 Constrain Prop  shift drag on corner  shift drag on corner

 Grow from center  opt drag on corner  alt drag on corner

 Toggle Paint-In/Paint-Out/Erase  x  x

 Toggle Single View Preview  cmd Y  ctl Y
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 Toggle Left/Right Preview  cmd L  ctl L

 Toggle Left/Right Split Preview  cmd opt L  ctl alt L

 Toggle Top/Bottom Preview  cmd T  ctl T

 Toggle Top/Bottom Split Preview  cmd opt T  ctl alt T

 Show Quick View Browser  cmd up  ctl up
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FocalPoint

Welcome to onOne Software FocalPoint 2

You control the focus with FocalPoint 2. Create realistic selective focus, depth-of-field
and vignette effects that tell your viewers right where to look. With the intuitive Focus
Bug controller, it is similar to using a tilt-shift or selective focus lens.  Set your area of
focus and then select a lens to simulate or create your own by controlling the amount and
type of blur, even in 3D.  With the new Focus Brush tool you can paint sharpness or blur
right where you want it. Finish things off with an elegant vignette. It has never been
easier or faster to focus your viewers eye and minimize distractions.

Hide distracting backgrounds - put the viewers eye where you want it.
Unique Focus Bug control works like adjusting a lens.
Recreates the look of popular lenses including selective focus, fast aperture and
tilt-shift lenses.
Ultimate defocus control after the shot is taken. You control the amount, feather
and type of blur.
Create presets for a fast & consistent look.
Easily add realistic vignettes to your image as well.
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Getting Started

This getting started section will give you only the basics of using FocalPoint. If you have never used FocalPoint before this is a good place to start. You might
also try watching the getting started video tutorial. For detailed information on steps and controls mentioned in the getting started section see the Using
FocalPoint section instead.

Articles in this section

When to use FocalPoint
Important Terms
User Interface
Navigating the Preview
Navigator
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When to use FocalPoint

FocalPoint is useful for reducing distractions and focusing the viewers attention where you want them to look. If you have a busy background or distracting
elements, it can hide them. If your subject doesn't stand out from the background, you can use FocalPoint to make your subject pop.

FocalPoint is considered a creative effect; it would fit in the middle of your digital imaging workflow. Generally, you would use it after color, contrast adjustments
and after retouching. You would also use it before resizing and sharpening.

Before FocalPoint     After FocalPoint
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Important Terms

There are several terms used in this guide and tutorials for FocalPoint that may not be familiar to all users. 

This is a brief list and their definitions.

Focus Bug: The Focus Bug is the main control used in FocalPoint. It appears as a wireframe insect with a body, legs and antennae. You reposition the
Focus Bug by clicking and dragging its body. You adjust its size and rotation by pulling and rotating its legs. Finally, you control the amount and type of
blur as well as the feather with the antennae. 

  

Sweet-spot: The sweet-spot is the area under the Focus Bug that is uneffected (protected) from the blur.  You control the sweet-spot with the Focus
Bug.   

Bokeh: The bokeh is the area outside of the sweet-spot that is blurred.

Tilt: Photographically, tilt is created by tilting the lens plane of camera to be not perpendicular to the film plane. This is accomplished by using speciality
lenses such as tilt-shift lens or view cameras. This technique allows the photographer greater control over the plane of focus and depth of field. In
FocalPoint, the tilt control allows you to vary the feather across the sweet-spot to simulate the tilt effect. 

  

Vignette:  A vignette is darkening or lightening the edges of an image. This can help focus the viewers eye.   

FocalPoint  179

 

Perfect Photo Suite



 

User Interface

A - Preview Window: Shows your original image.
B - Navigator Pane: Shows a birds-eye view of the document. Allows you to zoom and pan the preview areas.
C - Focus Bug Pane: Contains the Focus Bug list as well as the Focus Bug controls. Each Focus Bug has its own settings.
D - Blur Pane: Contains the controls for adjusting the blur type, amount, etc. 
E - Options Pane: Contains the Highlight Bloom, Brightness, Contrast and Film Grain controls.
F - Vignette Pane: Pictured in its closed state, Contains the vignette brightness and midpoint controls.
G - Focus Brush Pane: Contains the Focus Brush controls such as brush mode, size, feather, opacity, etc. Also contains controls to view and reset the mask.
H - Preset Pane: Not Pictured. Displays saved presets and contains the controls to add and remove presets.
J - Focus Bug: The Focus Bug is used to control the Sweet-Spot or the area that does not get blurred.
K - Find More Online button: Click this button to go the the FocalPoint online portal page containing free presets, tutorials, updates and news.
L - Preview on/off Toggle: Toggles the preview window on and off. 
M - Brush Tool: Select this tool to selectively paint an effect in or out.
N - Focus Bug Tool: Select this tool to adjust the Focus Bug.
P - Hand (Pan) Tool: Select this tool to move the image within the preview window.
Q - Zoom (Magnify) Tool: Select this tool to change the size of the image in the preview window.
R - Cancel Button: Press this button to cancel FocalPoint and return to the host application.
S - Apply Button: Press this button to apply the settings to your image and return to the host.
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Navigating the Preview
FocalPoint provides several ways to navigate and view your image in the Preview window.

The Preview window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator

At the top of the control panel on the right of the main window is the Navigator pane.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%
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Using FocalPoint

Articles in this Section
Using the Focus Bug
Blur Pane
Options Pane
Using the Focus Brush
Vignette Pane
Preferences
Using Presets
Menus
Keyboard Shortcuts
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The Focus Bug is the main control for using FocalPoint. It appears as a wireframe representation of an
insect. It has a body, legs and antennae. The Focus Bug gives you a fast and tactile way to control the
most commonly used controls in FocalPoint. The Focus Bug controls the position, size and shape of the
sweet-spot (the area that does not get blurred) as well as the amount and type of blur and the feather
and opacity of the sweet-spot. 

Once you have played with the Focus Bug for a few minutes, you will get the hang of using it. It will
become fast and intuitive for you to a use, similar to adjusting a zoom lens on a camera.

 

Using the Focus Bug
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 Round Focus Bug  Round Focus Bug with grid visible  Round Focus Bug with grid and mask visible

 

  

 Planar Focus Bug  Planar Focus Bug with grid visible  Planar Focus Bug with grid and mask visible

 

  

   

You can mix and match Focus Bug shapes to create the look you desire. See the Using Multiple Focus Bug section for details.

 

Shapes

The Focus Bug has two shapes, round and planar. The bug shape is controlled in the aperture pane from the shape pop-up. The Focus Bug tool changes
appearance from a round body to a square body depending on which shape is used. 

The round shape is the default. This creates a round or oblong sweet-spot. This is similar to using a selective focus lens. The bokeh will extend to all sides
of the image.  

The planar shape simulates a tilt-shift view. It creates a sweet-spot that slices through the image from one side to another.
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Tip: It is often useful to turn on the grid when adjusting the Focus Bug. This will allow you to see the exact size, shape and position of the sweet-
spot. You can turn on the grid by going to View > Focus Bug Grid and selecting Auto or On. The grid is set to Auto by default, meaning it will only
appear when you are adjusting the Focus Bug.

Adjusting the Size, Shape and Position

The Focus Bug controls the position, size and shape of the sweet-spot. To position the Focus Bug make sure you have it selected from the toolbar and that
you have the correct Focus Bug selected. Then click, hold and drag inside the body of the bug. Place the Focus Bug in the middle of the area you want to
keep in focus (the sweet-spot). 

To control the size and shape of the sweet-spot you will need to manipulate the legs of the Focus Bug. The legs are the shorter appendages that extend
out of the Focus Bug body. On the round Focus Bug there will be four legs. On the planar Focus Bug there will be only two legs. To adjust a leg click, hold
and drag it with your mouse. You will know when you can select a leg by the end of it glowing blue when your mouse pointer approaches it. The length of
the legs control the size and shape of the sweet-spot. You can also rotate the legs around the body to change the angle of rotation of the sweet-spot. 

Using the Antennae

The antennae of the Focus Bug controls the amount and type of blur as well as the feather and opacity of the sweet-spot. You adjust the antennae the
same as the legs. Click, hold and drag the antenna you wish to adjust. 

The right antenna controls the amount and feather of blur. The length of the antenna controls the amount of blur. The longer the antenna the more blur will
be present. The angle of the antenna in relation to the body controls the feather or the transition between the sweet-spot and the bokeh.

The left antenna controls the vignette function. The length of the antenna controls the midpoint of the vignette, or how large it appears. The Angle of the
left antenna controls the brightness from light to dark.

You can lock the antenna so you only adjust one of its variables at a time. 

By holding down the shift key while adjusting an antenna it will be locked to adjust only the antenna length. 
You may hold down shift and command (Mac) Control (Windows) to constrain the adjust to the angle instead

Adjusting the 3-D Tilt

You can also use the Focus Bug to tilt the plane of focus just like using a tilt-shift lens or view camera. This will vary the blur on each side of the sweet-spot.
To control the tilt click and hold the option (Mac) alt (Windows) key and then click and drag inside the body of the Focus Bug. You will notice the grid will
appear and as you move your cursor inside the Focus Bug’s body the grid will tilt in three dimensions. You can reset the tilt by holding option (Mac) alt
(windows) and doubleclicking inside the Focus Bug’s body.

 Round Focus Bug tilted to the right  Round Focus Bug tilted to the right with mask visible

Adjusting the Focus Bug
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 Planar Focus Bug tilted to the right   Planar Focus Bug tilted to the right with mask visible

Unlike a tilt-shift lens or view camera movements, FocalPoint can only reduce the amount of sharpness, not improve it.

Adjusting the Focus Bug Feather

The feather controls how hard the edge of the sweet-spot is. The harder the edge, the more obvious the transition is between the sweet-spot and the
bokeh. Generally a setting of 25-50 is used. The feather is also controlled the angle of the right antenna.

 Small feather, hard edge  High feather, soft edge 
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Adjusting the Focus Bug Opacity

The opacity controls the opacity of the sweet-spot. At a setting of 100%, the sweet-spot is completely protected from the blur. As the opacity is
decreased, the sweet-spot begins to blur. In most cases you will want the opacity to remain at 100%. The opacity is also controlled with the left antenna.

  

100% Opacity   50% Opacity 

  

Adjusting the Focus Bug Control Appearance

The opacity of the Focus Bug itself (not to be confused with the masking opacity as mentioned above) can be controlled to minimize its interference with
the preview image. To adjust the opacity of the Focus Bug’s body go to the View menu and select Focus Bug Opacity. This has no effect on the image
itself, only how the Focus Bug control appears.
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Viewing the Mask

Mask view will enable a black and white mask view of the sweet-spot. This can help you to see the bounds of the sweet-spot as well as understand the
effects of the 3D tilt. To enable the Mask view go to the View menu and select, Show/Hide Mask. You can also toggle it on and off with the command-M
(Mac) or control-M (Windows) keyboard shortcut. Mask view has no effect on the results of FocalPoint. It is just a view mode to assist you in configuring
the FocalPoint controls.

Normal Preview with three active Focus Bugs and a Photoshop selection 

 Mask Preview, shows the shape of all three Focus Bugs and the Photoshop selection
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Using Multiple Focus Bugs

In FocalPoint 2, you can use multiple Focus Bugs to create a complex shaped mask or to focus on multiple subjects. You can use up to six Focus Bugs at a time.
You can mix each bug type as well as all its shape, feather and opacity options. By default you start with a single active Focus Bug.

Managing Multiple Focus Bugs

To create an additional Focus Bug, click on the plus [+] icon in the Focus Bug list at the bottom of
the Focus Bug pane. This will create another Focus Bug and you will see it in the list. Your new
Focus Bug will be selected by default. Unselected Focus Bugs will appear as round markers in the
preview.

 

You determine which Focus Bug is selected for editing with the Focus Bug tool by selecting it in the
Focus Bug list. Only one Focus Bug can be selected at a time.

 

You can adjust the size and position as well as Shape, Feather and Opacity separately for each
Focus Bug you add.

 

You can turn off or hide a Focus Bug by clicking on the Eye icon for that Focus Bug in the list. This
can be handy for previewing the effect of a single Focus Bug or if you want to only use the Focus
Brush or a selection from Photoshop instead of a Focus Bug to control the sweet-spot.
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Tip: If you don't want to use a Focus Bug at all, you can turn off the default Focus Bug. This allows you to blur the entire image, to use just the
Focus Brush or a selection from Photoshop to apply the effect.

Using Multiple Focus Bugs in Practice

Below is an example of using multiple Focus Bugs simultaneously. The goal is to reduce the depth of field as the columns recede from the camera. Because
there are two rows of columns, plus the foreground, this will require three planar Focus Bugs to create a realistic look.
This is the original image. Notice that the row
of columns on the left recede quickly and the
row on the right recede slowly. This means
that the feather of the Focus Bugs will need
to be different. See the examples below.

You can delete unneeded Focus Bugs by clicking on the minus [-] icon in the Focus Bug list. Keep in
mind that you must have at least one Focus Bug continually. However, you can hide it if you want.
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Lets start with the left side. Turn the first
Focus Bug to planar and rotate it to vertical.
Then position it on the left edge of the frame
and stretch it until only the first two columns
are in focus. You may need to adjust the
feather like you see in the mask view on the
right.

 

Now lets add another planar Focus Bug
focused on the right row of columns. The
right side row recedes from the camera
slower and at a shallow angle. This means we
will need to lengthen the feather on our
Focus Bug.

Drag the Focus Bug over the right edge of
the image, twist it to vertical and stretch it
out until it reaches about 2/3 of the way
across the image.

Now adjust the feather to change how quickly
the background goes out of focus. Keep in
mind that the second column on the left is
roughly parallel to the first column on the
right so they should both be in focus.

    

192  FocalPoint

Perfect Photo Suite



Okay, things are looking good except for the
path in the foreground which should be in
focus as well. Add a third planar Focus Bug,
drag it to the bottom of the image and twist it
horizontal. Now adjust its height to just past
the second column.

 

    

There you have it. By using three Focus Bugs
together we have created a realistic change
in the depth of field, creating more depth in a
two dimensional image.
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FocalPoint supports selections created in Photoshop. This allows you to blur backgrounds behind complex shapes such as people, even with hair or mesh.
You can use any of Photoshop's selection tools and techniques as well as other masking tools such as Mask Pro. Be sure your selection is the area you wish
to blur, not the subject you do not want to blur.

To use a selection with FocalPoint, follow these instructions.

1. Open your image in Photoshop and use any of
Photoshop's tools to select your subject area.

2. Invert your selection by going to Select > Invert.

3. Launch FocalPoint 2. You can confirm your selection by
toggling mask view on. Make sure that the Photoshop
Selection option is enabled.

Tip: FocalPoint will only use the area in your selection when creating a blur. This prevents any halos of your subject in the blurred area. This
does require a precise selection. If you encounter any halo around your subject in the preview area, use the Focus Brush near the edge of the
subject to paint away the blur, which will remove any halo. You can also modify your selection in Photoshop to ensure that all your subject is
selected.

Using Selections from Photoshop

194  FocalPoint

Perfect Photo Suite



The Blur pane contains the controls for adjusting the type, amount and appearance of the blur.
These settings are global and effect the blur across the entire image. All the Focus Bugs share
these settings.

Reset: The Reset button resets all of the Blur pane settings to their defaults.

Version: The version pop-up selects the type of blur, Version 1 from FocalPoint 1, and version 2,
the new blur algorithm for FocalPoint 2.

Lens: The lens pop-up contains settings that simulate popular lenses and their bokeh.

 

Amount: The Amount slider is key, it controls the amount of blur for the image. The larger the amount, the softer the bokeh will appear and the larger
the highlights will appear.

Low Amount High Amount 

  

Optic Quality: This slider varies the density of the aperture. 

At the normal position of zero the aperture will have a hard edged shape.
At a lower setting, the aperture comes hollow and the shape of the highlights will have a softer center.
If the optic quality is raised the outer edge of the aperture becomes softer and the appearance of highlights in the background become softer.

Lower Quality  Normal Quality  Higher Quality

   

   

 

 

Blur Pane
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Aperture: This pop-up sets the number of blades in the aperture. The larger the number of blades, the more round the aperture and the highlights in
the bokeh. 

3-sided Aperture  6-sided Aperture

  

  

Curvature: This slider sets the curvature of the aperture blades. 

At the default setting of zero, each blade has a straight edge.
As the curvature increases, the aperture shape becomes more rounded and smooth. A high curvature setting will look more like a fast, large
aperture lens.
As it decreases, the blades become concave and create a more geometric, even star shape. While this doesn't happen in real lenses it can create
interesting shapes in the bokeh.

 Low Curvature Normal Curvature  High Curvature

   

   

Rotation: This slider is used to rotate the shape of the aperture.

Preview: This shows a graphical preview of the aperture shape.
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The Options pane contains additional controls for adjusting the appearance of the blur. These
options are global and effect the entire blurred region.

Highlight Bloom: The highlight bloom increases the brightness of highlights in the bokeh. It will
also increase the number and strength of aperture shapes in the bokeh. Usually a setting between
100-300 works well.

No Bloom 100 Bloom  400 Bloom

Brightness and Contrast: The brightness and contrast sliders allow you a quick way to either
brighten, darken or alter the contrast in the blurred region. 

Tip: A subtle change, such as -5 brightness and -5 contrast, can help your image pop and
make the blur appear more natural.

Film Grain: Contains the Amount slider for adding Film Grain or noise to the bokeh. Adding Film
Grain can replace grain lost in the bokeh during the blurring process maintaining a realistic image. It
is also useful to prevent posterization during printing. To toggle the Film Grain effect on and off, use
the toggle to the right side. Be sure to zoom into 1:1 (100%) when adjusting the amount. 

Options Pane
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New in FocalPoint 2 is the ability to selectively apply the blur with the Focus Brush.

Users can use the Focus Brush to selectively paint in blur or sharpness. This opens a whole new world of control for FocalPoint 2. Using the Focus Brush is
similar using a layer mask in Photoshop to hide or reveal the blur in specific, user-defined areas of the image. You can use the Focus Brush to alter the
shape of the mask created by a Focus Bug or from scratch to paint focus just where you want. The Focus Brush even supports pressure-sensitive Wacom
tablets for the ultimate control. 

Using the Focus Brush
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To use the Focus Brush you need to select it from the toolbar at the bottom of the window. When
you select the brush, the icon will highlight and the tool will appear as a circular brush in the after
preview window.

The brush will appear as two concentric circles. 

The outer circle represents the outer edge or soft edge of the brush.
The inner circle represents the hard edge of the brush.

The relationship between the hard edge and soft edge are controlled with the brush size and brush
feather controls.

The Brush Size slider adjusts the overall size of the brush. This is the outer circle of the brush. 

You can adjust the brush size using the left and right bracket keys ( [ or ] ) on your keyboard
just like you would in Photoshop.

The Brush Feather slider adjusts how hard the edge of the brush is. 

At a low setting the brush will have a hard distinct edge. The inner and outer circles will be
close together.
At a higher feather setting the brush will have a softer feathered appearance. The inner and
outer circles will be farther apart. Generally, a soft-edged brush will blend the effect in or out
in a more realistic way.
You can adjust the brush feather using the shift + left or right bracket keys ( [ or ] ) on your
keyboard just like you would in Photoshop.

  Zero Feather       50% Feather    100% Feather

 The Brush Opacity slider adjusts how much "paint" is applied with each brush stroke. 

At a low opacity it will take many strokes to paint-in or paint-out an effect. Low settings are
good when fine control is required or you want the effect to be subtle.
Higher opacity settings are good when you need to quickly change the strength of an effect.
You can adjust the brush opacity using the number keys on your keyboard (1-0, 1=10%,
2=20% etc.) just like you would in Photoshop.

  100% Opacity       50% Opacity      15% Opacity

 The Show Mask/Hide Mask Toggle makes the black and white mask visible so you can understand the
effect of your mask painting. 

Keep in mind that white areas of the mask show blurred areas while black areas show sharp
areas.
You can toggle the viewing of the mask using the command - M (Mac) or control - M
(Windows) keyboard shortcut.

 The Masking Control in FocalPoint supports Wacom® pressure sensitive drawing tablets. This allows
you to control both the brush size and opacity with your Wacom tablet. 

If Brush Size is selected the harder you press with your stylus the larger the brush will
appear, up to the maximum size set by the Brush Size slider.
If the Opacity is selected the harder you press with your stylus the stronger, or more
opaque the brush stroke will appear, up to the maximum opacity set by the Opacity Slider.

 The Reset Mask button will reset the mask to completely white, revealing the current effect.

The Paint Focus/Paint Blur/Erase Toggle changes the "color" that the brush uses.

In the Paint Focus mode, the
brush paints in black, revealing
the original image.

In Paint Blur mode, the brush paints with white
paint which will hide the original image allowing
it to blur.

In Erase mode the brush will work like an
eraser and paint away both Paint Focus and
Paint Blur strokes.
You can change the paint mode by pressing
the "x" keyboard short-cut.

Controls
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The Vignette pane is located under the Masking Brush pane. It contains the controls for adding realistic vignettes to an image. Adding a vignette is a classic
method for focusing the viewers eye on the subject.

Lightness: The lightness slider controls the amount and brightness of the vignette. At the neutral
position, in the middle of the slider, there is no vignette. If you move the slider to the left, selecting
a value of less that 50% will add a dark vignette. At a value of 0%, the vignette will be completely
black. If you move the slider to the right, selecting a value higher than 50%, you will add a white
vignette. You can also control the Lightness by adjusting the angle of the left antenna on the
Focus Bug.

Midpoint: The midpoint slider controls the relative size of the vignette in relation to the sweet-
spot. Low values add a large vignette that is tight around the sweet-spot. Large values add a
smaller vignette that only effects the edge of the image. You control the Midpoint by adjusting the
length of the left antenna on the Focus Bug.

Overlay Blending: When enabled, the vignette will blend in naturally with the image and will act
more like a burn or dodge. Even at the maximum, setting the vignetted area will not be pure white
or black.

Vignette Follows Focus Bug: When enabled, the vignette will follow the first (bottom) Focus
Bug. That means if your subject is off-centered, the vignette will be as well. The size and shape of
the vignette will also match the Focus Bug. When this option is turned off, the vignette will be a
natural vignette that is shaped like the entire image and only effects the four corners.

 

   

 

Vignette Pane
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Option When to Use

Copy of Current Layer:
Creates a copy of the current layer and returns the results of
FocalPoint to that layer, placed above the original target layer.
This option will duplicate an existing layer mask.

Use this option if your image has only a singe layer or if you wish to only affect a
single layer, including objects like text on a transparent background. An existing
layer mask is maintained so the results of FocalPoint will only appear to affect the

unmasked area. 

Stamped Duplicate Layer: Creates a new layer at the top of
your layers palette and merges (stamps) all the layers beneath

it to this new layer. This creates a single layer composite of your
image and protects all the original layers for future editing. Any
layer masks, text layers, adjustment layers, and layer styles will

be rendered. Hidden layers will not be seen.

Use this option if you have a complex image and you want the results of
FocalPoint to affect the entire image, instead of a selection. This is a great way to

simplify your work on a complex file or to create multiple looks in a single file for
client review. You can do this by turning off each FocalPoint layer and then

running FocalPoint again to create multiple layers. Each layer can have a different
look that can be turned on or off at anytime while still maintaining the original

layers.

Preferences
The FocalPoint preferences control the results of how FocalPoint is applied to your image. Preferences maintain their settings until you change them. You can
access the Preferences from the Photoshop menu on a Mac OS X system or the Edit menu on a Windows system. 
Apply FocalPoint to:
The Apply FocalPoint to options control what layer information is sent to FocalPoint for processing. The options are a copy of the current layer or new stamped
duplicate layer. Note that FocalPoint always applies the results to a new layer of some type, leaving the original image intact so you can easily remove or alter
FocalPoint results. The only exception to this is when your target layer is a Smart Object. In these cases, FocalPoint will be applied directly to the Smart Object
as a Smart Filter.

Preferences will take affect until the next time you open FocalPoint.
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You can edit a preset's name, creator, description, or
keywords by selecting and then right-clicking on it and
selecting edit preset. If you want to edit the settings in a
preset, load it, make your adjustments and then re-save the
preset with the same name and location.
FocalPoint 2 automatically saves presets called Recently
Used, which save all the settings you used during the last six
times you applied FocalPoint.

Using Presets
Presets are a great productivity boost. They store all the control settings
including the relative Focus Bug size and position. Presets can be recalled inside
FocalPoint for further adjustment or can be added directly from the onOne
Palette, or onOne menu within Photoshop. You can apply presets within Adobe
Photoshop, Lightroom, or Apple Aperture, via the FocalPoint dialogs in each
program. You can even share presets with other users of FocalPoint online with
the onOne Exchange.

Creating Presets

Saving a preset is simple. Once you have everything set the way you like, go
to the File menu and select Save Preset. You can also press the plus icon
located in the top of the preset column.

The New Preset dialog will appear (shown to the right). There are several fields
to complete including the preset name, the category, creator and description.

In the category pull-down, you can select which existing category the preset
should save into. You can also create a new category by selecting New
Category from the bottom of the list.

Note: FocalPoint presets will store all of your Focus Bugs and their
settings but do not save Focus Brush masks. 

Using Presets

You load a preset by double-clicking on it. When you add a preset, it will clear
your current settings and replace it with the effects and settings in the preset.
You can then adjust things to tailor it to your image.
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Sharing Presets

You can share your presets with other users of FocalPoint. 

Follow these steps:

Open FocalPoint.
Go to File > Show Presets folder.

A Finder (Mac) or Explorer (Win) window will open and will display the presets
folder. In the presets folder are sub folders for your preset categories. Inside
each sub-folder are the individual preset files, with a .pto extension. You can
copy these presets to another computer, attach them to an email or post them
on a website.
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Menus
FocalPoint Menu

About FocalPoint: Opens the FocalPoint about box. This dialog contains your serial number,
version number, and information on contacting onOne Software for support.

FocalPoint Preferences: Opens the FocalPoint preferences dialog.

Tip: In Windows, the preferences can be found in the Edit menu.  The About Box can be found in the Help menu.

File Menu

Close: Cancels FocalPoint and returns back to the host application with no changes.

Apply: Applies the current options to your image and returns to the host application.

Save Preset: Opens the save preset dialog where you can save the current options as a preset for
future use or sharing.

Import Preset: Opens the import preset dialog where you can select and add presets to FocalPoint.

Show Preset Folder: Opens the FocalPoint preset folder in the Finder (Mac) or Explorer (Win). This
folder contains the individual preset files.

Edit Menu

Undo: Reverses the last user action.

Copy: Copies the current text into the clipboard.

Cut: Cuts the current text into the clipboard.

Paste: Pastes the content of the clipboard.

Reset All: Resets all the floating palette controls back to their default settings.

Preferences (Windows Only): Opens the FocalPoint preferences dialog.

View Menu
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Zoom In: Zooms the preview window in one increment. This will make the preview image
larger.

Zoom Out: Zooms the preview window out one increment. This will make the preview images
smaller.

Fit to Screen: This sets the preview image so that the entire image is on screen at once.
Think of this as an overview of the entire image. This is the setting you will use most of the
time.

Actual Pixels: This sets the preview image so that it zooms to actual pixels, or 1:1. This is
also called 100%. This setting allows you to see every pixel in the image. This is useful when
making precise adjustments.

Show/Hide Mask: Toggles the visibility of the black and white mask. This is useful for
seeing the shape of the Focus Bugs as well as your Focus Brush strokes.

Show/Hide Preview: Toggles the preview of the effect on and off. This is useful for
comparing the results to the original image.

Show/Hide Focus Bug Info: Toggles the visibility of the text tool-tips and amount
readouts on the Focus Bug.

Focus Bug Opacity: Sets the opacity of the Focus Bug control on screen. You can reduce
its opacity if it interferes too much with the image. 

Focus Bug Grid: Sets the mode of the Focus Bug Grid; always on, always off, or automatic,
where it only appears when the Focus Bug is being adjusted.

Window Menu

Navigator: Hides or shows the navigator palette.
FocusBug: Hides or shows the FocusBug palette.
Blur: Hides or shows the blur palette.
Options: Hides or shows the options palette.
Vignette: Hides or shows the vignette palette.
FocusBrush: Hides or shows the FocusBrush palette.
Presets: Hides or shows the presets palette.

Show Welcome: Opens the Getting Started Dialog which shows basic step-by-step
instructions for using FocalPoint.

Help Menu

Search: Searches menus (Mac OSX only).

FocalPoint Help: Opens this html help in your default web browser. 

Find Tutorials Online: Opens your web browser and goes to the
tutorials section of the onOne website.

Perfect Inspiration: Opens the default web browser to the Inspiration
Section of the onOne website.

Activate/Deactivate: Opens the activation dialog. These are used to
deactivate your software for moving it to another computer or for a
return.

About FocalPoint (Windows Only): Opens the about box with the
version number and license code displayed.
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 Function Mac OS X Windows 

 Close (Cancel)
 Cmd-w
esc
Cmd-.

Ctrl-w
esc

 Apply
 Enter
Return

 Enter
Return

 Open Preferences  Cmd-,  Ctrl-,

 Undo  Cmd-z  Ctrl-z

 Reset All  Cmd-opt-z  Ctrl-alt-z

 Zoom-In  Cmd-+ (plus)  Ctrl-+ (plus)

 Zoom-Out  Cmd-- (minus)  Ctrl-- (minus)

 Fit to Screen  Cmd-0 (zero)  Ctrl-0 (zero)

 Actual Pixels  Cmd-opt-0 (zero)  Ctrl-alt-0 (zero)

 Open/Close Navigator  Cmd-1  Ctrl-1

 Open/Close Focus Bug pane  Cmd-2  Ctrl-2

 Open/Close Blur pane  Cmd-3  Ctrl-3

 Open/Close Options pane  Cmd-4  Ctrl-4

 Open/Close MaskingBug pane  Cmd-5  Ctrl-5

 Open/Close Vignette pane  Cmd-6  Ctrl-6

 Open/Close Preset pane  Cmd-7  Ctrl-7

 Toggle Preview on/off  Cmd-p  Ctrl-p

 Open Help  Cmd-?  Ctrl-?

 Save a Preset  Cmd-s  Ctrl-s

 Show/Hide Mask  Cmd-m  Ctrl-m

 Change Brush Size  [] bracket keys  [] bracket keys

 Change Brush Feather  shift+[] bracket keys  shift+[] bracket keys

 Change Brush Opacity  Number Keys 1-0  Number Keys 1-0

 Toggle Paint Focus/Blur/Erase  x  x

 Select Zoom tool  z  z

 Select Hand tool  h  h

 Select Focus Bug tool  b  b

 

Keyboard Shortcuts

FocalPoint has many keyboard short-cuts to make it faster to access common buttons and menu items. 
It also uses many of the keyboard shortcuts that Photoshop uses, making it intuitive to learn. 

Here is a list of the most commonly used keyboard shortcuts:
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 Select Focus Brush tool  m  m
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Perfect Resize 

Welcome to onOne Software™ Perfect Resize 7.5

Perfect Resize 7.5, the next generation of Genuine Fractals, is the industry standard for
image resizing. It is renowned across the photographic and printing industries for its ability
to increase image size over 1000% without the loss of sharpness or detail that you would
normally expect. Its patented, fractal based interpolation algorithms work like nothing else
and the results speak for themselves. Perfect Resize 7.5 allows you to crop and resize your
image in a single step with no guess work. Its new Tiling and Gallery Wrap features make it
easy to get your enlargements printed just the way you want. Fire up the batch processing
engine to resize an entire folder of images quickly. You can even access the power of
Perfect Resize inside of Adobe Photoshop, Lightroom or Apple Aperture.
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This getting started section will give you the basics of using Perfect Resize 7.5. If you have never
used Perfect Resize 7.5 before, this is a good place to start. You might also try watching the getting
started video tutorial. For detailed information on steps and controls mentioned in the getting
started section, see the "Using Perfect Resize" section instead. 

 

Getting Started
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How Big Can You Print

People often ask how large a print can be made with Perfect Resize. If your original image is sharp, has good details and little noise, you could go as large
as 1000% of the original size. 1000% is ten times the size of the original file. For example, an original file that is 8"x10" could be resized to 80"x100".
Viewing distance plays a big part of this. Standard viewing distances are two-times the diagonal of a print. For example, for an 8"x10" it would be about
two feet away. An 80"x100" would be about 21 feet. That seems like a lot but that image is almost 7'x9'. Keep in mind that many photographers scrutinize
their images closer than standard viewing distances. 

Images are perceived in color, tonality and sharpness. Other interpolation techniques maintain color and tonality but sacrifice sharpness by "inflating" the
image uniformly. The image still looks familiar but will not be crisp. Depending on the amount of interpolation, this can be severe and noticeable even at
standard viewing distances. Perfect Resize maintains the color, tonality, and sharpness of an image at all sizes. It will always look the same when viewed
at the proper distances. 

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 8x10 and an 80x100 created by Perfect Resize. Perfect Resize will
maintain the edges which perceptually make the image sharp, but it cannot create detail where there was none in the past. When the shutter is pressed, a
finite amount of detail is captured. A good way to think about this is to look at an insect on a leaf. If you look at it with a magnifying glass, you will see
more detail than you did than when looking at it with the naked eye. Now if you take a digital photograph of that same insect and look at it in the computer
and zoom in past 100% you do not see any more detail. The information you see is limited by what the camera captured. Perfect Resize works the same
way, it can not create new detail but instead takes the finite amount of detail available and increase it in size.

Perfect Resize isn't magic. We have all watched CSI where they take a security photo and enlarge the reflection in the victim’s eye to see the killer, with
results that look amazing. This is pure science fiction. You cannot create detail where there was none before. But if your original file has good detail and
little noise, you will be able to make very good looking enlargements from your files. This is what Perfect Resize does better than any other software.
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How Much Resolution Do I Need? 

To answer this, you need to know two things: 

The size of the print you need to make.
The resolution that your printer needs for best results.

The size of the print is as large you would like. This may be limited by the size of your printer. Resolution is the density of the pixels for a given distance,
usually measured in pixels or dots per inch. Most modern inkjet printers print anywhere from 1200 to 4800 dots per inch (what the printer manufacturers
really mean is 1200-4800 droplets of ink per inch). Inkjet printers use many tiny round droplets of 4-12 ink colors to reproduce one square pixel in your
image that could be one of any millions of colors. A common mistake is to set the resolution of the file to the resolution of the printer. In all but a few
special printers this will lead to huge files that will not print well, if at all. The secret is that the human eye cannot see more than 250-300 pixels per inch.
So the ideal resolution for your files should be close to this. Once you know the print size and resolution, it is easy to use Perfect Resize 7.5 to resize your
file to the desired output. Simply input the resolution and then either the print width or height. You'll see that the corresponding dimension is automatically
filled in by Perfect Resize 7.5 based on the proportions of your image. 

Keep the proportions in mind because the proportions of film, digital camera sensors and paper can all be different. For example, most digital camera
sensors are proportioned so that the height is two-thirds the width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5x11
inches or about 1:1.25. These kind of proportion mis-matches are common and require that the original image be cropped to fit the proportions of the
paper size. If your image cannot be cropped without ruining the composition then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called interpolation or resampling. There are many
mathematical ways, called algorithms, to do this. The most common method used by many pixel editing applications is called bicubic interpolation. Bicubic
along with its newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring pixels to determine the color value of
the new pixels to be added. While this technique is fast, it does not distinguish edges so there is a uniform loss of sharpness and detail across the image. 

Perfect Resize patented scaling algorithm is fundamentally different from bicubic or other interpolation methods. While other methods sample nearby pixels
and decide new pixel values one by one, Perfect Resize uses a sampling technique called Fractal Scaling.  Fractal Scaling samples nearby "blocks," square
groups of pixels, and varying sizes, compares them to smaller versions of the original image and mosaics these patches together to create a larger version
of the original. By doing this repeatedly, often the characteristics of the image like edges, smooth areas, and textures are reinforced for each larger
version. Noise is de-emphasized and sharp details are maintained. All this number crunching may take a bit longer than the single pass interpolation
methods like bicubic, but good things come to those who wait and the reward is far superior results.

 

Understanding Resolution
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When Should I Use Perfect Resize

Perfect Resize should be used as one of the last steps in your workflow before printing. The power of Perfect Resize is in the concept of resolution on demand.
You can work with a modest size file, which makes your editing faster and takes less hard drive space and memory. Then when you are ready to output your
file, you resize it with Perfect Resize to the desired size and sharpen it for output. This means you don’t have to keep multiple versions of a file at different print
sizes; you just create what you need on-the-fly. Perfect Resize also supports layered Photoshop files so you can maintain all your layers in the entire process.
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Supported Color Modes

When used as a standalone application or through Lightroom and Aperture, Perfect Resize supports 8 or 16 bit RGB images. These are the most common among
Photographers. 

If you use Perfect Resize through Photoshop, you have access to a larger range of color modes, depending on the version of Perfect Resize you have. Consult
the chart below for details.

Perfect Resize Standard Edition
Perfect Resize Lightroom & Aperture Edition
Perfect Resize Premium Edition vai Standalone
Perfect Resize Premium via Lightroom or Aperture

Perfect Resize Premium Edition
via Photoshop 

Saving STiNG Files
via Photoshop 

RGB 8-bit  Yes  Yes  Yes 

RGB 16-bit  Yes  Yes  Yes 

Grayscale 8-bit  No  Yes  Yes

Grayscale 16-bit  No  Yes  Yes

Lab 8-bit  No  Yes  No

Lab 16-bit  No  Yes  NoLab 16-bit  No  Yes  No

CMYK 8-bit  No  Yes  Yes

CMYK 16-bit  No  Yes  Yes

Photoshop Layers  Yes  Yes  No

Layer Masks  Yes  Yes  No

Text Layers  No  Yes  No

Adjustment Layers  No  Yes  No

Alpha Channels  No  Yes  No

Paths  No  Yes  No

Smart Objects  No  No  No
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User Interface

The Perfect Resize 7.5 Work Area

Perfect Resize provides you with an easy-to-use work area for editing your photos. Below is an overview of the main sections. 

The main sections of Perfect Resize:

A. Preset Browser: This panel is located on the left side of the window and is where you view a Library of presets.

B. Tool Well: This is where the tools are located.

C. Tool Options Bar: This strip above the preview window contains the options for the selected tool.
D. Preview Window: This is the main section where you preview and work on images.

E. Module Selector: This is where you select other modules to work in.

F. Control Panel: This is where you access the Control Panes.

The Perfect Resize Tool Well

There are three different tools in the Perfect Resize tool well. More details about each tool will be covered in the next chapters.

 Crop Tool  This tool lets you crop the image.

 Hand Tool  This tool drags your image within the preview window when it's larger than the viewable area.

 Zoom Tool  This tool changes the magnification in the preview window.
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Navigating the Preview
Perfect Resize provides several ways to navigate and view your image in the Preview window. 

The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area. 

 To pan (scroll) in the Preview window: 

Select the Hand Tool and drag the image until you locate the area you wish to view. 
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window. 

With the Zoom tool selected:

Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.
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Navigator, Loupe, Histogram and Info

At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane

This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region. 

At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate. 

FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
FILL: Zooms to fit the current layer. This is great if you are working on a layout and
want to zoom in on a smaller layer you are adjusting.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%

 

The Loupe Pane

This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

 

The Histogram Pane

This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.
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The Info Pane

The info pane will display important metadata about your file including:

Camera type
File type
Focal length and lens information
Date and time captured
Exposure information 

ISO
Shutter Speed
Aperture
Exposure Value

Filename
Color Space
Dimensions
File Size and Bit Depth

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS
enabled on your camera or mobile device. Otherwise you will not see the GPS button.

The Info panel is not visible when you access Perfect Resize as a Photoshop plug-in. 
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Browsing Presets

Built into Perfect Resize is a preset browser, located in the left panel. You can use it to browse the factory supplied presets, presets you have created or
downloaded from the onOne website or for marking and finding your favorites. Below is a description of the controls in the file browser.

 

A. Browser Tabs: This switches between the Library tab, Favorites tab and My
Presets tab.

B. Search Field: Use the search field to locate presets in the current tab. Simply start
to type and your results will appear in a new sub-category called search results while
you type.

C. Closed Category: A closed category has a dark gray tab and the arrow faces to
the right.

D. Open Category: An open category has a light gray tab and the arrow faces
down.

E. Preset: A preset is displayed by its name.

F. Favorite Flag: Click on the this flag to mark a preset as a favorite. It will appear in
the Favorites tab automatically.

G. Resize Handle: On the right edge is a resize handle that you can drag to change
the size of the browser or close it.

Browser Tabs

The Browser is divided into three tabs; Library, Favorites and My Presets.

Library: The Library tab contains the factory presets provided by onOne Software. They are a good place to start.
Favorites: When you click on the favorite flag on a preset, in any tab, it is added to the Favorites tab automatically. This makes it fast to find the
presets you use most frequently.
My Presets: When save your own presets, or install presets from the onOne website, they will be located here.

Navigating the Browser

To open a category, click on it. To close it, click on it again.

Only one top-level folder can be open at a time.
The selected item, either a category or preset, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
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You can open or close categories using the command (control on Windows) up and down arrows.

Selecting a Preset to Use

To activate a preset on your image, simply click on the preset.

Searching for Presets

To search for presets in the current browser tab, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up

To view a larger preview on a preset, enable the Show Browser Pop-up in the
View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up
window.

 

 

Resizing and Closing the Browser

The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.
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Using Perfect Resize
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The crop tool allows you to crop and resize your
image at the same time. Cropping removes any
pixels outside the crop box and changes the
canvas size at the same time. To crop the
image, select the Crop Tool from the tool well.
Then either select a crop preset or drag a box
over the area you wish to keep. The area
outside the crop box appears darkened for
guidance. You can resize and move the crop
box. The crop is Perfect Resize does not need
to be applied or committed, it is always live until
you apply your entire results.

Moving the Crop Box

To move the Crop Box, simply click and drag
inside the box. You can also nudge the box
using the arrow keys on your keyboard.

Resizing a Crop Box

To resize the Crop Box, click and drag on any of the resize handles. Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on
a side handle allows you to adjust that side. If you hold the shift key down while adjusting the size, the proportions of the box are maintained. 

Rotating a Crop Box

To rotate the Crop Box, move your cursor just outside of any of the corners. The cursor will change to a rotate cursor. Click and drag to rotate. 

Setting the Crop Size

There are two ways to preset the crop box size. The first is to select a document size preset from either the Crop Tool Options Bar, or the Document Size
pane. This will add a crop box to fix the image locked at the size and proportions of the preset. This is the fastest way to crop and resize your image at the
same time. You can then adjust the size and location of the crop box to best fit your composition.

You can also type in the size you desire into the width and height fields of the Crop Tool Options Bar, then drag out a crop box. This works similarly to a
Document Size Preset. It will lock the size and proportions of the crop box.

Cropping the Image

Crop Tool: This is used to crop the entire image.
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The original image is 10”x8” at a resolution of 200 pixels per inch. 
Notice that the pixel dimensions are 2000 x 1600 pixels. 

2000 px = 10”x200 ppi
1600 px = 8”x200 ppi

 

   
By changing the width to 20” the height changes to 16” proportionally 
and automatically and the new pixel dimensions change to 4000 x 3200 pixels. 
Note the resolution does not change. 

4000 px = 20”x200 ppi
3200 px = 16”x200 ppi

Note the file size and percentage have changed as well.

 

 

Adjusting the Image Size

In Perfect Resize, you can adjust your image size using either the Pixel Dimensions or Document Size panes. The information in these panes are interrelated and
locked together. Adjusting the values in either pane will lead to changes in the other pane. To help explain this, lets use the example below.

Follow these steps to adjust the size of your image to what is desired for your output file. 

1. Launch Perfect Resize 7.5.
2. Adjust width in the Document Size pane to your desired width. Note that the height will adjust automatically and proportionally. 
3. If needed, adjust the Resolution in the Document Size pane to what your printer or other output device needs. 
4. Press Apply.
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Tip: Using Document Size Presets is the fastest way to get common sizes. They let you crop and resize your image simultaneously. 

Keep the proportions in mind because the proportions of films, digital camera sensors, and papers can all be different. For example, most digital
cameras sensors are proportioned so that the height is two-thirds the width or 1:1.5; While the most common paper size, in the US, is letter size
which is 8.5x11 inches or about 1:1.25. These kinds of proportion mis-matches are common and require that the original image be cropped to fit the
proportions of the paper size.

Tip: The constrain proportions option locks the original image proportions so that when you change a value, like width, 
in the Pixel Dimensions or Document Size Preset panes and the height will adjust automatically. This function is on by default and is always
recommenced to use. By turning Constrain Proportions off you can inadvertently stretch and distort your image.
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Document size presets allows you to crop and resize your image simultaneously. Often,
when you are using Perfect Resize it is to create a file for print output at a known
common size. In these cases, using a Document Size Preset can be the fastest way to
set your Document Size and crop your image to the needed proportions.

Follow these instructions to use a Document Size Preset:

1. Select your image and launch Perfect Resize.
2. Select your desired size from the Document Size preset pull-down in the

Document Size pane, or Crop Tool Options Bar. You will see that the Document
Size fields will be completed automatically for you and that a crop box is drawn
on your image matching the proportions of the Document Size Preset that you
selected.

3. If needed, select the rotate crop box to rotate your crop box to the proper
orientation. It will automatically rotate to match the orientation of your image,
but if you want to crop differently you may need to rotate it. 

4. Now, you can use the crop tool to reposition and change the size of the crop
box so that it contains just the image area that you want. Note that the crop
box proportions and Document Size are locked so that you will always have the
finished document size that you requested.

5. Adjust your resolution to what is needed for your output device. If you are
unsure what to select, use the resolution drop-down menu for common settings.

Perfect Resize 7.5 comes with many commonly used print, paper and video Document
Size Presets but also allow users to create their own.

To create your own Document Size Preset follow these instructions:

1. Select your image and launch Perfect Resize.
2. From the Document Size Preset pull-down, select custom > Manage Custom

Sizes.
3. Click on the Add button.
4. Double-click on the highlighted untitled name and name your preset. 
5. Double-click on the width and height and fill in the proper values. 
6. Click on the units and select the proper unit. 
7. Click on the Okay button.

Tip: If you select the incorrect Document Size Preset you can change it by selecting a different one. If you do not

wish to use a Document Size Preset after you have selected one you can select “None” from the top of the Document 

Size Preset pull-down. Or you can click once outside the crop region with the crop tool to clear at any time.

Tip: The lock crop option locks the proportions and document size settings for the given crop. This is enabled by default 
when you use a Document Size Preset.

Using Document Size Presets
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The settings dialog contains the controls for selecting the resizing method, or algorithm, and its
settings. Every image is different and selecting the correct settings here can improve the
quality of the results. To help you get started, try one of the presets in the Image Type drop-
down menu.

Image Type: This pop-up contains presets that adjust the settings for Amount and
Threshold automatically. 

Method: The method drop-down selects the the method, or algorithm, used to resize the
image. The options are:

Genuine Fractals: This is the classic, patented, fractal-based algorithm that has made
Perfect Resize the standard for over a decade.
Perfect Resize Portrait: This is a new variation on the Genuine Fractals algorithm
designed for portrait images. It is slightly softer and does a better job representing
skin and hair textures.

Texture Controls
When you select the Genuine Fractals method there are several other controls that tune the
resizing algorithm based on the image. These deal with the texture of the image.  If you were
to analyze an image from a detail perspective you could break it into three categories: Edges,
Continuous Tone and Textures. Edges are obvious; these are the sharp details that define the
edges of the subject in your image. It’s paramount that these are maintained in order for your
enlargement to maintain quality. The continuous tone areas are things like skin or skies that
are mostly solid or graduated color. These resize easily as there is little detail in these areas.
The last area, what we call texture is areas that fall between these two. They are areas that
still contain detail but are not sharp edges. These are things like the surface of rocks, tree
bark, fabric, animal fur, etc. The amount of detail in these texture areas can have a large
impact on the perceived sharpness and quality of an image. In Perfect Resize you can control
the key algorithm variables that effect these areas. In Perfect Resize there are even presets
for different image types and subject matters that help you get the best results in reproducing
these textured areas.

Texture: This controls the amount of detail in flat, non-edge areas of an image. If your image
contains lots of small detail that does not have defined edges (many organic patterns like
leaves, rock, bark; or man-made patterns like fabric) it may be good to increase the amount to
a setting of 4 or 5. Settings beyond 5 will often introduce a bumpy noise pattern which is
undesirable unless your original image was from scanned film. Settings lower than the default 3
are useful for images with large areas of continuous tone that have no appreciable detail
(sand, snow, sky) but have hard edged foreground subjects such as landscape images,
architecture or portraiture.

Threshold: This controls the amount of hard edge detail that is enhanced. The default
setting is 25. Decreasing the threshold will focus the algorithms only on edge information. This
may be useful for portraiture or for reducing noise in your image. Settings higher than 25 will
increase the amount of small detail in flatter areas of the image. Settings as high as 100 are
useful for highly detailed images such as hair or feathers. Higher threshold settings will also
make Perfect Resize process faster. A good way to start adjusting these controls is by setting
the threshold to 100 and then move the amount up until the image is too noisy (bumpy) and
then reduce the threshold to smooth out the noise in continuous tone areas. For detailed
images with no little or no continuous tone, you might try the amount at 4 and the threshold at
100. For portrait images or images with significant JPG artifacts you should try an amount of 2-
3 and threshold of 25 or lower.

Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges.
Use the lowest setting needed.

Tip: Always make sure your zoom is set to 100% or 1:1 when adjusting the
controls in the Texture Control Pane. 

Settings
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The sharpening pane contains the controls to add additional sharpness to your image. 

Perfect Resize features three different sharpening methods:

Unsharp Mask: Good for general sharpening. Similar to Photoshop's unsharp mask function
except it is only applied to the luminance of the image to prevent color artifacts.
Highpass: Highpass sharpening is helpful when the original image is not sharp.
Progressive: Similar to the unsharp mask except it sharpens different amounts depending
on the size of the details in the image. Small details are enhanced more than large ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharpening before
printing and can help compensate for loss of sharpness due to dot gain from your printer. Sharpening
should only be applied at the end of your workflow just before printing. If you plan to do additional
retouching or compositing work after resizing your image, you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document Size
pane controls. 

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in the Navigator
pane.

2. Enable the Sharpening controls by toggling the on/off control in the Sharpening pane title bar.
3. Select the sharpening method that will provide the best results for your image. You may need to experiment

to determine this.
4. Adjust the amount slider to determine the amount of sharpening desired.
5. Use the Highlight and Shadow sliders to limit the sharpening from being applied to the darkest and lightest

areas of the image which can prevent sharpening of noise.

Sharpening Off Sharpening On

Sharpening

Tip: Keep in mind that this
sharpening is applied to the
entire image area. If you wish
to use a selective sharpening
technique you should disable
the Sharpening controls in
Perfect Resize.
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The Film Grain setting controls the amount of simulated Film Grain (noise) to
your image. Adding a modest amount of Film Grain can make your image
appear sharper visually and can help hide imperfections like JPG artifacts. This
is especially useful for monochrome images. Film Grain should only be added
just before printing. If you need to do other retouching or compositing work in
Photoshop after resizing your image, you should disable the Film Grain
controls.

To add Film Grain to your image follow these steps: 

1. Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in the Navigator pane.
2. Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.
3. Adjust the slider up or down until the desired amount of Film Grain is added.
4. You can preview just the effect of the Film Grain by toggling the Film Grain on/off control.

Film Grain Off

             

Film Grain On

 

Film Grain
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The tiling feature in Perfect Resize 7.5 will divide an enlargement into
smaller pieces that can be printed on a smaller printer. 

Lets say you want to create a mural that is 8 feet tall by 12 feet long
but your printer can only print 24 inch wide strips. With the tiling
feature you could automatically create four separate files that are
24" wide and 8 feet tall so you can create your mural in sections.
With the tiling feature all you do is specify the size of paper you have
to print on and if you would like the pages to overlap. Then Perfect
Resize 7.5 will resize your image and section it down into the
individual tiles.

  

   

To use the Tiling feature, follow these instructions:

1. Turn tiling on by toggling the on/off switch in the pane
header.

2. Set the Width and Height fields to the size and orientation of
paper that you wish to print on, or you can select the
number of rows and columns instead.

3. Set the Overlap size. The overlap makes each tile overlap so
you can tape multiple panels together and corrects for
printer margins if you are not printing borderless.

4. Set the file type for the newly created files for each tile.
5. Set the destination folder for the new files. Each file will be

named with the original filename and the tile indicated in the
filename.

The preview will show cyan guide lines for each tile that will be
created. The bottom of the Tiling pane will tell you how many tiles will
be created.

 

Tiling
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The Gallery Wrap feature is designed to help you print on canvas. When making
enlargements for canvas it is common to wrap a portion of the image around
wooden stretcher bars. These can be several inches thick and are used for
mounting the canvas. These are commonly called gallery wraps. However, if the
photographer had important detail near the edges of the image they may be lost in
the wrapping process. The Gallery Wrap feature in Perfect Resize Professional
Edition automatically creates extended margins by reflecting or stretching the areas
near the edge of the image allowing the photographer to create a gallery wrap
without having to sacrifice any of the original image. The Gallery Wrap feature
allows you to select the thickness of the canvas mounting bars and offers a variety
of techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1. Turn on the Gallery Wrap feature by toggling the on/off switch in the pane
header.

2. Set the Thickness control to the amount of margins you would like to add. A
good rule of thumb is the thickness of the stretcher bars, plus half an inch.

3. Select the Type you would like to use.
4. If you wish to add a color overlay to the gallery wrap wings set the color

and opacity.

The Gallery Wrap feature has several methods for adding margins:

Type:
Reflect: Copies an area equal to the thickness setting around your image, then flips each side and adds it as the margins. This is a good
general purpose technique.
Reflect Soft: Does the same as the Reflect method but softens the added margins.
Stretch: The Stretch method takes a small area around the edge of the image and stretches it to add the margins.
Stretch Soft: Does the same as stretch, but softens the added margins.

Thickness: This how thick your canvas stretcher bars are. Generally two inches works well for most gallery wraps. 
Overlay Color: You can also add a color overlay over the wrap area. This can be used to darken the wrap or fill it with a solid color.
Opacity: This sets the opacity of the overlay color. At the default of zero, there is no color overlay added.
Add to New Layer: This places the wrap wings on their own layer, rather then merging them with the image.

Gallery Wrap
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Without the Gallery Wrap feature, important parts of the image get lost when
wrapped.

With Gallery Wrap enabled, you can maintain the original image area
but still have the extended margins needed to wrap canvas on thick
stretcher bars.

Note: It is not recommended that you use the borderless printing option on a printer or use borderless lab prints when the overlap is set to
zero. Both borderless methods increase the image size 1-3 percent to allow for overprinting and/or trimming. The resulting prints may not
align properly. 

Perfect Resize  231

Perfect Photo Suite



Note: STiNG files do retain embedded icc color profiles but do not retain layers, clipping paths or alpha channels.

To save a file as a STiNG format follow these instructions:

1. In Photoshop, go to File > Save As... 
2. From the format pull-down, select Perfect Resize

    3. Select between Lossless and Standard compression in the dialog that appears.

Lossless Compression: creates a file that is approximately half the size of the
original file that is identical pixel by pixel to the original file.

Standard Compression: creates a file that is approximately 1/5th the size of the
original file and is visually lossless.

Using STiNG Files
What is a STiNG File?

Creating and opening of STiNG files is only available in the Premium Edition of Perfect Resize.

STiNG file support is provided in Perfect Resize 7.5 for opening exsiting .STN files for legacy users. STN is no longer a recommended format and this is
the last release of Perfect Resize to support it. It is recommended that exsiting STN files are converted to a modern format, like JPG2000 which
maintains the wavelet compression but is more compatible and is an industry standard.

STiNG (.STN) files are a specially compressed file that Perfect Resize can create in and for use with Photoshop. STiNG files allow you to save a single file that can
be scaled to any size when it is opened. This can help reduce the amount of space that is required for storage, and the bandwidth needed for transmission.

Saving a STiNG File

While it is no longer necessary to save images to STN format before you can scale them with Perfect Resize, some users may wish to do so. Any 8- or 16-bit
RGB, CMYK image and any 8bit grayscale image can be saved in STN format. The Perfect Resize’ STN format is available on the list of formats in the Save As…
dialog box in Photoshop, shown below. See your Adobe Photoshop documentation for more information on saving files.

Opening a STiNG File

232  Perfect Resize

Perfect Photo Suite



To open a STiNG file use the open command from inside of Adobe Photoshop or

Photoshop Elements. When you open a STiNG file you will be presented with the

Perfect Resize Express dialog. It will show the original size of the file when it was

saved. If you simply want to open the file at its original size click on Apply. If you

want to change the size of the file you can enter new values into the Pixel

Dimensions or Document Size panes to resize the STiNG file on-the-fly as you

open it.

 

Perfect Resize  233

 

Perfect Photo Suite



Batch Processing

The Batch processing engine is only available in the Premium Edition of Perfect Resize.

Perfect Resize is much more than just a resizing program, it also adds a powerful batch processor to your workflow. With the Perfect Resize batch engine you
can batch resize a group of images at the same time and even create new child documents from them in different sizes and formats. This can be a huge time
saver in your workflow. The following will explain the options within the batch engine and give you several ideas how you can use it in your studio. 

Opening the Batch Engine

The Perfect Resize batch engine can be accessed from either the File menu in the Perfect Layers module.

Source

In the source section you select the folder of images you would like
to batch process. If your folder has sub-folders, they can be
included as well.

Perfect Resize 7.5

In the Perfect Resize section you choose how to resize your images.
You can apply a preset, either factory supplied or a user saved
preset, or you can enter the size you desire. If you manually enter a
size you can select to fit in a specified size (width & height) or to
scale the long or short side of the images to a specified dimension.

Destination

In the destination section you determine where you would like to
save the new files, what file type, color space and file naming you
would like to use.

You can also batch process with Perfect Resize in Photoshop using actions for inside of Lightroom using the Export dialog. 
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Presets
Presets store all of the settings you can adjust in the the control panels on the right as well as the crop settings. Presets are a fast and easy way to get
consistent results. You can save your own presets for batch processing.

Using a Preset

Using a preset is simple, just click on it in the Preset Browser .

Saving a Preset

Saving a preset is simple. Once you have your settings that you wish to
save, go to the Preset menu and select Save Preset. 

The New Preset dialog will appear (shown to the right). There are several
fields to complete including the preset name, the category, creator and
description.

In the category pull-down you can select which existing category the
preset should saved into. You can also create a new category this way by
selecting new category from the bottom of the list.

You can edit a preset's name, creator or description by selecting
it and then selecting Edit Preset Info from the Preset menu. If
you want to edit the settings in a preset, load it into, make your
adjustments and then re-save the preset with the same name
and location. 

Deleting a Preset

You can remove a preset from Perfect Resize if you no longer want to
have access to it. To remove a preset, follow these steps:

1. Open Perfect Resize
2. Select the preset you wish to remove in the preset browser.
3. Select Delete Preset from the Preset menu.

Importing & Sharing Presets

You can import presets you have downloaded from the onOne website
using these steps.

1. Download the preset pack from the onOne website. It should have
a .ONPreset extension.

2. Double-click on the preset pack, it will install the presets into a
category named the same as the preset pack.

That's it, next time you use Perfect Resize the new presets will be located
in the My Presets tab, in a category named after the preset pack. You can
delete the files you downloaded, they have been copied into Perfect
Resize.

You can share presets like you would share any other file, such as email or
posting them to a website. First you need to find the preset files. The
easiest way it to open Perfect Resize, then from the Preset menu select
Show Presets Folder. A Finder (Mac) or Explorer (Win) window will open
and will display the presets folder. In the presets folder are sub-folders for
your preset categories. Inside each sub-folder are the individual preset
files, with a .ONResize extension. You can copy these presets to another
computer, attach them to an email or post them on a website.

Perfect Resize  235

Perfect Photo Suite



About Perfect Resize: Opens the about dialog box. It contains your serial number, version
number and information on contacting onOne Software for support.

Preferences: Opens the Perfect Resize preferences dialog. 

Services: Opens the OS level Services flyout (Mac only).

Hide Perfect Resize: Hides the window.

Quit Perfect Resize: Quits Perfect Resize.

Cancel: Cancels Perfect Resize and returns back to the host application with no changes.

Apply: Applies the current document size settings and options to your image and returns to the host application.

Undo: Reverses adding a preset

Redo: Unused

Copy: Unused

Cut: Unused

Paste: Unused

Reset All: Resets all the controls back to their default settings.

Module Settings: Opens the Perfect Resize 7.5 settings dialog.

Menus

Application Menu

Tip: On Windows, the preferences can be found in the Edit menu and the About Box can be found in the Help menu.

File Menu

Edit Menu

 Preset Menu
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Save Preset: Saves the current settings as a new preset.

Delete Preset: Deletes the current preset.

Edit Preset Info: Opens the preset dialog so you can edit
the name, author or description information.

Import Preset: Opens the import preset dialog to help you
import presets you have downloaded.

Show Presets Folder: Opens a Finder or Explorer window
showing the presets folder. 

Zoom In: Zooms the preview window in one increment. This will make the preview image
larger.

Zoom Out: Zooms the preview window out one increment. This will make the preview
image smaller.

Fit to Screen: This sets the preview image so that the entire image is on screen at
once. Think of this as an overview of the entire image. This is the setting you will use
most of the time.

Fill with Layer: Sets the zoom so the current layer fills the entire screen.

Actual Pixels: This sets the preview image so that it zooms to actual pixels or 1:1 also
called 100%. This setting allows you to see every pixel in the image. This is useful when
making adjustments to the Settings, Sharpening or Film Grain.

Show Browser Pop-up: Enables the browser pop-up window. A checkmark should
appear next to this when it is enabled.

Show Clipping: Shows the clipping overlay view, which overrides the current mask
view. No checkmark is displayed for this mode. The user can temporarily show this mode
by holding down J as well.

Preview Background Color: Flyout with background color options, the selected
item should have a checkmark next to it.

View Menu

Window Menu
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Navigator/Loupe/Histogram: Opens or closes the Navigator/Loupe/Histogram
pane.

Pixel Dimensions: Opens or closes the Pixel Dimensions pane.

Document Size: Opens or closes the Document Size pane.

Settings: Opens or closes the Settings pane.

Sharpening: Opens or closes the Sharpening pane.

Film Grain: Opens or closes the Film Grain pane.

Tiling: Opens or closes the Tiling pane.

Gallery Wrap: Opens or closes the Gallery Wrap pane.

Solo Mode: Enables or disables Solo Mode.

Show Browser Panel: Opens or closes the Browser Panel.

Show Control Panel: Opens or closes the Control Panel.

Hide Panel: Opens or closes all Panels.

Full Screen: Opens the window to full screen.

Search: Searches the Menus (Mac only)

Perfect Resize Online Help: Opens this html help in your default web
browser.

Video Tutorials: Opens a web browser to the tutorial section of the onOne
website.

Getting Started: Opens the Getting Started section in your default web
browser.

Keyboard Shortcuts: Opens a dark style dialog that displays the keyboard
shortcuts for that platform.

Perfect Inspiration: Opens the onOne Perfect Inspiration Gallery in your
default web browser.

Check For Updates: Checks for updates with the onOne auto update server.

Deactivate: Opens the activation dialog. This is used to deactivate your
software so you can move it to another computer or make a return.

Register: Opens the default web browser and navigates to the registration
page.

Provide Feedback: Opens the default web browser and navigates to the
feedback page.

Help Improve onOne Products: Opens the Improve onOne Products dialog.

 Help Menu
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Keyboard Shortcuts

Action  Mac  Win

 Preferences  cmd ,  ctl k

 Undo  cmd z  ctl z

 Redo  cmd shift z  ctl shift z

 Open/Close Navigator Pane  cmd 1  ctl 1

 Open/Close Pixel Dimensions Pane  cmd 2  ctl 2

 Open/Close Document Size Pane  cmd 3  ctl 3

 Open/Close Settings Pane  cmd 4  ctl 4

 Open/Close Sharpening Pane  cmd 5  ctl 5

 Open/Close Film Grain Pane  cmd 6  ctl 6

 Open/Close Tiling Pane  cmd 7  ctl 7

 Open/Close Gallery Wrap Pane  cmd 8  ctl 8

 Open/Close Browser Panel  cmd left arrow  ctl left arrow

 Open/Close Control Panel  cmd right arrow  ctl right arrow

 Hide Panels  tab  tab

 Full Screen Mode  cmd ctl f  F11

 Select Pan Tool  h  h

 Select Zoom Tool  z  z

 Select Crop Tool  c  c

 Zoom-In  cmd + or cmd =  ctl + or ctl =

 Zoom-Out  cmd -  ctl -

 1:1  cmd opt 0  ctl alt 0

 Fit to Screen  cmd 0  ctl 0

 Fit to Layer  cmd shift 0  ctl shift 0

 Show Clipping  opt J  alt J
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